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KATA SAMBUTAN

Puji syukur kami panjatkan kehadirat Allah SWT, berkat rahmat dan
karunia Nya, Pemerintah, dalam hal ini, Direktorat Pembinaan Sekolah 
Menengah Kejuruan Direktorat Jenderal Manajemen Pendidikan Dasar 
dan Menengah Departemen Pendidikan Nasional, telah melaksanakan 
kegiatan penulisan buku kejuruan sebagai bentuk dari kegiatan
pembelian hak cipta buku teks pelajaran kejuruan bagi siswa SMK.
Karena buku-buku pelajaran kejuruan sangat sulit di dapatkan di pasaran. 

Buku teks pelajaran ini telah melalui proses penilaian oleh Badan Standar 
Nasional Pendidikan sebagai buku teks pelajaran untuk SMK dan telah 
dinyatakan memenuhi syarat kelayakan untuk digunakan dalam proses 
pembelajaran melalui Peraturan Menteri Pendidikan Nasional Nomor 45
Tahun 2008 tanggal 15 Agustus 2008.

Kami menyampaikan penghargaan yang setinggi-tingginya kepada
seluruh penulis yang telah berkenan mengalihkan hak cipta karyanya 
kepada Departemen Pendidikan Nasional untuk digunakan secara luas 
oleh para pendidik dan peserta didik SMK.

Buku teks pelajaran yang telah dialihkan hak ciptanya kepada
Departemen Pendidikan Nasional ini, dapat diunduh (download),
digandakan, dicetak, dialihmediakan, atau difotokopi oleh masyarakat. 
Namun untuk penggandaan yang bersifat komersial harga penjualannya
harus memenuhi ketentuan yang ditetapkan oleh Pemerintah. Dengan 
ditayangkan soft copy ini diharapkan akan lebih memudahkan bagi
masyarakat khsusnya para pendidik dan peserta didik SMK di seluruh 
Indonesia maupun sekolah Indonesia yang berada di luar negeri untuk
mengakses dan memanfaatkannya sebagai sumber belajar.

Kami berharap, semua pihak dapat mendukung kebijakan ini. Kepada
para peserta didik kami ucapkan selamat belajar dan semoga dapat
memanfaatkan buku ini sebaik-baiknya. Kami menyadari bahwa buku ini 
masih perlu ditingkatkan mutunya. Oleh karena itu, saran dan kritik
sangat kami harapkan.

Jakarta, 17 Agustus 2008
Direktur Pembinaan SMK
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Alhamdulillah, saya bisa me-
nyelesaikan buku pegangan 
pelajaran (Handbook) berjudul 
Teknologi Grafis Komunikasi 
yang diperuntukkan kepada 
Sekolah Menengah Kejuruan 
(SMK) maupun bagi masya-
rakat yang berkecimpung pada 
Grafis Komunikasi. Buku ini 
disusun berdasarkan Ku-
rikulum Tingkat Satuan Pen-
didikan Sekolah Menengah 
Kejuruan dengan ada penam-
bahan - penambahan tertentu 
untuk memperdalam materi isi 
buku. Buku ini disusun dengan 
gaya komunikasi akademik 
dengan menampilkan teori dan 
praktek serta contoh-contoh 
karya rancangan atau karya 
yang telah ada di publikasikan. 

Penulis sudah mencoba se-
maksimal mungkin untuk 
menghadirkan tulisan maupun 
gambar yang mudah dipahami 
oleh siswa Sekolah Menengah 
Kejuruan, mudah-mudahan in-
formasi yang penulis sam-
paikan sampai kepada sa-
saran pembaca. Buku ini tidak 
akan ada bila tidak ada 
dukungan dari berbagai pihak. 
Maka pada kesempatan ini 
saya sampaikan ucapan teri-
makasih kepada: 

1. Direktur Pembinaan Seko-
lah Menengah Kejuruan 
yang telah memberikan 
kesempatan kepada saya 
untuk menulis buku ini. 

 
2. Teman sejawat yang telah 

membantu pengadaan ma-
teri demi terdukungnya ter-
selesainya buku ini 

3. Mahasiswa Desain Komu-
nikasi Visual Jurusan Seni 
dan Desain Fakultas Sas-
tra Universitas Negeri Ma-
lang yang telah merelakan 
karyanya untuk dibuat 
contoh dalam buku ini 

4. Mas Roy Genggam yang 
karya baiknya dibuat con-
toh demi meningkatnya 
kualitas berkarya anak 
bangsa 

5. Masmedia Surya, Cakram, 
Marketing, Consept, dan 
sebagainya karena gam-
bargambarnya kami pinjam 
untuk ditampilkan dalam 
buku ini 

6. Teman di SMK se Malang 
Raya yang telah memberi 
semangat dalam penyele-
saian  buku ini. 

Semoga buku ini bisa menjadi 
acuan dan memberikan kasa-
nah tentang bagaimana ber-
karya grafis yang berakar atau 
bernuansa local genius Indo-
nesia. Kami menyadari, bahwa 
tulisan buku ini sangat kurang 
dari harapan pembaca, untuk 
itu saya mohon saran dan 
ktitikan yang bersifat memba-
ngun guna kualitasnya buku 
ini. 

Malang, Akhir Tahun 2007 

Pujiyanto 

PENGANTAR PENULIS
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Teknologi Gafis Komunikasi 
merupakan kebutuhan yang 
tidak dapat dipisahkan dari 
kehidupan masyarakat, teru-
tama bagi mereka yang ber-
gerak dibidang industri dan 
teknologi. Seperti yang tam-
pak sekarang ini dimana per-
kembangan industri dan 
teknologi sangat pesat kema-
juannnya sehingga mengha-
rapkan hadirnya media sarana 
komunikasi yang mampu 
meningkatkan usahanya. Me-
lalui media sarana komunikasi 
yang handal diharapkan dapat  
mempengaruhi khalayak sa-
saran sebagai konsumen yang 
dapat diujudkan berupa media 
cetak maupun menggunakan 
sarana elektronik.  

Dampak dari perkembangan 
komunikasi secara global yang 
antara lain adalah  perkem-
bangan dunia pertelevisian, 
internet, cetak surat kabar 
jarak jauh, pasopati dan 
sebagainya. Seperti halnya 
dengan perkembangan komu-
nikasi di Indonesia, media 
sarana komunkasi sangat pe-
sat terutama bidang surat 
kabar dan televisi yang tidak 
jauh berbeda bila dibanding-
kan dengan negara-negara 
maju.  

 

 

 

 

Dalam bidang media sarana 
surat kabar telah terjadi 
kemajuan suatu proses visua-
lisasi, misalnya; bidang tata-
letak (lay-out), pemilihan huruf, 
dan isi berita, maka secara 
visual penampilan warna dise-
suaikan dengan obyek penya-
jian. Peran media grafis 
komunikasi bukan sebagai 
penawaran produk/ jasa saja 
melainkan suatu hiburan yang 
selalu ditunggu pembaca/ 
pemirsa. 

Sejalan dengan kemajuan di 
bidang komunikasi secara glo-
bal, yaitu dalam menghadapi 
pasar bebas untuk memacu 
sumber daya manusia guna 
mengantisipasi perkembangan 
teknologi dan industri. Sumber 
daya manusia yang handal 
mempunyai keahlian di bidang 
grafis komunikasi baik secara 
manual maupun elektronik 
sangat dibutuhkan. Salah satu 
upaya tersebut adalah mem-
beri pembinaan dan pembim-
bingan melalui program pen-
didikan teknologi grafis komu-
nikasi. 
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Teknologi grafis komunikasi 
merupakan pengetahuan dan 
keterampilan dalam meran-
cang media komunikasi cetak. 
Media grafis yang dirancang 
mengacu pada kualitas pene-
rapan estetik melalui unsur-
unsur grafis dan prinsip-prinsip 
grafis. Secara visual dan 
verbal, teknologi grafis komu-
nikasi sangat memperhatikan 
eleven-elemen yang ada, 
antara lain tipografi, ilustrasi, 
warna, corporate Identity, dan 
lay-out.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dalam penciptaan karya grafis, 
baik media lini atas maupun 
media lini bawah tetap melalui 
statu proses yang dikelom-
pokkan menjadi tiga, yaitu free 
design/Para desain, design/ 
produk, dan post design/paska 
desain (produk). Tapa-tahapan 
inilah yang harus dilakukan 
bagi calon desainer/praktisi 
gra-fis dalam mewujudkan 
karya-nya. Semua karya grafis 
komunikasi tetap mengacu 
pada pasar, agar pesan yang 
sampaikan diterima oleh 
masyarakat. 
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Gambar 10.1 : Media kerja 
Adobe Photoshop

Gambar 10.2: Tool pilihan pada 
marquee tool

Adobe Photoshop merupakan 
software yang biasa diguna-
kan untuk merancang media 
grafis komunikasi. Bagaimana 
cara penggunaannya, perha-
tikan langkah - langkah berikut 
ini.

A. Media Kerja Photoshop
Ketika pertama kali mengak-
tifkan program Adobe Photo-
shop, akan nampak area kerja 
terbagi menjadi beberapa ba-
gian menu yaitu: Menu Bar,
Option Bar, Toolbox, Pallet
Well, dan Pallete.

Menu bar: berisi menu-menu 
yang dapat membantu memu-
dahkan dalam bekerja dan 
terorganisir sesuai dengan 
topik yang saat itu digunakan. 
Sebagai contoh, menu Layers
berisi menu-menu yang ber-
hubungan dengan Pallete 
Layers.

1. Option bar: berisi informasi 
tentang tool yang saat itu 
digunakan.  

2. Toolbox: perangkat utama 
yang digunakan untuk 
membuat, mengedit gam-
bar dan teks.

3. Pallete Layers: membantu 
dalam menata beberapa 
palet yang digunakan 

4. Pallete: membantu memo-
nitor dan mengedit gambar 
(image).

Untuk lebih jelasnya, perha-
tikan gambar di bawah ini: 

Toolbox

Marquee Tool

Rectangle Marquee Tool:
untuk membuat seleksi ber-
bentuk persegi. 

1. Pertama kali, pilihlah salah 
satu alat seleksi pada 
Marqee tool.

2

3

4

1

X. KOMPUTER GRAFIS KOMUNIKASI
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Gambar 10.3: menu Marquee 

Gambar 10.4: Penggunaan Marquee tool

Gambar 10.5: 
Penggunaan marquee tool

2. Buatlah seleksi pada  gam-
bar yang dimaksud. 

3. Untuk Rectangle tool,
Rounded Rectangle tool,
atau Elliptical Marquee 
tool, pilihlah jenis seleksi 

• Normal=berguna untuk mem-
buat seleksi secara normal 

• Fixed Aspect Ration = untuk 
mengatur nilai panjang dan 
lebar seleksi secara rasio, 
sehingga panjang dan lebar 
akan proporsional  sesuai ni-
lai panjang dan lebar. 

• Fixed Size = untuk mengatur 
nilai panjang dan tinggi 
seleksi dalam bentuk pixel, 

sehingga akan membuat 
seleksi secara otomatis se-
suai panjang dan tinggi 
seleksi.

4. Tentukan pengaturan Fea-
ther, yang berfungsi untuk 
memperhalus batas tepi 
dengan gambar. Semakin 
besar nilai feather, maka 
semakin halus bagian te-
pinya.

Elliptical Marquee Tool:
untuk membuat seleksi ber-
bentuk lingkaran. 

Single Row Marquee Tool:
untuk membuat seleksi ber-
bentuk garis horisontal. 

Single Column Marquee 
Tool: untuk membuat seleksi 
berbentuk garis vertikal. 

Caranya: pilih salah satu tool
yang disediakan kemudian 
letakkan pada image yang 
dimaksud. Klik mouse sambil 
menyeret ke area lain kemu-
dian lepaskan. 
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Gambar 10.10: Penggunaan Move 

Gambar 10.7: menu pilihan 
l

Gambar 10.9: Polygonal Lasso 
Tool

Move Tool
Untuk memindahkan objek 
(teks maupun grafik). 

Caranya: Aktifkan Move tool,
lalu pilih objek yang ingin 
dipindahkan. Seret ke daerah 
lain.

Lasso Tool (L) 

Lasso Tool
untuk membuat seleksi secara 
bebas (handsfree) 

Caranya: aktifkan salah satu 
tool (missal: Magic Lasso tool)
dan tempatkan pada daerah 
yang ingin dibuat seleksi. Klik 
ujung Magnetic Lasso tool dan 
seret mouse mengelilingi dae-
rah yang dimaksud. 

Polygon Lasso Tool
untuk membuat seleksi bentuk 
persegi

Caranya: aktifkan salah satu 
tool (missal: Magic Lasso tool)
dan tempatkan pada daerah 
yang ingin dibuat seleksi. Klik 
ujung Magnetic Lasso tool dan 
seret mouse mengelilingi dae-
rah yang dimaksud. 

Gambar 10.8 : Lasso
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Gambar 10.10: Magic Lasso 
tool

Gambar 10.12 : Crop 

Magnetic Lasso Tool
untuk membuat seleksi bebas 
berdasarkan tingkat kesa-
maan warna. 

Caranya: aktifkan salah satu 
tool (missal: Magic Lasso tool)
dan tempatkan pada daerah 
yang ingin dibuat seleksi. Klik 
ujung Magnetic Lasso tool dan 
seret mouse mengelilingi dae-
rah yang dimaksud. 

Magic Wand Tool
Untuk membuat seleksi berda-
sarkan kesamaan warna. 

Caranya: aktifkan tool tersebut 
kemudian aturlah beberapa 
spesifikasi pada menu option
di bagian atas seperti toleransi 
(Tolerance), Antialis, Conti-
gous, dan Sample All Layers.
Semakin besar nilai pada 
Tolerance maka akan mem-
buat seleksi sesuai kesamaan 
warna yang berdekatan. 

Crop Tool (C) 
Untuk membuang bagian dari 
image canvas yang tidak 
digunakan.

Caranya: aktifkan Crop tool
kemudian letakkan mouse
pada daerah tertentu lalu seret 
ke daerah lain. Klik tanda 
centang di bagian atas jika 
sudah memilih atau tekan 
tombol enter. Untuk memper-
kecil atau memperbesar area 
yang dipilih, klik titik Nude di 
bagian kiri/kanan/atas/bawah 
dan seret ke tempat lain untuk 
membuat perubahan ukuran.  

Gambar 10.11: Magic Wand Tool
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Gambar 10.13: Slice 

Gambar 10.14: Menu pilihan modifier 
brush tool 

Slice Tool (K) 

Gambar: menu pilihan Slice
tool

Slice Tool
Untuk membuat irisan pada 
image menjadi beberapa ba-
gaian secara otomatis. Teknik 
ini sangat diperlukan ketika 
menampilkan beberapa gam-
bar di internet karena sebuah 
gambar akan dipotong menjadi 
beberapa bagian sehingga 
akan lebih cepat ditampilkan. 

Caranya: akifkan Slice tool ke-
mudian buat seleksi berbentuk 
kotak pada gambar yang ingin 
dipotong. Buatlah irisan pada 
daerah lain dengan cara yang 
sama. Usahahan pemotongan 
selanjutnya tepat pada garis 
sebelumnya karena jika ku-
rang atau melebihi daerah 
pemotongan sebelumnya ma-
ka secara otomatis akan 
membuat irisan lain. 

Slice Select Tool
Untuk memilih salah satu 
bagian yang telah dibuat 
menggunakan Slice Tool.

Caranya: tekan tombol Shift
dan klik pada salah satu irisan 
untuk memilih bagian yang 
dimaksud

Modifier Brush Tool (J) 

Spot Healing Brush 
Tool
Tool ini dapat memindahkan 
noda/cacat secara cepat dan 
ketidaksempurnaan lain pada 
gambar. Spot Healing Brush 
tool bekerja dengan cara 
mengambil sampel dari gam-
bar atau tekstur yang tepat, 
pencahayaan, dan pixel yang 
telah diperbaiki secara oto-
matis. Tidak sama dengan 
Healing Brush yang menutupi 
cacat dengan cara mengambil 
sampel yang kita tentukan, 
Spot Healing Brush secara 
otomatis mengambil sampel 
warna yang sesuai untuk 
menutupi daerah yang cacat. 
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Caranya: aktifkan Spot Healing 
Brush tool, kemudian aturlah 
ukuran brush dan tingkat 
ketajaman (hard). Selanjutnya, 
goreskan pada daerah yang 
kotor secara perlahan-lahan. 

Healing Brush Tool
Untuk memperbaiki bagian 
image yang cacat, kotor, 
maupun tergores dengan war-
na lain dengan cara mendup-
likasi dari warna atau pola 
pada bagian lain. 

Caranya: tekan tombol Alt
sambil mengklik tombol mouse 
pada daerah yang ingin 
dijadikan sumber. Lepaskan 
tombol Alt, lalu goreskan pada 
daerah yang ingin diper-
baiki/dihilangkan. 

Pacth Tool
Untuk memperbaiki bagian 
image yang cacat, kotor, 
maupun tergores dengan war-
na lain dengan cara memilih 
sumber warna/pola pada ba-
gian lain. 

Caranya: aktifkan Patch tool,
seleksi daerah yang ingin 
diperbaiki menggunakan tool 
tersebut. Setelah terbentuk 
seleksi, seret ke daerah lain 
sebagai sumber untuk menu-
tupi daerah yang kotor. 

Gambar 10.15: Panel option Spot 
Healing Brush Tool

Gambar 10.16: Penggunaan Spot 
Healing Brush Tool 

Gambar 10.17: Healing Brush 
Tool
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Gambar 10.18:  Pacth

Gambar 10.19: Red Eye Gambar 10.21: Brush 

Red Eye Tool
Seperti namanya, tool in dapat 
menghilangkan efek Red eye
pada foto Anda. 

Caranya: aktifkan Red Eye 
tool, kemudian klik pada mata 
yang berwarna merah (Red
Eye). Jika kurang puas de-
ngan hasil yang telah dibuat, 
Anda dapat membatalkannya 
kemudian atur menu option di 
bagian atas. Aturah ukuran 
Pupil (Pupil Size) dan tingkat 

gelap pupil (Darken Pupil).

Brush Tool (B) 

 Brush Tool 
Untuk membuat goresan kuas 
ketika mewarnai objek. Ter-
dapat 12 tipe brush yang 
dapat Anda pilih, dan tiap-tiap 
tipe memiliki 20 jenis brush 
yang berbeda bentuk dan 
ukurannya. Diantaranya ada 
yang berbentuk daun, bunga, 
rumput, dan berbentuk pena 
untuk membuat kaligrafi. 

Caranya: aktifkan Brush tool,
lalu aturlah ukuran brush, tipe 
brush dan tingkat kepekatan 
(opacity) pada menu option di 
bagian atas. Selanjutnya 
pilihlah warna yang diinginkan. 

Gambar 10.20: Menu pilihan brush 
tool
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Gambar 10.22: Pencil tool

Gambar 10.23: Menu pilihan Stamp tool

Gambar 10.24 : Clone Stamp 

Pencil Tool
Untuk membuat garis secara 
bebas dengan goresan yang 
menyerupai sebuah pensil. 

Caranya: aktifkan pencil tool,
lalu aturlah ukuran pencil, tipe 
pencil dan tingkat kepekatan 
(opacity) pada menu option di 
bagian atas. Selanjutnya 
pilihlah warna yang diinginkan. 

Stamp Tool (S) 

Clone Stamp Tool
Untuk menggambar dari sam-
pel pada sebuah image. 

Caranya: aktifkan Clone
Stamp tool dan aturlah ukuran 
brush, pilih tipe yang lembut 
(Soft). Selanjutnya klik pada 
daerah yangakan dijadikan 

sampel sambil menekan tom-
bol Alt. lalu klik pada daerah 
lain yang akan dijadikan 
target. Teknik ini biasanya 
digunakan untuk memanipu-
lasi sebuah image ketikame-
nambahkan objek yang sama. 

Pattern Stamp Tool
Untuk menggambar dari bagi-
an atau pola yang telah 
diambil.

Caranya: aktifkan Pattern
Stamp tool, pilih ukuran dan 
tipe brush. Selanjutnya, pada 
menu option di bagian atas, 
tentukan jenis pola (pattern)
yang digunakan untuk meng-
gambar.

Gambar 10.25: Pattern Stamp Tool
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Gambar 10.26: Menu pilihan history
brush tool 

Gambar 10.27: History Brush 

Gambar 10.28: Art History Brush 
Tool

Gambar 10.29: Menu pilihan eraser tool 

History Brush Tool 

History Brush Tool
Untuk mengembalikan objek 
pada posisi history tertentu. 
Tool in sangat berguna ketika 
mewarnai objek dengan brush 
kemudian ingin menghapus-
nya. Jika Anda menghapus 
menggunakan Eraser tool ma-
ka objek yang lain akan ikut 
terhapus.

Caranya: aktifkan History
Brush tool dan tentukan 
ukuran brush. Goreskan pada 
objek untuk menghilangkan 
bekas goresan brush.

Art History Brush Tool
Untuk mewarnai objek ber-
dasarkan history tertentu. Ca-
ranya: aktifkan Art History 
Brush tool dan aturlah ukuran 
brush. Pada menu option,
aturlah beberapa spesifikasi 
(Opacity, Style, Type, dan 
Tolerance). Kemudian gores-
kan pada gambar secara 
perlahan-lahan. 

Eraser Tool 
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Gambar 10.30: Eraser Tool 

Gambar 10.31: Background Eraser Tool 

Eraser Tool
Untuk menghapus objek dan 
dapat mengembalikan objek 
yang sudah terhapus ke posisi 
semula.

Caranya: aktifkan Eraser tool,
pilih ukuran brush dan pilih 
tipe brush yang lembut (Soft),
jika perlu perkecil tingkat 
kepekatan (opacity). Semakin 
kecil nilai opacity maka akan 
semakin lembut bagian tepi 
objek yang telah terhapus. 

Background Eraser Tool
Untuk menghapus latar bela-
kang (background) agar me-
njadi trasparan. 

Caranya: akifkan Background
Eraser tool kemudian aturlah 
beberapa spesifikasi pada 
Option bar.

Pada opsi Limits, pilih tipe
Contiguous agar warna yang 
pertama kali terhapus menjadi 
acuan untuk menghapus 
warna berikutnya. 

Magic Eraser Tool
Untuk menghapus warna yang 
solid dengan cara mengklik 
sekali pada bagian tertentu. 

Caranya: aktifkan Magic Era-
ser tool, kemutian aturlah nilai 
Tolerance (semakin besar 
nilainya maka warna yang 
berdekatan akan ikut terha-
pus), Anti-alias (jika diberi 
tanda centang maka warna 
yang terhapus semakin lem-
but), Contiguous (jika diaktif-
kan, akan menghapus bagian 
lain), dan Sample All Layer
(jika diaktifkan, semua layer di 
bawahnya ikut terhapus). 
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Gambar 10.33: Menu pilihan colouring
tool

Gambar 10.34: Gradient 
tool

Gambar 10.35: Paint Bucket 

Colouring Tool 

Gradient Tool
Untuk mewarnai objek dengan 
warna gradasi dengan tipe 
linier, angle, reflected, dan
diamond. 

Caranya: aktifkan Gradient tool
dan tentukan tipe gradasi 
(linier, angle, reflected, dan
diamond) pada menu Option.
Selanjuntya, pilih warna gra-
dasi, untuk membuat warna 
gradasi sendiri klik warna 
gradasi.

Paint Bucket Tool
Untuk mengisi objek dengan 
warna foreground yang telah 
dipilih.

Caranya: aktifkan Paint Bucket 
tool, pilih warna yang di-
inginkan. Klik pada daerah 
yang ingin diberi warna. Anda 
dapat pula menekan tombol 
Alt+Backspace secara bersa-
maan untuk memberi warna 
(berfungsi sebagai Shottcuts).

Gambar 10.32: Magic Eraser 
Tool
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Gambar 10.36: Menu pilihan modifikasi tool

Gambar 10.38: Sharpen Tool 

Tool Modifikasi  

Blur Tool
Untuk memperhalus bagian 
tepi sebuah image. Teknik ini 
juga sering digunakan untuk 
memperhalus bagian-bagian 
tertentu, misalnya memperha-
lus bagian wajah atau mem-
perhalus pixel yang terlalu 
besar

Caranya: aktifkan Blur tool,
aturlah spesifikasi pada Option
bar. Goreskan brush pada 
daerah yang ingin dibuat kabur 
(blur).

Sharpen Tool
Untuk mempertajam bagian 
tepi sebuah image.

Caranya: aktifkan Sharpen 
tool, aturlah spesifikasinya 
pada Option bar.

Smudge Tool
Untuk membuat efek sentuhan 
jari pada cat basah. Teknik ini 
sering digunakan untuk meng-
gambar secara digital.

Caranya: aktifkan Smudge
tool, tentukan ukuran dan tipe 
Brush (atur pula tingkat keta-
jaman). Aturlah Mode dan 
Strenght (radius efek goresan 
brush, semakin besar nilani-
nya maka akan bagian lain ikut 
terkena dampaknya) pada 
Option bar.

Gambar 10.37: Blur Tool

Gambar 10.39: Smudge 
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Gambar 
10.42:

Tool Saturasi dan 
Pencerahan

Dodge Tool
Untuk memberikan warna 
terang pada daerah tertentu. 

Caranya: aktifkan Dodge tool,
aturlah ukuran dan tipe brush,
aturlah pula pada Strenght
(semakin besar nilainya maka 
akan semakin terang). 

Burn Tool
Untuk memberikan warna 
yang gelap pada daerah ter-
tentu dengan goresan brush. 

Caranya: aktifkan burn tool,
aturlah ukuran dan tipe brush,
aturlah pula pada Strenght
(semakin besar nilainya maka 
akan semakin gelap). 

.

Sponge Tool
Untuk meningkatkan satu-
ration pada objek. 

Caranya: aktifkan sponge tool,
aturlah ukuran dan tipe brush,
aturlah pula pada Strenght.

.

Gambar 10.40: Menu pilihan saturasi 
dan pencerahan tool

Gambar 10.41: Dodge 
T l

Gambar 
10.43:
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Gambar 10.44: Menu pilihan type  
tool

Gambar 10.46: Type Mask 
Tool

PATH SELECTION (A)
Tool ini untuk memilih dan 
mengedit path yang dinginkan. 
Caranya: aktifkan Path Se-
lection tool, klik pada path 
yang telah dimaksud. Teknik 
ini biasa digunakan jika me-
miliki beberapa path. 

Tool Tulisan 

Type Tool
Untuk mengetik teks pada 
sebuah image secara vertikal 
maupun horisontal. 

Caranya: pilih salah satu tipe 
Type tool (horisontal atau 
vertikal), pilih jenis font, warna 
font, dan ukuran font. Anda 
dapat pula membuat efek teks 
warped dengan beberapa 
bentuk pilihan. 

Type Mask Tool
Untuk membuat seleksi ber-
bentuk huruf. 

Caranya: sama dengan Type 
tool.

Gambar 10.45: Type
Tool
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Gambar 10.47: Pen
T l

Gambar 10.48: Menu pilihan shape  tool

Gambar 10.49: Shape

Pen Tool
Untuk membuat path yang 
dapat digunakan sebagai 
seleksi maupun alat gambar. 

Caranya: aktifkan Pen tool,
dan aturlah Option bar untuk 
menentukan tipenya (Pen tool 
atau Freeform Pen tool), dan 
pilih salah satu bentuknya 
(Shape Layers, Path atau Fill 
Pixel).

Custom Shape Tool

Untuk membuat bentuk shape
tertentu dari daftar yang di-
tampilkan.

Caranya: sama dengan Pen
tool, dan dapat menentukan 
salah satu bentuk Shape yang 
diinginkan (Dingbats).

Notes tool
Untuk membuat catatan dan 
suara yang dapat disertakan 
dalam image. 

Caranya: aktifkan Annotation 
tool untuk membuat catatan 
lalu klik dan drag untuk mem-
buat tempat catatan (note). 
Mulailah mengetikkan bebe-
rapa catatan. Perlu diper-
hatikan, teks dalam catatan 
tersebut tidak akan tercetak 
dalam dokumen gambar anda. 
Sedangkan untuk membuat 
notasi berbentuk suara, aktif-
kan Audio Annotation tool.
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Gambar 10.50: Notes 
Tool

-

Eyedropper Tool
Untuk mengambil sampel 
warna dalam sebuah image.
Caranya: aktifkan Eyedropper 
tool, lalu klik pada daerah 
yang ingin diambil sampel 
warnanya. Umumnya, Anda 
hanya dapat mengambil sam-
pel satu warna, namun Anda 
dapat pula mengambil bebera-
pa sampel warna dengan cara 
menekan tombol Shift saat 
memilih warna. Maksimal sam-
pel warna yang diambil secara 
bersamaan adalah 4. 

Hand Tool
Untuk memindahkan sebuah 
gambar bersama-sama de-
ngan windows.

Caranya: aktifkan Hand tool
dan letakkan pada sebuah 
image. Geser tampilan 
windows untuk melihat daerah 
yang tak tampak. 

Zoom Tool
Untuk mengatur tampilan 
(perbesar atau perkecil) 
image.

Caranya: aktifkan Zoom tool,
dan buatlah seleksi untuk 
memperbesar daerah yang 
dimaksud. Untuk memperkecil 
tampilan, tekan tombol Alt
sambil mengklik pada daerah 
yang dimaksud. 

Foreground & Back-
ground Color 
Untuk menentukan warna 
foreground dan background.

Caranya: klik pada ikon 
tersebut untuk memilih warna. 
Secara default, warna fore-
ground & background adalah 
hitam dan putih. Untuk me-
nukar posisinya, tekan huruf X 
pada keyboard.

Gambar 10.51:  Hand
Tool
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Gambar 10.52: Menu 
adjusment

Koreksi warna 
Keserasian warna dan tonal 
menjadi hal yang sangat 
penting dalam dunia desain 
grafis karena menentukan 
indah atau tidaknya sebuah 
gambar yang dibuat. Bukan 
saja untuk dunia desain grafis, 
namun mencakup segala as-
pek kehidupan manusia. Jika 
tidak ada keserasian antara 
warna dan tonal, segala 
sesuatu akan nampak aneh 
dan kurang menarik.  

Mungkin tidak semua peng-
guna komputer grafis mema-
hami arti koreksi warna dan 
koreksi tonal.Koreksi warna 
adalah penyesuaian warna 
dalam sebuah gambar yang 
diolah menggunakan komputer 
sehingga nampak serasi dan 
menarik namun tidak memiliki 
kesan aneh.  

Sebagai contoh, ketika Anda 
mengambil gambar menggu-
nakan kamera digital mungkin 
hasilnya terlalu banyak warna 
merahnya. Dengan alat korek-
si warna yang disediakan 
masing-masing aplikasi kom-
puter grafis dapat disesuaikan 
warna agar menghasilkan ke-
serasian warna.  

Koreksi tonal adalah hal-hal 
yang berhubungan dengan 
brightness dan contrast serta 
beberapa efek akibat adanya 
pencahayaan. Dalam bidang 
desain grafis, koreksi tonal 
memerlukan perhatian khusus 
terutama ketika melakukan 

penggabungan beberapa gam-
bar (kolase/montase). Aplikasi 
pengolah gambar seperti 
Adobe Photoshop menyedi-
akan fasilitas yang lengkap 
untuk koreks tonal yang 
menyangkut tingkat pencaha-
yaan (brightness) dan kontras 
(contrast) dari tiga sisi yaitu: 
sisi terang (highlight), sisi 
tengah (midtones), dan sisi 
gelap (shadows).

Dalam melakukan koreksi war-
na perlu diperhatikan bahwa 
dengan melakukan perubahan 
nilai variabel sebuah warna 
maka secara otomatis mem-
pengaruhi keseimbangan war-
na dalam gambar tersebut 
karena dalam spektrum warna, 
semua warna saling mem-
pengaruhi. Sebagai contoh, 
warna hijau berseberangan 
dengan warna magenta 
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Gambar 10.53: Penggunaan 

Gambar 10.54: Penggunaan auto 
level

sehingga ketika Anda mening-
katkan persentase warna hijau 
maka nilai persentase warna 
magenta akan berkurang. 

Alat koreksi warna dalam 
Adobe Photoshop terdiri dari 
beberapa bagian yaitu: 

Caranya:

1. Bukalah gambar yang ingin 
koreksi warnanya 

2. Pilih menu Image > 
Adjustment 

3. Pilih salah satu alat 
koreksi warna

Level
Fasilitas ini disediakan untuk 
mengatur brightness, contrast,
serta dan interval (posisi
highlight, midtones, shadows).

Autolevel
Fasilitas ini berguna untuk 
mengatur menu Levels secara 
otomatis. Anda dapat pula 
menggunakan Autolevels de-
ngan cara mengklik ikon Auto
pada kotak dialog Levels.

Auto Contrast 
Fasilitas ini berguna untuk 
mengatur contrast (kontras) 
secara otomatis. 

AUTO COLORS 
Fasilitas ini berguna untuk 
mengatur Colors (warna) 
secara otomatis. 

Gambar 10.55: Penggunaan autocontrast 
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Gambar 10.56: Penggunaan auto colors

Gambar 10.57: Penggunaan 

Gambar 10.58: Penggunaan color balances

Curves
Fasilitas in tidak jauh berbeda 
dengan fasiltas Levels yaitu 
untuk mengatur brightness
dan contrast pada highlight, 
midtones, dan shadows. Per-
bedaannya: pada pengaturan 
Curves digambarkan dengan 
kurva sedangkan pada Levels
digambarkan dengan nilai 
nominal dan histogram. 

Color Balance 
Fasilitas ini berguna untuk 
meningkatkan suatu warna 
atau beberapa warna dengan 
cara menggeser slider yang 
telah disediakan. Pengaturan 
yang dimaksud adalah untuk 
mengatur sisi gelap (sha-
dows), sisi tengah (midtones),
dan sisi terang (highlight).
Terdapat pula ikon Preserve 
Luminosity secara otomatis, 
nilai brightness dalam gambar 
tersebut akan menyesuaikan 
perubahan warnanya. 

Brihtness/Contrast
Fasilitas in berguna untuk 
mengatur tingkat pencaha-
yaan (brightness) dan kontrast 
(contrast). Bentuk fasilitas in 
sangat sederhana karena 
hanya menyediakan dua buah 
sisi saja.  
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Gambar 10.59: Penggunaan brightness/contrast

Gambar 10.60: Penggunaan hue saturation

Gambar 10.61: Penggunaan desaturate

Hue/Saturation  
Fasilitas ini berguna untuk 
mengatur Hue Saturation dan 
Lightness dari warna-warna 
utama spektrum warna dalam 
Adobe Photoshop. Fasilitas in 
sering digunakan untuk me-
ngubah foto hitam putih 
menjadi berwarna, yang telah 
diubah mode warnanya dari 
grayscale menjadi RGB atau 
CMYK. 

Desaturate 
Fasilitas ini berguna untuk 
membuat gambar berwarna 
menjadi hitam putih tanpa 
harus mengubah mode war-
nanya.

Match Color 
Perintah Match Color dapat 
menyesuaikan warna terang, 
warna jenuh (saturasi), dan 
menyeimbangkan warna da-
lam sebuah image. Menge-
depankan perintah Match
Color akan memberikan kele-
luasaan mengatur lebih ba-
nyak luminance dan kom-
ponen warna dalam sebuah 
image. Oleh karena Anda 
dapat mengatur warna dalam 
gambar tunggal dibandingkan 
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Gambar 10.63:  
Penggunaan
replace color

mencocokkan antar warna 
dalam dua gambar, kedua 
gambar akan terkoreksi secara 
tepat. Hal in sangat berguna 
ketika ingin menggabungkan 
kedua gambar yang memiliki 
warna yang agak berbeda.  

Replace Color 
Fasilitas in berguna untuk 
membuat virtual seleksi pada 
gambar berdasarkan tingkat 
kemiripan warna kemudian 
mengedit dengan Hue satu-
ration dan Lightness. 

Selective Color 
Fasilitas in berguna untuk 
mengoreksi warna utama 
dalam sebuah gambar. Ketika 
mencetak, alat cetak yang 
digunakan akan mencetak 
berdasarkan tabel proses 
pembentukan warnawarna pri-
mer baik aditif maupun 
substraktif.

Channel Mixer 
Channel Mixer memberikan 
Anda keleluasaan untuk me-
ngatur sebuah image dengan 
kualitas grayscale yang tinggi 
dengan cara memilih persen-
tase pada masing-masing 
chanel warna. Anda dapat 
pula membuat keseimbangan 
sepia berkualitas tinggi atau 
gambar lain yang diwarnai. 
Dengan menggunakan Chan-
nel Mixer, Anda juga dapat 
menyesuaikan warna secara 
kreatif yang mudah dilakukan 
dibandingkan alat koreksi 

Gambar 
10.62:
Penggunaan
match color

Gambar 10.64:  
Penggunaan
selective color 
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Gambar 
10.65:
Penggunaan

warna lain. Channel Mixer
memodifikasi target keluaran 
(output) warna channel yang 
menggunakan campuran war-
na channel yang ada (source)
dalam sebuah gambar. Ketika 
Anda menggunakan alat 
koreksi warna dengan Chan-
nel Mixer, Anda sebenarnya 
sedang menambahkan atau 
mengurangi data grayscale
dari suatu channel sumber ke 
target channel.

Gradient Map 
Alat koreksi warna in akan 
memetakan cakupan batas 
grayscale dalam sebuah 
image pada warna yang telah 
ditetapkan warna gradasinya. 
Sebagai contoh, jika Anda 
mengatur gradasi dua warna, 
maka bayangan akan dipe-
takan ke titik angka salah satu 
warna gradasi sedangkan 
warna terang (highlight) akan 
dipetakan ke titik angka salah 

satu warna gradasi yang 
lainnya.

PHOTO FILTER 
Alat koreksi warna in meng-
gunakan teknik meniru pe-
ngambilan filter yang di-warnai 
dalam lensa kamera bagian 
depan untuk menyesuikan 
keseimbangan warna dan tem-
peratur warna yang memancar 
melalui lensa dan membuka 
film tersebut. Perinea in juga 
mengijinkan Anda untuk me-
milih warna yang ditetapkan 
untuk digunakan pengaturan 
Hue dalam sebuah gambar.

Gambar 
10.66:
Penggunaan
gradient map 

Gambar 
10.67:
Penggunaan
photo filter 
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Gambar 
10.68:
Penggunaan

Gambar 10.70: Penggunaan 
invert

Shadows/Highlight
Fasilitas in berguna untuk 
mengoreksi foto yang memiliki 
efek siluet menjadi  penca-
hayaan latar belakang 
(backlighting) yang kuat atau 
mengoreksi subyek yang 
terlalu dekat dengan cahaya 
kamera. Penyesuaian ini juga 
berguna untuk menerangi 
daerah bayangan (shadow)
menjadi kebalikannya. 

Exposure
Alat koreksi warna ini memang 
dirancang untuk membuat 
penyesuaian pada gambar 
HDR (format file untuk pro-
gram Radiance), namun be-
kerja dengan gambar 8-bit dan 
110-bit. Exposure bekerja de-
ngan cara mengkal-kulasikan 
dalam ruang warna linier
(gamma 1.) bukan pada ruang 
warna gambar saat itu. 

Invert
Fasilitasi ini berguna untuk 
membuat efek negatif film dari 
image yang aktif. Ketika 
menggunakan fasilitas ini, 
Adobe Photoshop secara 
otomatis akan membalik posisi 
batas maksimal sisi gelap 
menjadi batas sisi terang. 

Equalize
Fasilitas in berguna untuk 
mendatarkan brightness dari 
gambar ke posisi terdekat rata-
rata. Fasilitas in berguna 
ketika ingin meningkatkan nilai 
brightness suatu gambar. 

Gambar 
10.69:
Penggunaan
exposure
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Gambar 10.71: Penggunaan
equalize

Gambar 10.74: Penggunaan 
variations

Threshold
Fasilitas in berguna untuk 
mengubah gambar hitam putih 
(B/W) atau gambar berwarna 
secara normal menjadi hitam 
putih atau berwarna dengan 
nilai contrast tinggi. 

Posterize
Fasilitas in berguna untuk 
mengelompokkan pixel yang 
berdekatan dan nilai bright-
nessnya.

Variations
Fasilitas in berguna untuk 
mengatur tonal dan warna 
secara mudah karena hanya 
mengklik elemen yang akan 
dikoreksi.

Gambar 
10.72:
Penggunaan
threshold

Gambar 10.73:  
Penggunaan
posterize
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Gambar 10.75:  
Penggunaan

Gambar 10.77: 
Penggunaan skew

Transforming & Retouching 
Anda dapat mengubah skala, 
memutar, mencondongkan, 
mendistorsi objek, dan digu-
nakan pada salah satu layer 
maupun beberapa layer, mask, 
path, maupun channel. Dalam 
Adobe Photoshop, Anda dapat 
menerapkan transformasi un-
tuk path, vec-tor shape, vector 
mask, selection border, atau
channel alfa dalam sebuah 
layer, multiple layers, maupun 
layer mask.

Transformasi 
Perintah untuk mentrans-for-
masikan dapat digunakan un-
tuk beberapa kondisi, yaitu: 
1. Untuk mentransformasikan, 

pilih menu Edit>Transform.
2. Lakukan beberapa pilihan 

yang telah disediakan: 

a. Scale

Memperbesar skala atau 
memperkecil skala sebuah 
item pada titik tertentu. Anda 
dapat mengubah skala secara 
vertikal, horisontal, maupun 
keduanya (vertikal dan hori-
sontal).

b. Rotate

Mengaktifkan pemutaran se-
buah item dari salah satu titik. 
Secara default, titik tersebut 
berada di pusat, meskipun 
begitu Anda dapat memin-
dahkan titik tersebut ke tempat 
lain.

c. Skew

Teknik Skewing menghasilkan 
efek miring secara vertikal dan 
horisontal.

Gambar 
10.76:
 Penggunaan
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Gambar 10.81: Buka 

d. Distort
Mendistorsi sebuah objek dari 
seluruh titik. 

e. Perspective
Mengubah bentuk secara 
perspektif dari satu titik. 

f. Flip
Mengubah/memutar gambar 
sesuai pilihan (horisontal/ver-
tikal)

g. Setelah Anda melakukan 
perintah transformasi, jangan 
lupa mengklik tombol Commit  
pada Option bar dan untuk 
membatalkan klik tombol Can-
cel ( ), atau dapat pula 
menekan tombol Enter. Jika 
tidak melakukan hal tersebut, 
objek yang ditransformasikan 
belum mengalami perubahan. 

B. Merubah Gambar 
1. Mengubah Ukuran 

Kanvas
Adakalanya ketika membuat 
sebuah dokumen mengalami 
perubahan ukuran kanvas. An-
da tidak dapat mengubah 
ukuran image untuk memper-
baiki ukuran kanvas. 

a. Pertama kali bukalah file
yang akan diubah ukuran 
kanvasnya.

b. Pilih menu Image > Can-
vas Size. 

c. Setelah kotak dialog Can-
vas Size muncul, aturlah 
beberapa spesifikasi. 

Gambar 
10.78:
Penggunaan
distort

Gambar 
10.79:
Penggunaan
perspective

Gambar 10.80:  
Penggunaan
flip
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Gambar 10.82: Menu canvas
i

Gambar 10.83: Penggunaan canvas 
pada bagian bawah 

Gambar 10.84: Hasil canvas 

Gambar 10.85: Penggunaan cermin 
gambar

d. Untuk menambah kanvas 
pada bagian bawah, klik 
tanda panah ke atas. 

e. Setelah selesai klik OK, 
maka akan terbentuk kan-
vas dengan ukuran yang 
telah dimodifikasi. 

2.   Memutar dan Mencer-
minkan Gambar 

Ketika anda menggunakan 
perintah Rotate Canvas mem-
berikan keleluasaan Anda 
untuk memutar dan mencer-
minkan gambar. Perintah 
tersebut tidak bekerja pada 
layer individu atau salah satu 
bagian dari layer, path, atau 
tepi seleksi. Perintah ini sering 
digunakan untuk membalikkan 
posisi image (misalnya: me-
ngubah posisi objek yang 
menghadap ke kanan menjadi 
ke kiri).

Selain itu, sering digunakan 
pula ketika membuat beberapa 
efek special, misalnya efek 
api. Jadi, perintah Rotate
Canvas berlaku untuk satu 
dokumen yang berisi beberapa 
objek di dalamnya. Untuk 
menjalankan perintah tersebut, 
ikuti langkah-langkah berikut: 
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Gambar 10.86: Penggunaan 

Gambar 10.87: Penggunaan 

3. Memotong Image
Ketika kita membuat sebuah 
poster, banner, pamflet mau-
pun brosur, kita membutuhkan 
beberapa gambar sebagai 
pendukung untuk menginfor-
masikan content yang penting. 
Beberapa gambar tersebut 
mungkin saja berukuran be-
sar,sedangkan kita hanya 
membutuhkan bagian-bagian 
tertentu dalam gambar. Adobe
Photoshop menyediakan tool 
untuk mengambil atau memo-
tong bagian tertentu dalam 
sebuah gambar. Ada dua tek-
nik dalam memotong gambar 
yaitu menggunakan perintah 
Cropping dan Trim.

Memotong gambar dengan 
Crop tool 

 Pertama kali bukalah gam-
bar yang akan dicroping 

 Aktifkan Crop tool pada
Toolbox, kemudian seleksi 
bagian yang akan dicro-
ping. Selanjutnya, klik 
Commit (tanda centang). 

 Untuk memotong gambar 
(Crop) dengan Marquee 
tool, pilih Rectangle 
Marquee tool. 

 Kemudian seleksi bagian 
yang akan diambil. 

 Pilih menu Image > Crop.

4. Merperbaiki Gambar 

Gambar 10.88: Penerapan 

Gambar 10.89: Hasil 
crop
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Dalam sebuah kasus, gambar 
yang kita ambil dari sebuah 
kamera maupun hasil scan 
seringkali buram dan Nampak 
kurang tajam. Ada beberapa 
penyebab, diantaranya reso-
lusi gambar yang rendah, 
jumlah pixel warna yang 
sangat minim, kurang fokus 
pada objek yang dimaksud, 
dan lain-lain. Adobe Photo-
shop dapat mengatasi ber-
bagai kekurangan yang terjadi 
pada kasus tersebut. Foto/ 
image yang redup, kurang 
warna, kurang tajam, maupun 
kurang focus  dapat ditangani 
dalam Photoshop. Pada ba-
gian berikut ini, kita akan 
mencoba beberapa teknik 
memperbaiki foto yang buram, 
pudar, kurang warna, terlalu 
gelap dan kurang fokus. 

Mempertajam Gambar 
Seperti telah disebutkan pada 
bagian sebelumnya, Anda da-
pat menggunakan beberapa 
cara maupun menggunakan 
tool tertentu untuk memper-
baiki sebuah gambar. Umum-
nya, orang orang memanfa-
atkan menu Adjustment,
namun meski begitu, Anda 
dapat pula menggunakan 
menu Filter yang disediakan 
untuk lebih mempermudah 
menangani berbagai kesa-
lahan dalam sebuah gambar. 
Tingkat ketajaman didefini-
sikan dari bagian tepi sebuah 
gambar. Apakah gambar Anda 

berasal dari kamera digital 
maupun alat scanner, akan 
lebih berguna jika tingkat 
ketajaman gambar diperbesar.

Derajat tingkat ketajaman 
dalam satu gambar bervariasi, 
bergantung dari kamera digital 
dan alat scanner yang dimiliki. 
Perlu diingat, bahwa Anda 
tidak dapat mempertajam 
sebuah gambar yang terlalu 
kabur (blur) ataupun gambar 
yang telah diberi efek kabur 
blur. Ada beberapa catatan 
dan teknik untuk memper-
tajam gambar, diantaranya:  
 Pertajam gambar Anda 

dengan layer yang terpisah, 
sehingga Anda dapat mem-
pertajam kembali jika diper-
lukan dalam output dengan 
media yang berbeda.  

 Jika Anda mempertajam 
gambar pada layer terpi-
sah,aturlah layer dengan 
blending mode menjadi 
Luminance untuk meng-
hindari warna yang ber-
geser di bagian tepi. Adobe
Photoshop memiliki fasilitas 
untuk mempertajam secara 
digital dengan berapa menu 
yang dapat dipilih dan 
diatur opsinya.  

Dengan memanfaatkan Filter 
Sharpen, Anda dapat memiliki 
salah satu jenis menu sharp. 
Mulai dari yang sederhana 
sampai dengan yang memiliki 
fasilitas pengaturan yang lebih 
detail.
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Gambar 10.90: Tampilan menu
filter sharpen

Gambar 10.91: Menu tampilan utomate 
photomerge 

1) Pertama kali bukalah gam-
bar yang ingin dipertajam. 

2) Pilih menu Filter > Shar-
pen > Sharpen. Sekilas 
memang tidak nampak 
efek sharp (ketajaman), 
namun jika Anda menekan 
tombol Ctrl+F beberapa 
kali maka akan nampak 
efek ketajamannya.  

Semakin banyak Anda 
menekan tombol Ctrl+F 
maka akan semakin tajam 
dan warna gambar menga-
lami distorsi. 

3) Atau Anda dapat pula 
memilih menu Filter > 
Sharpen > Edges yang 
fungsinya sama dengan 
Sharpen.

4) Anda dapat pula meman-
faatkan menu filter lain 
seperti Smart Sharpen.
Filter ini memiliki menu 
pengaturan yang sangat 
canggih sehingga Anda 
dapat memilih tingkat keta-
jaman dan menentukan 
radius ketajaman pada 
objek. Pilih menu Filter > 
Smart Sharpen, maka 
akan muncul kotak dialog 
Smart Sharpen. Pada ko-

tak dialog Smart Sharpen,
Anda dapat menentukan 
pengaturan secara Basic
maupun Advanced. Pada 
menu ini, terdapat fasilitas 
untuk membuang efek 
Motion Blur, Lens Blur, dan
Gaussian Blur. 

Membuat Gambar Panorama 
menggunakan Photomerge
Perintah Photomerge meng-
kombinasikan beberapa foto 
menjadi sebuah gambar yang 
bersambungan. Sebagai con-
toh, Anda dapat mengambil 
lima buah gambar yang over-
lap sebuah kota besar atau 
pantai kemudian memasang 
gambar tersebut menjadi se-
buah panorama. Perintah 
Photomerge dapat menyusun 
foto secara vertikal maupun 
horizontal. Untuk lebih jelas-
nya, perhatikan gambar berikut 
ini. Gambargambar yang 
berada di bagian atas meru-
pakan gambar source (gambar 
asli) yang terdiri dari lima buah 
gambar, sedangkan di bagian 
bawah adalah hasil kombinasi 
menggunakan perintah Photo-
merge.
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Gambar 10.92: Penerapan 
photomerge

Gambar 10.93: Penerapan menu
photomerge

Untuk menggunakan perintah 
Photomerge, pilih menu File > 
Automate > Photomerge.
Setelah muncul kotak dialog 
Photomerge, pilih file yang 
dimaksud atau Anda dapat 
memilih folder yang berisi 
gambar-gambar yang akan 
digabungkan. Setelah selesai, 
klik OK. Tunggu beberapa 
saat, proses photomerge se-
dang berjalan. Setelah selesai, 
maka akan terbentuk sebuah 
gambar baru dengan nama 
Untitled dan nama layernya 
adalah Photomerge, bukan
Background. 

Layer
Pada photoshop, pasti kita 
akan berhadapan dengan 
sistem kerja multi gambar, 
sehingga pada media kerja 
photoshop kita akan diha-
dapkan dengan layers atau 
tumpukan gambar. Bekerja 
dengan layers

Dasar-dasar Layer
Layers merupakan lapisan 
yang berfungsi sebagai tem-
pat objek, diibaratkan sebagai 
kanvas. Dengan adanya la-
yers, memungkinkan Anda 
untuk mengedit sebuah objek 
tanpa mengganggu objek yang 
lain. Sebagai contoh, jika Anda 
sedang mengedit gam-bar 1 
maka gambar 2 tidak akan 
terpengaruh.

Anda dapat mengatur kompo-
sisi layers dengan cara me-
ngubah atribut dan urutan 
layers. Sebagai tambahan, 
corak khusus seperti adjus-
tment layers, fill layers, dan
layers style dapat diterapkan 
untuk memberikan efek 
khusus pada layers tersebut 
Untuk lebih jelasnya, perha-
tikan gambar di bawah. Layers
berisi satu objek sehingga 
masing-masing objek dapat 
diedit tanpa mempengaruhi 
objek yang lain. Ketika Anda 
memberikan efek tertentu 
(layer style) pada sebuah 
layer, maka Anda dapat 
menduplikasi layer style ke 
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Gambar 10.95: Palette

Gambar 10.96: Menu palette 
layer

Gambar 10.97:  
Pulldown layers 

layer yang lain dengan corak 
dan bentuk yang sama.  

Pallete Layer 
Palet Layers berisi seluruh 
layers yang ada, kelompok 
layer, dan efek layers dalam 
sebuah gambar. Dengan palet 
Layers, anda dapat menam-
pilkan/menyembunyikan layer,
membuat layer baru, dan 
dapat bekerja dengan kelom-
pok layers. Anda dapat meng-
akses pilihan dan perintah 
tambahan pada menu Palet
Layers.

Keterangan:

A=Menu palet Layers, B=Groups,  
C=Layer, D=Expand/Collapese 
E=Efek Layer,  
F=Thumbnail Layer. 

 Untuk menampilkan Palet
Layer, pilih menu Win-
dows>Layers.

 Untuk mengaktifkan menu 
Palet Layers, klik gambar 
segitiga di sudut kanan 
atas. Menu yang ditampil-
kanadalah beberapa perin-
tah untuk bekerja dengan 
palet.

• Untuk mengubah ukuran 
thumbnail, klik Palet Options  
dari menu Palet Layers
kemudian pilih ukuran thum-
bnail.

Gambar 10.94: 



Desain Grafis Komunikasi 296

Gambar 10.99: membuat layer baru 

Gambar 10.100: Mengatur opacity layer

Layer Background 
Ketika anda membuat sebuah 
image baru dengan latar 
belakang putih maupun ber-
warna, di bagian bawah layer 
pada Pallet Layer tertulis 
Background yang menanda-
kan nama layer tersebut. Anda 
tidak dapat memodifikasi layer 
tersebut, seperti mengatur 
blending mode atau opacity.

Meski begitu, anda dapat 
mengubah status tersebut 
dengan cara mengkonversi la-
yer Background menjadi layer 
reguler. Caranya, klik ganda 
(double klik) layer Background
tersebut sehingga berubah 
namanya menjadi layer, atau 
Anda dapat melakukan pe-
rintah dengan cara memilih 
menu Layer > New > Layer 
From Background. 

Ketika anda membuat sebuah 
image yang transparan, image
tersebut tidak memiliki layer 
background sehingga Anda 
dapat memindahkan, memo-
difikasi blending mode dan 
opacity objek dalam layer 
tersebut.

Apabila anda ingin mengubah 
layer transparan menjadi layer 
Background, Anda dapat 
mengkonversi layer tersebut 
dengan cara memilih menu 
Layer > New > Background 
From Layer.

Gambar 10.98: Layers 
background
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Gambar 10.101: Membuat layer baru 

Gambar 10.102: Mengatur opacity layer

Membuat Layer Baru atau 
Group Baru
Untuk mempermudah ketika 
mengedit sebuah image, se-
baiknya membuat layer baru
atau group baru untuk objek 
lain. Hal ini perlu Anda lakukan 
karena ketika mengedit bebe-
rpa objek dalam satu layer,
Anda akan mengalami kesu-
litan. Layer baru atau group
baru dapat dibuat sesuai 
keinginan kita.  

Layer baru atau group baru 
akan muncul setelah layer
atau group tertentu aktif. Jadi, 
secara otomatis layer baru 
atau group baru akan terben-
tuk pada posisi di atas layer 
atau group yang sedang aktif 
dalam Palet Layers.

Untuk membuat layer baru 
atau group baru, lakukan 
beberapa teknik berikut:

 Klik ikon New Layer ( ) atau
New Group ( ) dibagian 
bawah Palet Layers.

 Pilih menu Layer > New > 
Layer atau pilih menu
Layer> New > Group.

 Pilih New Layer atau New 
Group dari menu Palet 
Layers.

Aturlah beberapa opsi layer,
kemudian klik OK. 

• Name = nama untuk layer 
baru atau group baru 

• Color = mengidentifikasikan 
warna layer atau group 
dalam Palet Layers.

• Mode = mengatur blending 
mode untuk layer atau group 
dalam Palet Layers.

• Opacity = mengatur tingkat 
opacity untuk layer atau
group dalam Palet Layers.

Menampilkan/
Menyembunyikan Layer atau
Group atau Style.
Layer atau Group atau efek 
layer dalam Palet Layers dapat 
ditampilkan maupun disembu-
nyikan kapan saja. Jika Anda 
tidak ingin menampilkan salah 
satu objek, Anda tidak perlu 
menghapus layer tersebut 
tetapi cukup menyembunyi-
kannya. Meskipun pada Palet
Layers masih muncul nama 
layer tersebut tetapi tidak akan 
ikut tercetak dalam image.
Yang akan dicetak adalah 
seluruh layer atau group yang 
nampak dalam Palet Layers.
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Gambar 10.103: 
Menampilkan/menyembunyikan layer

Gambar 10.104: Memilih 

Gambar 10.105: Memilih layer tidak urut 

Untuk menyembunyikan layer
atau group, pilih salah satu 
cara:

 Pada palet Layers, klik ikon 
mata di sebelah kiri layer
atau group untuk menyem-
bunyikannya.

 Tekan tombol Alt sambil 
mengklik ikon mata untuk 
menampilkan layer atau 
group tersebut, sedangkan 
layer atau group yang lain-
nya akan disembunyikan.

Memilih Menggabungkan 
dan Menghubungkan Layer
Memilih Layer
Anda dapat memilih salah satu 
atau beberapa layer sekaligus 
ketika sedang mengedit. Untuk 
melakukan berbagai tindakan 
seperti menggambar atau 
memberikan warna atau me-
ngatur tone (tone adjustment)
hanya dapat dilakukan pada 
salah satu layer tunggal.

Sedangkan ketika memin-
dahkan, mentransformasikan, 
mengatur alignment, dan 
memberikan style dapat dila-
kukan pada beberapa layer 
sekaligus. Anda dapat memilih 
layer pada palet Layers atau 
menggunaka tool Move.

Untuk memilih satu atau bebe-
rapa layer, pilih salah satu 
teknik:

 Klik layer yang diinginkan 
pada palet Layers

 Untuk memillih beberapa 
layer secara berurutan (dari 
atas ke bawah atau seba-
liknya), klik layer yang 
pertama kemudian tekan 
tombol Shift sambil meng-
klik layer lain untuk 
memilihnya. 

 Untuk memilih beberapa 
layer yang tidak berurutan, 
tekan tombol Ctrl sambil 
mengklik layer yang diingin-
kan.
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Gambar 10.106: Group 

Gambar 10.107: Group layer

Gambar 10.108: Ungroup

Menggabungkan dan Memi-
sahkan Layer Objek yang 
sering diedit secara bersa-
maan, sebaiknyadigabungkan 
dalam satu kelompok agar 
lebih efisien. 

1) Pilih beberapa layer yang 
ingin digabungkan menjadi 
satu group.

2) Lakukan salah satu cara: 
Pilih menu Layer > Group 
Layers.

Tekan tombol Alt sambil 
menyeret layer-layer ke dalam 
ikon Group di bagian bawah 
palet Layers.

Untuk memisahkan beberapa 
layer dalam satu group,  anda 
dapat memilih menu Layer > 
Ungroup Layers atau dengan 
cara memilih menu palet 
Layers.

Link dan Unlik Layer 
Anda dapat membuat link
(menghubungkan) pada bebe-
rapa layer maupun group.
Tidak seperti memilih bebe-
rapa layer sekaligus dalam 
satu waktu, layer yang telah 
terhubung (linked) akan 
memberikan efek satu sama 
lain. Anda dapat mentrans-
formasikan dan membuat 
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Gambar 10.109: Link layer

Gambar 10.111: Layer

clipping mask pada layer yang 
telah terhubung dan bahkan 
dapat menerapkan layer style
pada layer yang terhubung 
sehingga seluruh layer yang 
telah terhubung memiliki style 
yang sama. 

 Pilih beberapa layer atau 
beberapa group dalam 
palet Layers.

 Untuk membuat link, klik 
ikon Link (rantai) di bagian 
bawah palet Layers.

 Untuk memutuskan link
(Unlink), klik sekali lagi 
pada ikon Link.

Efek Layer dan Style 
Layer Style 
Adobe Photoshop menyedi-
akan fasilitas untuk membe-
rikan efek dan style seperti 
shadows, bevels, glows, over-
lay, dan strokes secara cepat 
pada objek dalam sebuah 
layer. Ketika Anda mengedit 
teks yang telah diberikan efek 
shadow maka efek tersebut 
juga ikut berubah sesuai 
dengan perubahan teks. Efek 
yang muncul pada layer
tersebut disebut Style.

Ketika sebuah layer memiliki 
syle maka pada layer tersebut 
akan muncul ikon “f” di bagian 
kanan. Untuk memberikan 
efek pada layer, klik pada layer 
yang ingi diberi efek kemudian 
klik ikon Style di bagian bawah Gambar 10.110 : Unlink
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Gambar 10.112: 
Shadow layer style 

Gambar 
10.113:
Inner Shadow  

Gambar 10.114:  
Outer glow  
layer style 

palet Layers (bertanda “f”). 
Anda dapat menentukan salah 
satu atau beberapa efek yang 
diinginkan (lihat 10.112) Anda 
dapat melihat seluruh efek 
yang telah digunakan pada 
layer tersebut dengan cara 
mengklik tombol “f”. Style ter-
sebut memuat informasi efek 
yang ada dan dapat ditambah 
maupun dikurani efeknya pada 
Layer Style.

Memilih Layer Style
Anda dapat mengatur efek 
layer dengan cara memilih 
style yang diinginkan. 

Shadow = menambahkan efek 
bayangan di bagian bawah 
objek.

Inner Shadow = menambah-
kan efek bayangan di bagian 
tepi objek 

Outer Glow and Inner Glow = 
menambahkan efek cahaya 
yang berasal dari dalam atau 
dari luar objek. 

Bevel and Emboss = menam-
bahkan kombinasi bayangan 
dan cahaya dalam sebuah 
objek.
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Gambar 
10.115:
Bevel layer 

Gambar 
10.116:

Gambar 10.117:  
Gradien layer style 

Gambar 10.118:  
Stroke layer style 

Satin = menerapkan bagian 
dalam berteduh yang dibuat 
satin.

Color, Gradient, and Pattern 
Overlay = memberikan warna, 
gradasi dan tekstur/pola. 

Stroke = memberikan outline
pada layer dengan warna ter-
tentu, gradasi maupun tekstur. 

Mengedit Layer Style
Setelah Anda memilih bentuk 
style yang diinginkan, Anda 
juga dapat mengeditnya suatu 
waktu secara cepat dan 
mudah.
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Gambar 10.119:  Layer style

Gambar 10.120: Menu layer 

Gambar 10.121: layer mask 

1) Untuk mengedit layer style, 
aktifkan layer yang ingin 
diedit

2) Kemudian klik ganda ikon 
Style di bagian kanan layer 
yang dimaksud maka akan 
muncul kotak dialog Layer 
Style. Yang bertanda cen-
tang menandakan efek 
tersebut digunakan dalam 
layer. Untuk mengeditnya, 
klik style tersebut. Selan-
jutnya, Anda dapat menga-
tur kombinasi efek yang 
diinginkan pada bagian 
kanan.

3) Atur pula untuk efek yang 
lain. Setelah selesai klik 
OK.

Layer Mask 
Dengan layer mask, Anda 
dapat menampilkan maupun 
menyembunyikan bagian ter-
tentu dari layer atau melin-
dungi area tertentu dari 
editing. Anda dapat membuat 
layer mask dengan dua cara: 

Layer Mask adalah gambar 
bitmap bergantung resolusi 
yang dibuat dengan lukisan 
atau tool yang dipilih. Vektor
Mask adalah resolusi yang 
mandiri dan dibuat dengan 
suatu pena atau tool Shape.

Pada palet Layers, layer mask 
dan vektor mask ditampilkan 
sebagai thumbnail tambahan 
di sebelah kanan thumbnail 
layer. Untuk layer mask, 
thumbnail ini dipresentasikan 
sebagai channel grayscale
yang terbuat ketika anda 
membuat sebuah layer mask.
Sedangkan vektor mask dipre-
sentasikan sebagai sebuah 
path yang berisi klip di luar 
layer.

A. Layer mask thumbnail  
B. Vector mask thumbnail
C. Vector Mask Link icon  
D. New Layer Mask 
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Gambar 10.122: Layer mask

Gambar 10.123: Menu vektor 
mask

Membuat Layer Mask
Anda dapat membuat layer 
mask untuk layer yang di-
tampilkan maupun disembu-
nyikan.

1) Membuat layer mask untuk 
layer yang nampak dan 
yang disembunyikan, pilih 
menu Select > Deselect
untuk membersihkan suatu 
seleksi tepi image yang 
tidak nampak. 

2) Pada palet Layers, pilih 
layer atau group yang akan 
dibuat layer mask. 

3) Lakukan slalah satu pi-
lihan:

• Untuk membuat layer mask
yang berisi seluruh layer, klik 
ikon New Layer Mask di 
bagian bawah palet Layers
atau pilih menu Layer > 
Layer Mask > Reveal All.

• Untuk membuat layer mask 
yang berisi layer yang di-
sembunyikan, tekan tombol 
Alt sambil mengklik ikon New
Layer Mask di bagian bawah 
palet Layers atau pilih menu
Layer > Layer Mask > Hide 
All.

Membuat Vektor Mask
Anda dapat membuat vektor 
mask untuk layer yang di-
tampilkan maupun disembu-
nyikan dan untuk shape yang
ditampilkan maupun disem-
bunyikan.

1) Pada palet Layers, pilih 
layer atau group yang akan 
dibuat

2) layer mask.

3) Lakukan salah satu pilihan: 

• Untuk membuat vektor mask 
yang berisi seluruh layer,
pilih menu Layer > Vektor 
Mask > Reveal All.

• Untuk membuat layer mask
yang berisi layer yang di-
sembunyikan, tekan tombol 
Alt sambil mengklik ikon New
Layer Mask di bagian bawah 
palet Layers atau pilih menu 
Layer > Vektor Mask > Hide 
All.

Filter
Menggunakan Filter
Dengan menu Filter, mengi-
jinkan Anda untuk mengubah 
tampilan image. Sebagai 
contoh, Anda dapat membe-
rikan efek mosaik maupun 
lukisan yang impresif atau 
menambahkan efek cahaya 
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yang unik maupun mendistorsi 
image Anda. Adobe Photo-
shop menyediakan menu Filter 
yang sudah dipaketkan dalam 
satu program Photo-shop,
namun Adobe Photo-shop ju-
ga mengijinkan pihak ketiga 
untuk menambahkan menu 
filter yang disebut Plug-in.

Untuk menggunakan Filter,
pilih menu Filter kemudian pilih 
salah satu jenis filter yang 
diinginkan. Ada beberapa re-
ferensi ketika ingin menggu-
nakan menu filter.

• Filter dapat digunakan untuk 
layer aktif, tersembunyi 
maupun yang diseleksi. 

• Filter tidak dapat digunakan 
untuk gambar mode Bitmap 
dan Indexed-color.

• Beberapa filter yang dapat 
bekerja pada gambar RGB. 

• Semua filter dapat digunakan 
untuk gambar 8 bit 

• Beberapa filter yang dapat 
digunakan untuk gambar 110 
bit adalah: Liquify, Average 
Blur, Bilateral Blur, Blur, Blur 
More, Box Blur, Gaussian 
Blur, Lens Blur, Motion Blur, 
Radial Blur, Sampled Blur, 
Lens Correction, Add Noise, 
Despeckle, Dust & Scrat-
ches, Median, Reduce 
Noise, Fibers, Lens Flare, 
Sharpen, Sharpen Edges, 
Sharpen More, Smart Shar-
pen, Unsharp Mask, Em-
boss, Find Edges, Solarize, 
De-Interlace, NTSC Colors, 

Custom, High Pass, Maxi-
mum, Minimum, dan Offset. 

• Beberapa filter yang dapat 
digunakan untuk gambar 32 
bit adalah: Average Blur, 
Bilateral Blur, Box Blur, 
Gaussian Blur, Motion Blur, 
Radial Blur, Sampled Blur, 
Add Noise, Fibers, Lens 
Flare, Smart Sharpen, Un-
sharp Mask, De- Interlace, 
NTSC Colors, High Pass, 
and Offset. 

• Beberapa filter diproses da-
lam RAM, sehingga jika 
Anda menggunakan bebe-
rapa filter akan muncul 
pesan error atau memori 
yang digunakan tidak me-
madai untuk memproses 
filter yang digunakan. Seper-
ti telah disebutkan di awal, 
Adobe Photoshop juga me-
ngijinkan pengembang pihka 
ketiga untuk membuat filter 
baru dan dapat diinstal ke 
dalam Adobe Photoshop.
Setelah Anda menginstal 
Plug-in, filter baru akan 
muncul pada menu Filter.

Filter Gallery 
Filter Gallery mengijinkan An-
da menggunakan filter secara 
komulatif dan menggunakan 
filter tertentu lebih dari satu 
kali. Anda dapat melihat 
contoh thumbnail dari tiap filter
yang digunakan. Anda dapat 
pula mengatur kembali filter 
dan mengubah pengaturan 
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Gambar 10.124: Filter
Gallery

Gambar 10.127: Fresco, Neon 

filter yang telah digunakan 
menjadi efek yang diiginkan. 
Untuk menampilkan menu 
Filter Gallery, pilih menu Filter 
> Filter Gallery. Klik sebuah 
kategori yang ditampilkan 
thumbnail dari efek filter yang 
ada.

A. Preview  
B. Kategori Filter
C. Thumbnail filter yang dipilih  
D.Menampilkan/menyembunyikan 

thumbnail filter
E. Menu pop-up
F. Options untuk filter yang dipilih  
G. Daftar efek filter untuk ditampilkan atau 

disusun kembali  
H. Efek filter yang dipilih tetapi tidak  
I. Efek filter digunakan beberapa kali tetapi 

tidak dipilih
J. Efek filter yang disembunyikan 

Efek Filter
Secara default, Adobe Photo-
shop memiliki 22 kategori filter
yang dapat digunakan. 

1. Artistic
Filter dari sub menu Artistic
membantu Anda menjadi 
seorang pelukis dan efek 
artistik untuk sebuah karya 
seni rupa maupun proyek 
komersial. Sebagai contoh, 

gunakan filter Cutoour untuk 
membuat gambar yang dibuat 
dari potongan atau untuk 
tipografi, filter ini merupakan 
replikasi alami atau media 
tradisional.

Gambar 10.126: Dry Brush, Film 

Gambar 10.125: Colour Pencil, 
Cutout
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Gambar 10.128:  
Poster edges, Rough Pastels 

Gambar 10.129: Accented Edges, 
Angled Stroke

Gambar 10.130: Dark
stroke,

Gambar 10.131: 
Spatter,

Sprayed stroke 

2. Brush Stroke
Seperti filter Artistic, filter 
Brush Stroke filters membe-
rikan keleluasaan Anda me-
lukis atau nampak seperti seni 
rupa menggunakan brush
tertentu dan efek tinta me-
ngembang. Beberapa filter
ditambahkan grain, paint,
noise, edge detail, atau 
texture. Semua filter Brush 
Stroke dapat digunakan pada 
Filter Gallery.

3. Distort
Filter Distor secara geometris 
mendistorsi sebuah image, 
menciptakan 3D atau efek lain. 
Sebagai catatan bahwa filter
ini dapat menjadi memori yang 
intensive. Filter Diffuse Glow, 
Glass, dan Ocean Ripple
dapat digunakan pada Filter 
Gallery.
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Gambar 10.132: Diffuse glow, 

Gambar 10.133: Bas Relief, Chalk & 
charcoal

Gambar 10.134: Conte Crayon, 
Photocopy

Gambar 10.135: 
Reticulation,

4. Sketch
Filter dalam submenu Sketch
menambahkan tekstur ke  
image, sering pula digunakan 
untuk efek 3D. Filter ini  juga 
berguna untuk menciptakan 
sebuah lukisan atau  nampak 
hand-down. Banyak dari filter 
Sketch digunaka  untuk latar 
belakang dan latar depan 
berwarna ketika  mereduksi 
image tersebut. Semua filter 
Sketch dapat  diterapkan pada 
Filter Gallery.

5. Texture
Gunakan filter ini untuk 
menirukan penampilan unsur  
atau kedalaman, atau 
menambahkan efek organik.  
Filter ini memiliki sub menu 
yang berjumlah 10, dan  
semuanya dapat diterapkan 
pada Filter Gallery.



Desain Grafis Komunikasi 309

Gambar 10.136: Craquele,

Gambar 10.137: Mosaic 
tiles,

Stain Glass 

C. Teknik Photoshop 
1. Membuat teks dengan 

outline
Langkah-langkah: 

Buat file baru. 

 Dengan menggunakan 

Type Mask Tool ,
buatlah sembarang teks 

Dari menu Edit, pilih Stroke.
Beri nilai pada width, misalnya 
3.

Sekarang Anda bisa membari 
warna pada bagian dalam teks 
tersebut dengan menggu-
nakan Paint Bucket Tool.

2.  Teknik Dasar Dalam 
Membuat Effect Petir
Pada Photoshop

Langkah-langkah: 

Buatlah sebuah file baru 
dengan menekan Ctrl + N, 
pilih ukuran sesuai dengan 
keinginan anda dan warna 
dasar adalah hitam. Kemu-
dian buatlah layers baru dan 
mulailah membuat garis 
dengan menggunakan Air

Gambar 10. 
138:

Gambar 10. 139:  
Penerapan
stroke

Gambar 10. 
140:
Penerapan Paint  
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Gambar 10. 141: Hasil langkah a. 

Gambar 10. 142: Hasil langkah b. 

Gambar 10. 143: Hasil langkah 

Gambar 10. 144: Hasil langkah d. 

Brush (B) dengan besar titik 
fokus 5px atau sesuaikan 
dengan gambar anda. Bu-
atlah secara acak sehingga 
menyerupai petir yang se-
dang menyambar. 

Klik kanan pada layers yang 
anda buat kemudian pilih 
Blending Options lalu pilih 
Outer Glow dan ganti 
warnanya menjadi agak kebi-
ru-biruan. Sesuaikan besar 
kecilnya ukuran dan trans-
paransi penyebaran glownya
dengan gambar anda buat. 

Kecilkan ujung-ujung dari garis 
yang anda buat dengan Eraser
Tool (E) dan kemudian lem-
butkan garis-garis tadi dengan 
Smudge Tool ® 

Buat garis yang lebih kecil 
untuk membuat anak lidah dari 
petir dengan Air Brush dengan
transparansi (opacity) sekitar 
25-30%
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Gambar 10.145:  
Tool quick mask di toolbox

Gambar 10. 146:  
menu pilihan brush 

pada option bar Gambar Gambar 10. 
148:
Foreground dan
background colour 

3.   Menggunakan Quick 
Mask untuk menyeleksi 
gambar

Metode ini digunakan apabila 
kita kurang leluasa bila meng-
gunakan teknik lasso. Sebab 
dengan quick mask kita bisa 
dengan leluasa menyeleksi 
obyek yang akan kita ambil 
dengan media brush (seperti 
kita menggunakan kuas lukis 
untuk menggambar obyek). 
Langkah-langkah menyeleksi 
gambar dengan metode quick
mask adalah sebagai berikut: 

Langkah 1:  
Buka file yang akan diambil 
gambarnya

Langkah 2:  
Aktifkan mode quick mask
atau tekan tombol Q pada 
keyboard

Langkah 3:  
Pilih pilihan brush yang akan 
kita gunakan untuk me-
nyeleksi gambar pada option 
bar.

Langkah 4:  

Seleksi gambar yang akan kita 
ambil, namun tekniknya disini 
dibalik yaitu gambar yang akan 
kita ambil tidak di brush.
Sebagai contoh kita akan 
mengambil gambar anak, ma-
ka yang kita brush adalah 
gambar latar belakangnya, 
seperti gambar dibawah ini 

Pada langkah quick mask ini 
perlu ditekankan mengenai 
warna seleksi dari brush.
Perhatikan warna foreground
dan background pada mode 
quick mask seperti gambar 
dibawah ini. 

Gambar 10. 147: Penggunaan 
brush
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Gambar 10. 149: 

(a) gambar diseleksi dengan quick
mask,

(b) gambar dikembalikan ke mode 
standar,

(c) hasil gambar setelah di copy.

Gambar 10. 150: Foto gadis hitam-putih 

Untuk mode quick mask,
warna yang digunakan pada 
foreground apabila berwarna 
hitam berarti gambar yang 
terkena brush adalah gambar 
yang terseleksi, kalau ber-
warna putih berarti gambar 
yang terkena brush adalah 
gambar yang tidak terseleksi 

Apabila telah selesai kita 
brush, maka kita kembalikan 
ke mode standart. Maka akan 
dihasilkan hasil gambar yang 
telah terseleksi, tinggal kita 
lakukan langkah copy gambar. 
Seperti gambar berikut di 
bawah ini 

4.   Melukis tangan sebuah 
Gambar Hitam dan Putih 

Gambar dari anak perempuan 
di jendela yang diperlihatkan di 
gambar 10.150 adalah satu 
dari banyak foto hitam putih 
hasil pemotretan Scott 
Dingman yang sangat bagus. 
Scott sering menggunakan 
jasa seniman grafis  honorer,
Tammy Kennedy untuk me-
ngedit gambarnya, Tammy 

memberikan kepada penulis 
teknik dan saran untuk lukisan 
tangan digital dari gambar 
Hope Linhof milik Scott. Saya 
sangat menyukai foto lukisan 
tangan hitam putih tradisional 
yang telah dicat dengan cat 
fotografis tradisional. Bagaima-
napun, melukis menggunakan 
cat tradisional memakan wak-
tu. Bahkan kesalahan paling 
kecil sering tidak dapat 
diperbaiki.

Melukis satu foto adalah satu 
pekerjaan besar yang membu-
tuhkan banyak ruang dan 
waktu. Anda samasekali tidak 
dapat membuat bebe-rapa 
salinan tanpa melukis tiap–tiap 
foto yang disalin. Palet warna 
memiliki banyak batasan dan 
penulis tidak menyukai proses 
menuggu pengeringan cat.

Mempergunakan teknik dan 
saran dari Tammy Kennedy, 
semua hal negatif itu sirna! 
Hasil dari penerapan teknik ini 
dapat menjadi sangat fan-
tastis, coba gunakan pada 
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Gambar 10. 151: Menu 

gambar di atas, kemudian 
pada salah satu foto anda 
sendiri.

Langkah 1:  
Buka file 

Pilih File > Open (Ctrl+O) 
untuk menampilkan Open 
dialog box. Klik ganda folder 
lokasi gambar, dalam hal ini 
hope – before.tif.

Langkah 2:  
Penerangan Gambar 

Untuk memungkinkan warna 
lukisan tangan yang halus 
menjadi lebih kelihatan, tam-
bah penerangan gambar 
dengan memilih Layer > New 
Adjustment Layer > Curves
untuk menampilkan New
LayerDialog box. Ketik lighten 
background dalam Name box
dan klik OK untuk menam-
pilkan Curves dialog box. Klik 
curve untuk mengatur poin 
dengan nilai Input dan Output
50 dan 108, seperti 
ditampilkan pada gambar 1.3. 
klik OK untuk membuat 
adjustment layers.

Langkah 3:  
Tambahkan Layer untuk 
Setiap Warna san Warna-
warna Lukisan 

Pendekatan terbaik untuk 
penciptaan gambar lukisan 
tangan adalah dengan mem-
buat satu lapisan terpisah 
untuk masing – masing warna 
yang anda pergunakan. Atur 
mode Blend pada Layers 
palette untuk masing – masing 
Color Layer untuk pewarnaan.

Gambar 10.151 memper-
lihatkan bagaimana Tammy 
membuat folder–folder dan 
menggunakan warna-warna 
pada Layers palette untuk 
menolong dirinya dalam me-
lacak warna cat dan 
adjustment layers apapun 
yang ditambahkan ke dalam 
color layers. Keuntungan dari 
pendekatan ini adalah sega-
lanya dapat diatur ulang!

Anda dapat dengan mudah 
menghapus layer, mengo-
songkan layer, atau menam-
bahkan suatu adjustment layer
untuk mengubah warna atau 
meningkatkan titik jenuh war-
na. Kalau anda melukis 
dengan suatu kuas halus 
dengan Keburaman (Opacity)
mulai 10 - 15%, anda dapat 
secara berangsur – angsur 
menyusun warna dan akan 
terlihat lebih lembut diban-
dingkan jika anda menggu-
nakan suatu konfigurasi ke-
buraman yang lebih tinggi.  
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Gambar 10. 152: 

Gambar 10. 153: Efek yang menarik  
pada benda 

Kalau keseluruhan layer war-
na terlihat gelap, anda dapat 
dengan mudah mengatur 
ulang dengan mengurangi Ke-
buraman dari layer pada 
Layers palette.

Jika anda bertanya – tanya 
warna apa yang tepat guna, 
buka sebuah potret dengan 
warna serupa dan gunakan 
Eyedropper untuk memilih 

warna utama, misalnya kulit 
dan mata; kemudian melukis 
warna itu pada gambar kerja.

Foto lukisan tangan terbaik 
biasa-nya dilukis dengan 
warna–warna lembut. Salah 
satu kesalahan yang biasa 
terjadi pada mereka yang 
masih baru dalam bidang foto 
lukisan tangan adalah pema-
kaian warna yang terlalu 
berani. Jadi gunakan warna 
yang tidak terlalu tajam, 
kerjakan dengan santai, dan 
melukislah dengan sebuah 
setelan Kebu-raman yang 
rendah. Hasil kerja anda akan 
terlihat jauh lebih profesional. 

5. Membuat sebuah 
“Pseudosolarization”
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Gambar 10. 154: Menu levels

Sebuah pseudosolarization – 
solarisasi semu, apakah itu 
dan apakah saya perlu mem-
buatnya? Ada istilah solarisasi 
kimia, dan solarisasi di kamar 
gelap pada proses penca-
hayaan dari slide negatif film 
(exposure), kemudian bebe-
rapa yang lain diciptakan 
secara teori.  

Pencahayaan yang diperlukan 
dalam menghasilkan solarisasi 
mutlak adalah mulai dari 1,000 
sampai 10,000 kali untuk 
menghasilkan warna hitam 
total pada sebuah negatif film, 
yang mana agak sulit pembu-
atannya, terkecuali jika anda 
menggunakan Photoshop 7
dan dapat mengambil jalan 
lain di sekitar definisi sebe-
narnya.

Penulis lebih condong pada 
kinerja kreatif dibandingkan 
teknis, dan gagasan menukar 
beberapa atau keseluruhan 
warna terlihat sangat menarik, 
asumsikan ini adalah suatu 
efek fotografis klasik yang 
resmi, yang berarti dituangkan 
secara tepat pada bab ini. 
(Kenyataannya, penulis menik-
mati modifikasi Curves dan 
ingin membahasnya dalam 
penulisan ini, dikarenakan juga 
karena pseudosolarization da-
pat menciptakan efek – efek 
baru yang sangat menarik.) 
Efek ini bahkan terlihat lebih 
baik ketika anda membuat 
keseluruhan portofolio pseu-
dosolarizations! Coba terapkan 
teknik ini pada beberapa 

gambar anda, mungkin anda 
akan menyukai hasilnya. Jika 
tidak, pertimbangkan saja ilmu 
pengetahuan tentang teknik ini 
untuk memecah suasana se-
rius yang terdapat dalam 
teknik – teknik photoshop 7
lainnya.

Langkah 1:  
Buka File

Pilih File > Open (Ctrl+O) 
untuk menampilkan Open 
dialog box. Klik ganda pada 
folder lokasi gambar, dalam 
hal ini rusty – truck – before.tif.
Klik Open untuk membuka file.  

Langkah 2:             
Pengaturan Levels

Pilih Layer > New Adjustment 
Layer > Levels untuk
menampilkan New Layer
dialog box. Klik OK untuk 
menampilkan Levels dialog 
box seperti pada gambar 2.3. 
Geser slider hitam di sisi 
kanan sampai Input Levels
mencapai poin 18, 1.0, dan 
255.
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Gambar 10. 155: Menu Curves

Gambar 10. 156: Hasil

Gambar 10. 157: Konversi foto

Langkah 3:             
Pengaturan Curves

Pilih Layer > New Adjustment 
Layer > Curves untuk me-
ampilkan New Layer dialog 
box. Klik OK untuk mem-
eroleh Curves dialog box. 
Mulai atur dan memindahkan 
poin – poin di sekitar kurva 
untuk membuat kurva menye-
upai seutas tali panjang yang 
digerakkan naik dan turun. 
Umumnya, sebaiknya anda 
mempertahankan posisi kedua 
poin – akhir.  

Penulis menetapkan poin – 
poin pada Curves, seperti itu 
terlihat di gambar 2.4 untuk 
memperoleh gambar yang 
diperlihatkan di gambar 2.2. 
Keberagaman kurva tidak ter-
atas, bereksperimenlah dan 
lihat apa yang anda dapat 
ciptakan. Coba gunakan dua, 
tiga, dan empat set loop.   

Saat anda mendapat gambar 
yang anda inginkan, pertim-
angkan untuk membuat 
adjustment layer baru untuk 
Hue/ Saturation. Gambar 
10.1510 menampilkan hasil 
dari penerapan Hue/Saturation
dengan konfigurasi +101, –15, 
dan 0 pada gambar 2.2. 
Percaya atau tidak, teknik ini 
harus dicoba pada beragam 
jenis gambar yang berbeda, di 
mana hasilnya tidak dapat 
diperkirakan dan dapat meng-
hasilkan gambar berkualitas 
baik.

10. Konversi Foto berwarna 
ke Hitam Putih
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Gambar 10. 158:  
Merubah dokumen ke grayscale

Gambar 10.159: Merubah pola level
kontrol untuk sisi gelap

Gambar 10.160: Merubah pola level
kontrol untuk sisi terang 

Gambar 10.161: Gambar 
duotone

Langkah  1: Buka File

Langkah  2:                         
Pilih image>  ode> Grayscale
kemudian klik pada OK

Langkah 3:  
Mempergunakan level kontrol, 
petakan titik gelap ke hitam 
dengan memindahkan panel 
ke hitam 

Langkah  4:   
Untuk mengevaluasi sisi te-
rang gerakkan panel putih 
kekiri

7. Membuat Gambar Mode 
Duotone

Mode gambar duotone ialah 
salah satu mode gambar yang 
mana gambar yang dihasilkan 
adalah terdiri dari campuran 2 
warna dari mode warna RGB. 
Adapun langkah-langkah pem-
buatan gambar mode duotone
adalah sebagai beriku 

Langkah 1:  
Buka File yang akan dibuat 
mode duotone

Langkah 2:  
Konversi gambar ke Duotone

Kita tidak dapat mengkonversi 
langsung gambar ke mode 
duotone terlebih dulu kita 
konversikan ke mode 
grayscale yaitu dengan cara, 
pilih Image -> Mode ->
Grayscale. Kemudian pilih 
Image -> Mode -> Duotone 
untuk masuk ke  kotak dialog
Mode Duotone, seperti terlihat 
pada gambar dibawah ini. Klik 
pada Jenis kotak dan memilih 
Duotone.
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Gambar 10.1102: Mode 

Gambar 10.163: Kotak dialog 
warna

Gambar 10.164: hasil fokus pada 
suatu bagian dari gambar 

Gambar 10.165: gambar 

Untuk memilih warna yang 
pertama, klik warna untuk 
Tinta 1 untuk menampilkan 
kotak dialog warna seperti 
terlihat pada gambar dibawah 
ini Untuk menyetel warna 
hitam sebagai warna yang 
pertama, ketik 0 pada warna 
R, G, dan b.

Untuk warna yang lain pilih 
warna pada kotak warna lalu 
klik Ok. Lakukan langkah ini 
untuk warna ke 2. 

Apabila pada mode duotone
warna 1 dan 2 sudah terisi, 
lalu klik Ok. Untuk melihat 
hasil dari mode duotone. 

8.  Membuat teknik fokus 
pada satu bagian gambar 

Untuk membuat teknik ini kita 
pertama-tama sudah harus 
memutuskan dari suatu gam-
bar obyek apa yang akan kita 
angkat sebagai fokus, kemu-
dian lakukan langkah-langkah 
berikut ini: 

Langkah 1:  
Buka file yang akan kita guna-
kan, sebagai contoh Bebek 
Jpg, seperti gambar berikut. 

Langkah 2:  
Seleksi bagian gambar yang 
akan kita jadikan fokus de-
ngan menggunakan lasso tool.
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Gambar 10.169: Hasil 
Akhi

Gambar 10.168: Image asli hasil tool blur

Gambar 10.166: Hasil lasso

Gambar 10.167: Hasil gradien pada layer

Langkah 3:  
Setelah diseleksi kemudian 
copy gambar tersebut, kemu-
dian paste gambar sehingga 
terbentuk layer baru pada 
palette layer.

Setelah itu aktifkan mask tool
pada layer yang baru tersebut, 
kemudian pada cendela mask 
buat gradien (warna gradien
hitam dan putih). Sehingga 
menghasilkan pada palette 
layer seperti gambar dibawah 
ini. Setelah itu sembunyikan 
layer ini dengan menekan 
pada palette layer.

Langkah 4:  
Pada layer gambar yang asli 
gunakan tool blur untuk mem-
buat hasil blur pada gambar 
yang asli, sehingga mengha-
silkan hasil berikut. 

Langkah 5:  
Tampilkan semua layer se-
hingga didapatkan hasil akhir 
seperti berikut. 

D. Pendalaman 
Buatlah gambar baru dengan 
cara menggabungkan dua 
gambar (foto) yang beda, 
sehingga nantinya akan meng-
hasilkan gambar baru. 



Desain Grafis Komunikasi 320

Melalui proses komunikasi, 
pesan atau informasi dapat 
diserap dan dihayati orang 
lain. Agar tidak terjadi kese-
satan proses komunikasi yang 
di sebut media. Media infor-
masi dan komunikasi suatu 
produk/jasa diperlukan kejeli-
an, baik bidikan pasar, trategi, 
desain, maupun yang lain. 

A. Kemasan Produk 
1. Maksud dan Tujuan De-

sain Kemasan 
Desain Kemasan dari jaman 
Prasejarah hingga kini menga-
lami perkembangan dari segi 
maksud dan tujuan. 

 Desain Kemasan Sebagai 
Persembahan

Desain kemasan, khususnya 
produk tradisional masih ada 
yang ditujukan pada Yang 
Maha Kuasa sebagai persem-
bahan, apakah rasa syukur 
terhadap keselamatan atau 
pemberianNya, atau suatu 
permohonan seseorang atau 
kelompok masyarakat untuk 
mendapat keselamatan atau 
keberkahan. Sebagai contoh 
desain kemasan yang dicip-
takan pada kegiatan sakral 
Kerajaan yang bersifat magis 
pada Ulang Tahun Kenaikan 
Tahta Raja, dan peringatan 1 
Syura, maupun Syawalan.  

Bisa juga tampilnya kotak yang 
dicat warna emas (prodo)
sebagai tempat atau barang 
yang dipersembahkan oleh 
Raja.

 Desain Kemasan Sebagai 
Daya Tarik 

Di Jaman modern ini, Desain 
Kemasan dihadirkan tidak lagi 
diperuntukkan sebagai per-
sembahan meskipun masih 
mengandung unsur tradisi-
onal, tetapi tampilnya desain 
kemasan sebagai daya tarik 
untuk dinikmati atau memberi 
kesan nostalgia masa lalu. 
Sebagai contoh makanan lem-
per yang ditampilkan dengan 
pembungkus plastik warna 
hijau muda menyerupai daun 
pisang muda, atau permainan 
yang dianyam dari janur 
diganti dengan kertas. Tam-
pilnya jenis pembungkus dan 
jenis mainan tradisional ini 
disebabkan sulitnya daun pi-
sang atau sejenisnya di kota-
kota besar. Begitu juga pem-
bungkus kado yang didesain 
seindah mungkin, tidak lain 

Gambar 11.1: Kemasan tradisional 
yang mengandung magis 

XI. JENIS MEDIA GRAFIS KOMUNIKASI
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adalah untuk menambah daya 
tarik terhadap sesuatu yang 
dibungkus.

 Desain Kemasan Sebagai 
Penutup

Suatu produk tanpa desain 
kemasan, ibarat orang tanpa 
baju. Desain kemasan ber-
fungsi sebagai penutup bila 
mana produk tidak dibungkus. 
Dalam hal ini fungsi desain 
kemasan hanyalah semata-
mata untuk melindungi produk 
(seperti makanan) tidak dima-
kan atau dihinggapai berbagai 
binatang, dan menghindari 
debu atau polusi agar tetap 
enak dan tidak berpenyakit. 
Bila desain kemasan berfungsi 
sebagai penutup, tentu dalam 
hal tampilan visual sangat 
kurang diperhatikan. Sebagai 
contoh penutup makanan di 

meja makan, yang dulunya 
menggunakan bahan dari 
bambu sekarang menggu-
nakan bahan dari plastik. 

2. Fungsi Desain Kemasan 
a. Pembungkus  

Pembungkus fungsi utama 
adalah untuk melindung pro-
duk yang ada di dalamnya, 
sedangkan fungsi yang lain 
dalam perkembangan terakhir 
ini adalah sebagai promodi, 
atau informasi sebuah produk 
yang didalamnya. 

 Makanan dan Minuman 

Desain kemasan yang difung-
sikan sebagai pembungkus 
makanan atau minuman sa-
ngat didekatkan pada rasa, 
warna, dan kenikmatan pro-
duk di dalam desain kemasan. 

Gambar 11.2: Kemasan memberikan 
pilihan yang lebih terhadap konsumen

Gambar 11.3: Kemasan yang berfungsi 
hanya sekedar penutup atau tempat
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Dalam desain kemasan ma-
kanan atau minuman harus 
memperlihatkan jenis produk 
didalamnya dengan cara trans-
parasi bentuk desain kemas-
an, atau tampilnya gambar 
produk di dalam desain 
kemasan.

Hal ini sangat membantu calon 
pembeli untuk melihat sesung-
guhnya bentuk atau karakter 
produk yang ada dalam pem-
bungkus. Bahan desain ke-
masan harus memperhatikan 
jenis atau sifat makanan/ 
minuman, sehingga tidak me-
ngakibatkan kerusakan produk 
atau mempengaruhi / mengu-
rangi rasa produk. 

 Obat-obatan 

Desain Kemasan untuk obat-
obatan selalu diarahkan pada 
fungsi produk agar orang yang 
membelinya mengetahui fung-
si dan kegunaan obat untuk 
kesehatan.  

Tidak mengherankan bila da-
lam desain kemasan selalu 
ditampilkan tulisan keguanaan 
obat dan komposisinya. Begitu 
pula warna yang ditampilkan 
selalu mengarah pada rasa, 
seperti kuning menyimbulkan 
rasa jenuk. Di samping itu ada 
kode etik yang harus disam-
paikan, seperti lingkaran biru 
pada desain kemasan obat 
menandakan obat kesar, ling-
karan warna merah me-
nandakan obat luar, dan 
sebagainya. Bentuk desain 
kemasan tentunya juga ber-
beda-beda. Obat yang tem-
patnya botol selalu dibungkus 
dengan desain kemasan ko-
tak, dengan maksud agar tidak 
mudah pecah, mudah dibawa, 
dan mudah dikemas dalam 
dus.

Gambar 11.4: Kemasan yang bagus dapat membujuk calon pembeli 

Gambar 11.5: Kemasan selalu  
berdampingan dengan merek
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 Alat dapur/ Elektronik 

Jenis produk ini sangat 
reskhan dalam benturan, pe-
nyimpanan dan sulit pena-
taannya. Agar produk tidak 
rusak, lebih mudah di atur, dan 
sebagai informasi produk, 
maka perlu adanya desain 
kemasan yang multi guna. 
Jenis bahan yang digunakan 
adalah bahan yang murah, 
kaku, ringan, dan tebal, se-
perti lapisan kertas berge-
lombang. Bentuk atau model 
desain kemasan disesuaikan 
dengan karakter isi desain 
kemasan (produk), sehingga 
anatomi produk maupun 
tangan manusia sangat diper-
timbangan.

 Kosmetik 

Desain kemasan yang seba-
gian berukuran kecil ini sangat 
dominan dalam segi ekonomi, 
yaitu menginformasikan pro-
duk melalui desain kemasan. 
Bentuk, ukuran, maupun 
warna sangat melekat pada 
produk di dalamnya, seperti 
lipstik yang berwarna merah 
dengan desain kemasan war-
na merah pula. Untuk desain 
kemasan jenis ini biasa 
ditampilkan bentuk yang kecil-
kecil, manis, dan feminin 
dengan warna-warna ceria 
dan romantis. 

b. Sovenir 

Desain kemasan yang diper-
untukkan untuk produk ini 
biasa mengarah ke warna 
alam agar menyatu dengan 
produk sovenir. Adapun ben-
tuknya ditampilkan secara 
sederhana yang biasa menga-
rah nostalgia yaitu modivikasi 
tradisional (kontemporer). De-
sain kemasan yang unik dan 
aneh tanpa banyak elemen 
desain disengajakan untuk 
menonjolkan isi produk agar 
tampil lebih menawan dan 
menambah nilai jual. 

Gambar 11.6: Bagaimana 
membedakan kemasan obat batuk 

Gambar11.8: Kemasan kosmetik 
sangat memperhatikan argonomis  

Gambar 11.7: Gambar produk 
ditampilkan pada kemasan salah

satu trategi pasar 
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 Benda Hias 

Sebagian masyarakat kadang 
suka berhias diri melalui 
penampilan keindahan dise-
kitarnya, seperti sangat mem-
perhatikan kondisi rumah atau 
tempat kerjanya. Berhias disini 
dalam pengertian suka me-
nata ruang baik luar maupun 
dalam agar tampil cantik, me-
nawan, dan enak dipandang 
mata bagi yang melihatnya.

Sebagai contoh tampilnya 
barang-barang hias yang di 
tempatkan di luar rumah untuk 
menyapa tama yang datang, 
atau hiasan dalam rumah yang 
seakan mengajak tamu untuk 
berbicara atau teman pendam-
ping dalam mengisi kekosong-
an pembicaraan dengan tuan 
rumah.

 Benda Pakai 

Barang pakai sangat dide-
katkan denga kebutuhan si 
pemakainya secara langsung 
maupun tidak lansung. Secara 
langsung adalah benda yang 
di pakai sehari-hari seperti 
sepatu, tas, dan sebagainya 
yang selalu melekat pada si 
pemakai. Sedangkan benda 
pakai tang lansung meru-
pakan benda yang dipakai bila 
orang sewaktu-waktu membu-
tuhkannya, seperti peralatan 
dapur, dan sebagainya. 

Gambar 11.9: Kemasan sovenir yang 
dibuat kuat dan menarik 

Gambar 11.10: Kesan cantik pada 
kemasan sebagai tempat perhiasan  

Gambar 11.11: Sebagai tempat 
sekaligus sebagai untuk aksesoris diri  
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3. Bahan Desain Kemasan 
a. Bahan Flora dan Fauna 

Alam seisinya merupakan 
pemberian Yang Maha Kuasa 
luar biasa. Flora dan fauna 
sebagai contoh kecil yang bisa 
kita nikmati bersama untuk 
bisa digunakan atau diman-
faatkan untuk kebutuhan 
manusia. Kulit binatang, yang 
akhir-akhir ini menjadi trend 
pembungkus dan produk 
desain kemasan dalam per-
kembangannya dilarang mem-
produksi jenis barang atau 
pembungkus dari kulit bina-
tang. Kulit dan daun tumbuh-
tumbuhan sangat menawan 
untuk dibuat Desain Kemasan 
yang mengarah produk-pro-
duk tradisional. 

b. Bahan dari Tanah 

Tanah tidak sekedar dianggap 
tujuan akhir sebuah perja-
lanan hidup, yaitu mening-
galnya makhluk hidup tetapi 
sebuah pengembangan diri 
termasuk berkarya seni dan 
desain menggunakan bahan 
dari tanah. Menciptakan karya 
desain kemasan dari dulu 
hingga saat ini terus meng-
gunakan bahan dari tahan, 
seperti keramik yang dibuat 
berbagai jenis dan fungsi pro-
duk pelengkap estetik interior 
maupun eksterior. 

c. Bahan Sintetis 

Sintetis merupakan bahan 
tiruan yang terbuat dari bahan 
kimia. Jenis ini bersifat flek-
sibel, elastis, dan berfariasi 
pilihan, sehingga mudah di-
bentuk sesuai dengan model, 
mudah dilipat, dan mempunyai 
nilai ekonomis. Jenis bahan ini 
yang paling meonjol dipakai 
untuk berbagai desain ke-
masan adalah plastik. Jenis 
bahan ini sangat dibutuhkan, 
disamping harganya murah, 
juga banyaknya pilihan karak-
teristik, baik ketebalannya, 
kekuatannya, lemas/kakunya, 
dan sebagainya. Penggunaan 
jenis bahan ini bisa ditam-
pilkan dengan teknik trans-
paran maupun cara tertutup.

Gambar 11.12 (kanan):  
Kemasan dari plastik untuk 

menghindari pecahnya kemasan  
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d. Bahan dari Logam 

Jenis bahan ini merupakan 
jenis yang mahal harganya 
dan mempunyai kekuatan 
mempertahankan produk bila 
ada benturan. Sifat kaku yang 
dimiliki jenis bahan ini mem-
buat ketenangan para pembeli 
terhadap kualitas isi produk, 
hanya harga produk lebih 
tinggi dari produk yang lain. 
Orang tertarik pada desain 
Kemasan dengan logam kare-
na memiliki daya kemewahan, 
dan kuat. 

4. Faktor Ekonomi Dalam 
Desain Kemasan 

a. Faktor Kepraktisan 

Desain Kemasan dibuat untuk 
membungkus produk maupun 
berfungsi sebagai alat atau 
media mengejar kepraktisan. 
Dikatakan praktis karena pro-
duk yang akan dibeli sudah 
siap dibawa pulang, atau 
melayani pembeli untuk lebih 
cepat membuka desain ke-
masan.

Multi fungsi sering pula ditam-
pilkan dalam desain kemasan 
sesuai selera konsumen da-
lam penggunaan produk yang 
dibeli dengan mengatur atau 
menggunakan desain kemas-
an. Biasanya jenis desain 
kemasan ini sangat memper-
hatikan kegunaannya setelah 
pasca guna, yaitu penggu-
naan desain kemasan setelah 
tidak dipakai secara sesung-
guhnya tetapi untuk hiasan 
atau fungsi lain. 

b. Faktor Kemudahan 

Faktor kemudahan juga men-
jadi pemikiran dalam mencip-
takan sebuah desain kemas-
an, antara lain: 

 Mudah dibawa 

Produk yang dikemas beru-
kuran kecil maupun besar 
harus memperhatikan segi 
kemudahan untuk dibawa, 
baik dibawa sendiri atau 
dengan orang lain.

Gambar 11.13: Kemasan dari logam 
untuk menghindari lembab dan  

bau sengat
Gambar 11.14: Perlu pemikiran fungsi 
kemasan pasca jual
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 Mudah ditata 

Dalam segi penataan harus 
juga diperhatikan dalam pen-
ciptaan desain kemasan, 
apakah penataan di dalam 
pembungkus yang dibawa 
untuk keluar kota, atau mudah 
ditata dalam etalase (rak 
pajang) toko. Pemikiran kemu-
dahan penataan ini didasar-
kan atas servis produsen 
(perusahaan) kepada penjual 
terhadap kemudahan tersebut. 

 Mudah dibuat 

Faktor mudah dibuat meru-
pakan proses desain hingga 
dalam pembuatan desain 
kemasan. Suatu desain yang 
berhasil adalah bila desain 
tersebut bisa dikerjakan de-
ngan teknologi proses dan 
terjual. Maka seorang pende-
sain harus memperhatikan 
cara pengerjaan desain ke-
masan hingga sampai finishi-
ng. Serumit desain apapun 
tetap harus bisa dan mudah 
dibuat hingga jadi. 

c. Faktor Murah 

Faktor ini merupakan suatu 
penekanan pembiayaan yang 
mengarah keekonomis agar 
tidak boros. Adanya pene-
kanan pembiayaan ini akan 
mempengaruhi pula harga 
sebuah produk 3 D, sehingga 
bisa bersaing dengan produl 
lain. Ada beberapa penekanan 
biaya dalam proses pem-
buatan desain, antara lain: 

 Penggunaan bahan yang 
semurah mungkin 

 Desain sederhana dengan 
biaya murah 

 Murahnya biaya produksi 
 Meringankan harga produk 

5. Trategi Promosi Melalui 
Desain Kemasan 

Kemasan adalah pelindung 
dari suatu barang / produk 
biasa maupun hasil dari 
produksi industri. Dalam dunia 
industri, kemasan merupakan 
pemenuhan suatu kebutuhan 
akibat adanya hubungan anta-
ra penghasil barang dengan 

Gambar 11.15: Cantik, anggun,  
praktis dan mudah dibawa  

Gambar11.16: Adanya kemasan, 
jangan sampai produk lebih mahal, 
sehingga membebankan konsumen. 
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masyarakat pembeli. Dalam 
tuntutan keperluan ini, kemas-
an harus dapat menyandang 
beberapa fungsi yang harus 
dimiliki, seperti: 

 Tempat atau wadah dalam 
bentuk tertentu sebagai 
pelindung barang/produk 
agar tidak rusak sejak 
keluar dari pabrik sampai 
ke tangan pembeli, bahkan 
masih digunakan sebagai 
wadah bila isi barang habis 
pakai.

 Kemasan bukan sekedar 
pembungkus, tetapi juga 
sebagai pelengkap rumah 
tangga, seperti sebuah 
botol kecap yang mempu-
nyai nilai estetik tinggi 
tentunya akan menyema-
rakkan suasana tertentu di 
ruang dapur dan meja 
makan, kemasan kertas 
lap yang didesin menarik 
dapat menambah cantik-
nya ruang kamar mandi. 

 Mutu kemasan dapat me-
numbuhkan kepercayaan 
dan pelengkap citradiri dan 
mempengaruhi calon pem-
beli untuk menjatuhkan 
pilihan terhadap barang 
yang dikemasnya. 

 Kemasan mempunyai ke-
mudahan dalam pemakai-
annya (buka, tutup, pe-
gang, bawa) tanpa mengu-
rangi mutu ketahanannya 
dalam melindungi barang. 

 Secara visual, rupa luar 
kemasan harus menim-
bulkan kesan yang benar 

dan nyata tentang jenis isi 
barang yang dikemas. 

 Harus memperhatikan da-
lam hal benruk dan ukuran, 
sehingga efisien dan tidak 
sulit dalam hal pengepak-
an, pengiriman serta pe-
nempatan, demikian dalam 
penempatan dalam etalase 
pajangan di toko. 

 Kemasan harus memper-
hatikan dalam segi pema-
saran atau mempunyai 
nilai jual yang tinggi terhap 
barang/produk yang dipa-
sarkan. Keberhasilan su-
atu barang tidak hanya 
ditentukan oleh mutu 
barang serta usaha pro-
mosi yang dilakukkanm, 
tetapi juga dalam upaya 
yang sama oleh kualitas 
dan penampilan kemasan. 

Kehadiran toko-toko mewah 
merangsang hadirnya bentuk 
kemasan yang bagus mem-
punyai estetika yang tinggi. 
Pemajangan barang/produk di 
supermaket merupakan strate-
gi pemasaran bahwa setiap 
barang/produk harus melayani 
dan menjual dirinya sendiri, 
sehingga setiap produsen 
berusaha menciptakan desain 
kemasan yang sesuai.

Pemajangan barang / produk 
tersebut tentunya tidak sen-
dirian, tetapi beberapa barang/ 
produk lain atau sejenisnya. 
Inilah terjadi pertarungan pro-
duk melalui tampilan kemas-
an. Pertarungan ilmu meran-
cang kemasan adalah salah 
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satu strategi mengalahkan 
saingan barang/produk lain 
untuk merayu pilihan kon-
sumen.

a. Daya tarik 

Strategi promosi melalui daya 
tarik (perhatian) seseorang 
atau sebagian masyarakat 
terhadap desain kemasan 
produk sering dilakukan oleh 
berbagai perusahaan besar. 
Strategi ini yang diburu oleh 
beberapa perusahaan, karena 
berhadapan langsung pada 
konsumen calon pembeli. 
Kemenarikan sebuah desain 
kemasan bisa dikatakan ber-
hasil bila konsumen tersebut 
kesensem (sangat tertarik) 
pada desain kemasan seka-
ligus produknya, ingin men-
coba / melihat hingga pada 
akhirnya memilikinya (mem-
beli).

b. Sebuah Citra 

Citra harus dibangun sejak 
perusahaan itu mulai berdiri, 
berkembang, hingga akhirnya 
dapat dipercaya oleh masya-
rakat luas terhadap produk 
yang ditawarkan melalui 
desain kemasan. Tampilnya 
desain kemasan pada suatu 
produk akan meningkatnya 
kepercayaan masyarakat ter-
hadap produk.

Kemanapun orang pergi, bila 
mereka sudah terpengaruh 
pada suatu produk maka 
mereka selalu akan mencari 

produk yang disukai. Maka 
citra harus terbentuk dihati 
masyarakat, sehingga akan 
terwujud:

 Konsumen lebih percaya 
diri

 Bergaya modern 
 Adanya peningkatan 

prestise
 Bergaya masyarakat klas 

tinggi

6. Kualitas Desain 
Kemasan

a. Kekuatan dalam desain 
kemasan

Segi kekuatan dalam desain 
kemasan juga sangat diper-
hatikan, karena bila desain 
kemasan tidak kuat akan 
mengakibatkan benda/produk 
di dalamnya akan mengalami 
kerusakan yang akhirnya 
pembeli tidak puas.

Bila hal tersebut terjadi suara 
masyarakat (bakul sinambi 
woro) akan sangat mempe-
ngaruhi pembeli sampai calon 
pembeli tidak jadi membeli 
produk hanya gara-gara keku-
atan desain kemasan kualitas 
rendah.

Agar produk yang dikemas 
bisa bertahan dihati konsumen 
dan dapat mempengaruhi 
calon pembeli, maka harus 
memperhatikan kekuatan de-
sain kemasan. 
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Kualitas, sangatlah diperhati-
kan dalam sebuah desain, 
antara lain:  

 Kuat benturan (elastis) 
 Kuat terhadap   cuaca/ 

iklim
 Kuat dibawa 
 Kuat dipakai 

b. Segi Higienis 

Desain kemasan harus mem-
perhatikan segi higienis (kese-
hatan), baik terhadap produk 
atau orang yang membelinya. 
Bila segi higienis terjamin 
niscaya masyarakat akan me-
lekatkan hatinya pada produk 
yang telah/pernah dibelinya. 
Desain kemasan yang difung-
sikan ke arah makanan dan 
minuman biasa memperha-
tikan segi kesehatan dari 
pemilihan bahan, apakah ada 
reksinya terhadap produk 
didalmnya.

Desain kemasan yang dipakai 
untuk pembungkus atau pro-
duk mainan / sovenir harus 
memperhatikan segi kesehat-
an luar bila desain kemasan itu 
dipegang. Sebagai contoh, 
desain kemasan yang dibuat 
dari bahan daun jati atau daun 
bambu yang masih melekat 
bulu-bulunya sehingga dapat 
mengakibatkan gatal-gatal di 
tangan.

c. Segi Argonomis

Segi argonomis kadang ku-
rang diperhatikan oleh de-
sainer kemasan, padahal ini 

juga dapat mempengaruhi 
kenyamanan untuk dipegang. 
Kebiasaan orang akan Kenya-
manan inilah dibidik seorang 
desainer desain kemasan agar 
desainnya bisa berhasil guna. 
Desain enak disentuh, dipe-
gang waktu melihat maupun 
membuka produk didalamnya, 
tentunya konsumen akan me-
rasanya kenikmatan atau ti-
daknya desain kemasan yang 
mendampingi produk di dalam-
nya.

B. Media Lini Atas 
Above-The-Line (ATL), adalah 
media lini atas. Berkomunikasi 
menggunakan “sewa media” 
bersifat masal, seperti iklan 
koran, majalah, televisi, radio, 
internet dan lain-lain. Kalau 
kita pasang iklan di koran, 
teve, dan internet itu tujuan-
nya membangun imej, itu kita 
sebut full factor.

C. Media Lini Bawah 
Below-The-Line (BTL), meru-
pakan pelengkap yang men-
dukung dukung lini atas. 
Biasanya berupa dua kegiatan 
sales promotion dan merchan-
dising yang dipadukan dengan 
iklan ATL untuk menguatkan 
sebuah kampanye. Aktifitas 
BTL bisa beragam, mulai dari 
event, sponsorship, live tele-
cast, dan lain-lain.  

Tujuannya adalah mendekat-
kan produk pada konsumen, 
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membangun pengalaman khu-
sus, mengundang pembelian, 
menjaga loyalitas konsumen, 
bahkan bukan itu saja, bisa 
juga dijadikan ajang membina 
jaringan distribusi penjualan.  

BTL sifatnya highly segmen-
ted yang bisa membuat orang 
berpikir dan kemudian tertarik. 
Keefektifan BTL tergantung 
pada karakteristik produk. Ada 
produk yang bisa membuat 
orang langsung beli, contoh-
nya adalah barang murah 
seperti rokok. Berbeda dengan 
produk mobil, orang akan 
berpikir dulu walau sudah meli-
hat. Suatu produk itu tereks-
pos terlebih dahulu, istilahnya 
the economic of attention,
ekonomi perhatian. 

Biasanya berupa dua kegiatan 
sales promotion dan mer-
chantdising yang dipadukan 
dengan iklan ATL untuk me-
nguatkan sebuah kampanye. 
Aktifitas BTL bisa beragam, 
mulai dari event, sponsorship,
live telecast, dan media seperti 
di bawah:

Gambar 11.17: Seorang peragawati 
lenggak-lenggok di plasa 
mempromosikan produk tertentu 

Gambar 11.18 a,b,c (bawah):  
Pawai dan kegiatan olah raga
merupakan strategi  
yang tepat untuk produk minuman 
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NO BENTUK BTL KETERANGAN 

1 Billboard Papan iklan berukuran besar 
yang ditempatkan di ruang 
terbuka

2 Billboard multi sided Papan iklan yang berganti 
tampilan 

3 Billboard rotary Papan iklan yang dapat berputar 
4 Brosur Selebaran cetakan dalam 

promosi penjualan 
5 Building ad Iklan yang memanfaatkan 

dinding gedung 
6 Coaster Lembar promosi dalam bentuk 

tatakan/asbak 
7 Direct mailing Iklan pos langsung berisi 

brosur/katalog
8 Event acara Promosi dipusat perpelanjaan 

dan hiburan 
9 Flier Iklan selebaran yang yang berisi 

katalog produk 
10 Interleaf Lembar sisipan diantara barang 

cetakan
11 Leaflet Selebaran yang dilipat 
12 Lift panel Iklan display logo 

produk/perusahaan didinding 
lift/escalator panel-floor vision 

13 Menu Buklet/lembaran daftar menu 
14 Merchandise Promosi produk dengan 

mencantumkan logo 
15 Neon sign Display produk/perusahaan sari 

lampu neon 
16 Pameran Menggelar keunggulan produk 

dan jasa 
17 Poster Iklan display besar di kertas 

cetak
18 Road show Promosi yang diadakan di 

beberapa kota/yempat acara 
berturut-turut

19 Sales force Penetrasi khas penjualan melalui 
SPG-SPB dari pintu ke pintu Pall 
Mall

20 Sampling Penarikan percontoh konsumen 
21 Shop/Rak display/Trolly 

ad
Pajangan di rak/ keranjang 
belanja 

22 Spanduk, umbul-umbul Kain rentang slogan/logo produk 
perusahaan 

23 Tent card Media promosi melalui 
tenda/halte

24 Transit ad/ Side panel Iklan display di badan kendaraan 
umum

Jenis media Grafis Komunikasi 
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D. Pendalaman 
Sebelum merancang desain 
kemasan, sebaiknya saudara 
melihat berbagai kemasan di 
toko-toko, apotik, supermarket, 
hingga ke pasar tradisional. 

Setelah melihat dan mencer-
mati desain kemasan tersebut, 
saudara catat tentang, tujuan, 
fungsi, bahan, faktor ekonomi, 
dan teknik pembuatan dalam 
kemasan.

Setelah itu buatlah: 

1. Desain kemasan kosmetik 
untuk remaja puteri. 

2. Desain kemasan makanan 
tradisional untuk keluarga. 

3. Desain kemasan minuman 
tradisional untuk anak-
anak.

Gambar 11.19: 
Contoh desain kemasan minuman nata de coco 
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Gambar 12.1:  
Media grafis (iklan) yang ditekankan 
pada harga 

Tugas media grafis komu-
nikasi pada suatu produk 
adalah mengusahakan ada-
nya calon langganan baru 
untuk perusahaan dan usaha-
usaha tertentu, sebagai mem-
pertahankan konsumennya 
agar tidak lari ke produk/jasa 
lain, atau sebagai prestise 
semata. Suatu perusahaan 
selalu berusaha untuk membe-
rikan jasa-jasanya atau ba-
rang-barang hasil produksinya 
kepada langganannya secara 
efisien, ekonomis, dan me-
nguntungkan berupa imbalan 
dari apa yang diharapkan 
maupun yang dibutuhkan oleh 
pelanggan.

Dalam memperkenalkan pro-
duk/jasa maupun perusahaan-
nya kepada calon pelanggan 
melalui media grafis komu-
nikasi dapat dikelompokkan 
menjadi dua bagian yaitu;

1) Jenis media grafis komuni-
kasi yang menekankan 
pada produk yang dita-
warkan.

2) Jenis media grafis komuni-
kasi yang menekankan 
pada sisi visualnya. 

3). Jenis media grafis komuni-
kasi yang menekankan 
pada teknik penyampaian. 

A. Penekanan pada Produk 
yang Disampaikan 

 Penekanan pada Harga 

Media grafis komunikasi yang 
menawarkan barang atau jasa 
dengan penonjolan harga 
produk yang menarik. Jenis 
media grafis komunikasi ini 
biasa menggunakan bahasa 
kata yang mempunyai kono-
tasi yang jauh dari arti 
sesungguhnya, seperti sale, 
obral, pesta diskon, cuci 
gudang, banting harga, harga 
miring, produk baru harga 
lama, harga tetap dan se-
bagainya.

XII. PENEKANAN PENYAMPAIAN DESAIN
GRAFIS KOMUNIKASI 
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Gambar 12.2:  
Media grafis (iklan) yang ditekankan merek 

Penonjolan harga ini dimak-
sudkan untuk mendongkrak 
penjualan maupun menja-
tuhkan saingan pasar. Tere-
krutnya langganan baru atau 
mempertahankan langganan 
lama berarti meningkatkan 
omset penjualan. Biasanya 
jenis media grafis komunikasi 
ini diluncurkan bilamana 
jumlah produknya menurun 
yang diakibatkan adanya sa-
ingan baru, atau penyegaran 
terhadap pelanggan/pembeli 
sebagai hadiah. 

 Penekanan pada Merek 

Media grafis komunikasi yang 
berusaha memebrikan kesan 
tentang brand atau merk 
kepada pembaca, penglihat 
atau pendangar. Jenis media 
grafis komunikasi ini tampak 
pada jenis produk merk SONY, 
HONDA, LEVI’S, VIT, dan 
sebagainya.

Masyarakat yang sudah fa-
natik terhadap tentunya akan 
memilih jenis produk yang 
biasa dipergunakan atau 
dianggap cocok untuknya. 
Begitu juga produsen yang 
sudah lama dipercayai ma-
syarakat karena jenis merk 
produknya sudah dapat mere-
but hati masyarakat.

Bilamana masyarakat sudah 
fanatik atau percaya terhadap 
produk atau merk tertentu 
yang selalu diikuti lama, maka 
bilamana ada jenis produk lain 

namun masih dalam lingkup 
merek yang sama tetap akan 
percaya. Ada ucapan yang 
sering terdengarn di 
masyarakat. “Kalau beli produk 
belilah merk SONY, karena 
awet dan bandel”, atau 
”Frestea yang rasanya segar 
teh hijau alami”.

 Penekanan pada Kualitas 

Media grafis komunikasi yang 
berusaha untuk menimbulkan 
kesan bahwa barang atau jasa 
yang dimedia grafis komu-
nikasikan bermutu tinggi, se-
perti perguruan tinggi swasta 
yang mengekspos status akre-
ditas “disamakan” pada pro-
gram-program tertentu, produk 
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Gambar 12.3:  
Meskipun harganya murah,  

tapi kualitasnya luarbiasa 

Gambar 12.4:  
Pendekatan emosional pada merek 

jeans yang kuat 

otomotif suzuki “inovasi tiada 
henti”, produk komputer pla-
tinum dengan mengandalkan 
teknologinya, ballpen “Bic” 
yang mengandalkan kelan-
caran dalam menulis, tought 
jeans, dan sebagainya. 

 Penekanan pada Manfaat 

Media grafis komunikasi yang 
menarik konsumen dengan 
cara mengemukakan faedah 
pemakaian suatu produk atau 
jasa tertentu. Media grafis 
komunikasi jenis ini sering 
ditayangkan di media televisi 
tentang produk-produk rumah-
tangga yang ramah ling-
kungan, seperti alat pember-
sih air, penghisap debu, 
produk peralatan rumah-tang-
ga dengan teknik bongkar-
pasang, atau jenis produk baru 
yang mempunyai kelebihan 
dari pada produk sebelumnya. 

Bagaimana memancing calon 
pembeli agar terbujuk untuk 
membeli produk yang iinfor-
masikan, walaupun sebelum-
nya mereka sudah membeli 
jenis merk yang sama. Strategi 
yang dipakai adalah mengin-
formasikan kualitas, kelebihan, 
fasilitas, keung-gulan yang 
ada pada produk yang baru 
dikeluarkan. Sebagai contoh 
media grafis komunikasi mobil 
yang tiap tahun berganti 
sejalan dengan jenis produk 
yang dikeluarkan.  

Agar masyarakat tidak me-
nganggap bahwa produk baru 
dikeluarkan ini tidak sama 
dengan produk terdahulu, ma-
ka di sini perlu penjelasan ten-
tang kelebihan terhadap pro-
duk terbaru, sehingga masya-
rakat bisa membadingkannya. 
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Gambar 12.5:  
Media grafis (iklan) yang ditekankan 

dari segi manfaat 

Gambar 12.6:  
Media grafis (iklan) yang ditekankan 
dari segi status 

 Penekanan pada Status 

Media grafis komunikasi yang 
melakukan komunikasi agar 
masyarakat mengasosiasikan 
produk yang ditawarkan de-
ngan status atau kedudukan 
pribadinya. Produk yang dita-
warkan melalui media grafis 
komunikasi ini biasanya 
berharga mahal atau jarang 
dipakai oleh oarng banyak. 
Media grafis komunikasi yang 
dimaksud sebagai contoh 
media grafis komunikasi mobil 
BMW, Mercy, Kondominium, 
hotel berbintang, mebel gaya 
itali, dan sebagainya. 

Ada sekelompok masyarakat 
yang mempunayi gaya hidup 
yang lain dari masyarakat 
umumnya, mereka menikmati 
hidupnya dengan kebanggaan 

tersendiri terhadap yang di-
punyai, karena jarang orang 
memilikinya. Kelompok inilah 
yang ditangkap oleh produsen 
untuk meluncurkan produknya 
agar mereka terbawa hatinya 
yang akhirnya memilikinya, 
meskipun produk yang dike-
luarkan sangat tinggi har-
ganya.

 Penekanan pada Lembaga 

Media grafis komunikasi yang 
menekankan atau meno-
njolkan nama perusahaan 
untuk memberi kesan yang 
baik kepada calon pembeli 
produk/jasa yang dikeluarkan. 
Jenis media grafis komunikasi 
ini sering menawarkan jasa 
yang dikomunikasikan oleh 
perusahaan, hanya saja lebih 
ditonjolkan pada perusahaan 
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Gambar 12.7:  
Media grafis (iklan)

yang mempromosikan lembaga 

Gambar 12.8:  
Sebuah stasiun televisi mengiklankan 

tentang dirinya 

Gambar 12.9:  
Kesan lembut dan lucu tampil  
dalam media grafis komunikasi 

yang mengeluarkannya. Me-
dia grafis komunikasi yang 
dimaksud antara lain media 
grafis komunikasi jasa trans-
portasi Garuda, jasa pengi-
riman LTH, televisi, jasa 
telekomunikasi Telkom, dan 
sebagainya.

B. Penekanan pada Sisi 
Visualnya 

Bila ditinjau dari segi visual, 
maka media grafis komunikasi 
dapat dikelompokka menjadi 
beberapa hal, yaitu: 

 Faktor kelembutan dan 
kelucuan

Dimana orang akan tertarik 
dengan sebuah pesan yang 
disampaikan oleh sebuah 
media grafis komunikasi yang 
disebabkan oleh penampilan 
wajah media grafis komunikasi 
yang artistik, baik keindah-
annya maupun kelucuannya. 
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Gambar 12.10:  
Kelucuan sebuah obyek akan 

menanamkan catatan di benak 
konsumen

Gambar 12.11:  
Faktor kejelekan sebagai strategi 
komunikasi

Dalam media grafis komu-
nikasi sering kita lihat suatu 
produk sabun atau bedak 
mandi anak-anak yang meng-
gambarkan suatu kesejukan, 
kelembutan dan kesehatan 
sesuai dengan pesan atau 
peragaan yang disampaikan. 
Atau produk kursi untuk anak-
anak yang kuat, nyenyak, dan 
argonomis, begitu juga tam-
pilan hewan dicukur rambut-
nya yang memberikan 
kesegaran dan kelucuan bagi 
yang melihatnya. 

 Faktor Kejelekan 

Dalam penampilan wajah atau 
pesan media grafis komu-
nikasi dalam faktor kejelekan 
akan menarik perhatian. Orang 
tidak akan senang melihat 

media grafis komunikasi 
tersebut atau tidak tertarik 
sama sekali, akan tetapi 
mereka akan teringat atau 
tahu terhadap pesan yang 
disampaikan.  

Media grafis komunikasi di-
anggap kampungan, karena 
penampilan obyeknya seperti 
seorang anak baru memeras 
susu sapi di waktu pagi-pagi, 
seperti sebuah media grafis 
komunikasi susu. Biasanya 
orang tidak sebang terhadap 
media grafis komunikasi ter-
sebut apalagi tampilan sapi 
yang diperas kurus kering, 
akan tetapi mereka terikat 
terhadap pesan yang disam-
paikan lewat tokoh/ model 
media grafis komu-nikasi.
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Gambar 12.13:  
Orang kadang bosan dengan kegiatan 
yang sama. Ini juga menjadi strategi 
komunikasi

Gambar 12.12:  
Perusahaan yang memancing  

konsumen melalui kesan menjatuhkan 
produknya sendiri 

Ada sekelompok masyarakat 
yang mengatakan bahwa 
coca-cola rasanya seperti ”air 
kencing”, maka tidak heran 
bila iklan di bawan digam-
barkan ada makluk (wujud 
jeruk) mengencingi  coca-cola.  

 Faktor Kebosanan 

Dimana-mana kita melihat 
media grafis komunikasi “Blue 
Band”, baik di jalan, di bus 
atau ditempat-tempat strategis 
di pinggir jalan. Bila kita pergi 
ke luar kota selalu melihat 
media grafis komunikasi yang 
dipasang tersebut sehingga 
mengakibatkan kebosanan. 
Pemasangan yang berlebihan 
baik jumlah maupun waktu 

pemasangan, pada suatu saat 
media grafis komunikasi ter-
sebut dihilangkan/diganti, akan 
tetapi orang akan teringat 
terus pada produk dari sebuah 
media grafis komunikasi yang 
disampaikan sebelumnya. 

Seseorang ketika masih anak-
anak teringat akan media 
grafis komunikasi Palmboom 
Margarine, tetapi dalam batas 
waktu tertentu produk itu 
hilang di pasaran, kemudian 
setelah dewasa produk tiu 
muncul lagi. Hal ini mengi-
ngatkan masa-masa kecil dulu 
yang pernah membeli produk 
tersebut, sehingga akhirnya 
ingin kembali mencoba produk 
tersebut.
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Gambar 12.14:  
Orang kadang kepingin seperti tokoh 
yang dipujanya

Kita sering memepringati hari 
ulang tahun kemerdekaan 
Indonesia yang setiap tahun 
diperingati. Dimana kita men-
jelang tanggal 17 Agustus 
tentu akan mendapatkan me-
riahnya sambutan terhadap 
bangsa ini. Media grafis ko-
munikasi musiman juga tampil 
yang bertema sesuai dengan 
pesta kemerdekaan. Sering 
adanya kegaitan yang bertema 
kemerdekaan, kadang kita 
bosan apa yang ditampil-
kannya, namun hal kebosanan 
ini tampaknya malah mudah 
diingatkan terhadap jiwa 
nasionalis, sepeti pada media 
grafis komunikasi di bawah. 

 Faktor Tokoh 

Tokoh atau idola ditampilkan 
dalam media grafis komuni-
kasi merupakan cara yang 
ampuh dalam membidik pasar 
bagi masyarakat yang tergila-
gila (fanatik) terhadap tokoh 
idolanya. Adanya tampilan to-
koh idola sebagai model 
dalam mempromosikan pro-
duk/jasa jelas berbeda dengan 
produk/jasa yang dipromo-
sikan menggunakan model 
lain. Masyarakat seakan ter-
bius dan sangat percaya bila 
tokoh idolanya menggunakan 
produk/jasa yang dikomuni-
kasikan.  

Tokoh atau idola Okky 
orangnya cantik, tinggi, dan 
ramping, dan profesinya seba-
gai peragawati. Tentunya 
masyarakat banyak yang kenal 
tokoh yang satu ini yang sring 
muncul di masmedia. Tidak 
salah bila perusahaan mem-
bidik dia untuk digunakan 
sebagai model produk 
”Slimming Tea” Mustika Ratu 
yang diperuntukkan bagi kaum 
Hawa yang kepingin tubuhnya 
menjadi ramping dan me-
nawan.
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Gambar 12.15:  
Warna merah merupakan warna  

yang mudah ditangkap audien 

 Faktor Kontras 

Kekontrasan pada media 
grafis komunikasi sangat 
membantu dalam pengingatan 
sebuah produk. Misalnya 
penampilan warna yang 
sangat simpel atau ciri khas 
dari produk (logo atau trade 
mark).

Media grafis komunikasi yang 
memapilkan warna konras 
antara warna merah, kuning, 
dan ungu yang mengingatkan 
pada sebuah media grafis 
komunikasi Vitamin C yaitu 
Sakatonik Sirup untuk anak-
anak. Warna yang ditampilakn 
merupakan jenis rasa seperti 
stawberi, jeruk, dan anggur. 
Media grafis komunikasi yang 
disampiakna lewat model 
penyanyi anak terkenal itu 

menggunakan atribut yang 
disamalakn dengan trade mark 
yang ada dalam kemas-an 
sirup yang ditawarkan. Bila 
anak-anak melihat produk 
tersebut tentu anak akan tahu 
rasa apa yang ada di dalam 
botol tersebut. 

Bank BII yang mempunayi 
warna merah dengan sedikit 
dukungan warna biri tampak 
akan kekontrasannya. Kekon-
trasan yang ditampilkan ini 
tampaknya disengaja agar 
orang mudah mengingatnya 
yang akhirnya lari ke produk. 

C. Penekanan pada Teknik 
Penyampaian 

 Iklan Suara (Teriakan 
Slogan)

Media grafis komunikasi ini 
sebagai pengingat terhadap 
apa yang ditawarkan pada 
media grafis komunikasi lewat 
slogan atau jangle, meskipun 
visual media grafis komuni-
kasinya berganti-gantu (baru). 
Karena seringnya salah satu 
media grafis komunikasi dita-
yangkan di televisi dengan 
sendirinya orang akan terbe-
kas dan teringat pada media 
grafis komunikasi tersebut 
walaupun kita kita melihat ke 
depan televisi. Sering akrab-
nya telinga kita terhadap 
slogan atau jengle pada jenis 
media grafis komunikasi yang 
menawarkan produk tertentu, 
akan mumudahkan tangkapan 
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Gambar 12.16:  
Setiap menjelang awal sekolah,   
selalu muncul iklan musiman 

pikiran kita pada produk yang 
sama. Jenin media grafis 
komunikasi ini antara lain me-
dia grafis komunikasi “indomi” 
dengan jenglenya yang khas, 
atau media grafis komunikasi 
“suchlin” yang mempunyai 
slogan “coba tebak, ibu siapa 
yang menggunakan suchlin”. 

 Iklan Musiman 

Media grafis komunikasi mu-
siman untuk kesempatan 
tertentu yang ditujukan pada 
konsumen pada waktu-waktu 
tertentu sesuai dengan ka-
lender waktu atau musim. 
Jenis media grafis komunikasi 
ini sering dimunculkan pada 
musim menjelang ajaran baru 
tiap tahun, yaitu seperti me-
nawarkan peralatan sekolah, 
sepatu, seragam sekolah atau 
sejenisnya.

Menjelang hari Raya, banyak-
nya media grafis komunikasi 
menawarkan produk yang 
berhubungan dengan acara 
tersebut, seperti produk sa-
rung dan sajadah, atau 
kemasan dalam media grafis 
komunikasi yang menampil-
kan kemeriahan suatu pesta 
besar umat agama Islam yaitu 
seperti makanan siap saji 
menjelang berbuka puasa, 
serta kemenangan setelah 
berpuasa sebulan penuh 
dengan pesta kemeriahan 
minum bersama, seperti pada 
media grafis komunikasi 
“Coca-Cola”.

Berbeda pula, bila media grafis 
komunikasi ini mena-warkan 
produknys dimasa hari Natal 
dengan cara menge-masnya 
seperti layaknya kejadian 
sungguhan di hari Natal, atau 
banyaknya media grafis komu-
nikasi perguruan tinggi swasta 
yang menawarkan jasa pendi-
dikannya dimasa kelulusan 
SLTA atau musim masyarakat 
akan melanjutkan pendidikan 
ke perguruan tinggi. 

 Iklan bersama 

Media grafis komunikasi ko-
lektif yaitu semua media grafis 
komunikasi anonim atau bu-
kan dilakukan oleh berbagai 
perusahaan saingan maupun 
bukan untuk bersama-sama 
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Gambar 12.17:  
Iklan bersama selalu muncul

dalam kegiatan tingkat Internasional 

Gambar 12.18:  
Membidik masyarakat yang suka membaca 

dalam perencanaan dan biaya. 
Hal ini sering dilakukan pada 
media grafis komunikasi la-
yanan masyarakat (ILM) yang 
dibiayai bersama untuk penya-
daran terhadap hal kesosialan 
yang perlu diinfor-masikan, 
seperti narkoba, AIDS, ko-
rupsi, kampanye pemilu yang 
demokratis atau konser musik 
kemanusiaan.

 Iklan Pariwara 

Ciri dari jenis media ini adalah 
terletak pada berita yang 
disampaikan, karena media ini 
diprakarsai oleh Copywriter,
yaitu orang yang tahu dan 
memahami tentang bahasa.  

Media yang ditampilkan de-
ngan gaya bahasa komunikasi 
yang dikemas berita membidik 
bagi masyarakat yang suka 
membaca. Bila masyarakat 
umum kurang memperhatikan 
terhadap jenis media grafis 
komunikasi ini, tentunya me-
nganggapnya sebagai suatu 
berita baru.  

Setelah masyarakat membaca 
dengan teliti hingga tuntas, 
maka baru mengetahui kalau 
berita yang baru dibaca ter-
nyata media grafis komunikasi 
salah satu produk tertentu. Hal 
ini tidak bisa disalahkan ka-
rena lay-outnya  media grafis 
komunikasi tersebut dibuat 
menyerupai berita. Kesenga-
jaan ini dibuat karena ada 
segmen yang suka membaca 
berita-berita baru, maka mun-
cullah media grafis komunikasi 
yang dikemas berita. 
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Gambar 12.19 a, b:  
Iklan lanjutan pada sebuah masmedia 

Advertorial Advertising meru-
pakan garapan penuh di pihak 
pembuat media grafis komuni-
kasi, maksudnya bahwa berita 
tersebut merupakan olahan-
nya, baik isi maupun cara 
penyampaiannya. Produsen 
dalam hal ini hanya bercerita 
tentang apa saja tentang 
perusahaan, produk, maupun 
segmennya, namun yang me-
ngemas akhir adalah pihak 
pengmedia grafis komunikasi. 

 Iklan Lanjutan 

Media grafis komunikasi yang 
dikomunikasikan dengan tek-
nik lanjutan ini bertujuan 
menggoda perhatian sesaat 
kepada audience. Audience
sementara dibuat agak kurang 
faham terhadap yang diko-
munikasikan, karena produk-
nya belum ditampilkan dalam 
media tersebut. Dengan cara 
ini audien (masyarakat) akan 
merasa penasaran terhadap 
apa yang disampaikan. Ada-
nya penasaran ini tentunya 
audien akan bertanya dalam 
hati ada apa ini, maksudnya 
apa, dan nada bertanya 
lainnya. Bila jenis media ini 
dipublikasikan pada surat 
kabar, pertanyaan ini akan 
terjawab bila pembaca 
membuka pada halaman lain 
(berikutnya). Bila di Televisi 
biasanya diselipi oleh iklan 
yang lain, dan baru terjawab 
pada sesi berikutnya. Disinilah 
strategi pemasaran produk/ 

jasa dengan gaya membidik 
pasar bagi yang orang berjiwa 
petualangan atau tantangan 
sebuah permasalahan. 
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Gambar 12.20:  
Iklan lanjutan bisa memanfaatkan 

moment tertentu 

Gambar 12.21:  
Telah lahir sebuah jeans 

Media cetak yang mengko-
munikasikan sebuah majalah 
perempuan yang diterbitkan 
pada bulan April bertepatan 
menjelang hari Kartini. Pada 
tahap awal orang akan banyak 
bertanya dan mempunyai 
pandangan konotasi tentang 
yang media yang disampaikan 
terhadap ilustrasi mata terpe-
jam dan bertuliskan ”habis 
gelap” pada latar warna hitam. 
Ausien mengira bahwa produk 
yang ditampilan mungkin obat 
tetes mata, atau peringatan 
hari Kartini, atau yang lain. 
Setelah audien membuka pa-
da halaman berikutnya baru 
terjawab, bahwa yang dikomu-
nikasikan adalah majalah 
Kartini.

 Iklan Berseri 

Media grafis komunikasi ini 
dibuat dengan pendekatan 
suatu cerita bersambung atau 
berseri. Orang kadang tertarik 

pada suatu cerita, hal inilah 
yang dibidik desainer untuk 
penyampaian pesan. Penyam-
paian produk/jasa melalui 
bidikan cerita terhadap ma-
syarakat harus benar-benar 
kena di hati masyarakat, 
khususnya alur cerita yang 
disampaikan. Bila cerita perta-
ma tidak berhasil akan mem-
pengaruhi pesan cerita beri-
kutnya. Penyampaian media 
ini biasanya berurutan, yaitu 
media grafis komunikasi per-
tama, setelah beberapa kali 
ditampilkan baru media beri-
kutnya, seperti: 

Media 1,
ditampilkan ilustrasi jean yang 
mempunyai tali panjang yang 
dipotomng. Tampilan ini men-
ceritakan telah lahir jean 
(seperti bayi) bernama 
”Denim”.
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Gambar 12.22:  
Perlu ketelitian untuk menghasilkan 

produk berkualitas baik 

Gambar 12.23:  
Berbagai model telah diproduksi  
di perusahaan ini

Media 2,

ditampilkan seorang dokter 
memeriksa jean seperti me-
meriksa seorang bayi. Mak-
sudnya, bahwa jean ”Denim” 
sebelum dikeluarkan ke 
masyarakat perlu diperiksa 
dulu, sebagai tanda ”Danim” 
berkualitas.

Media 3,

Produk ”Danim” ditampilkan 
seperti banyaknya bayi yang di 
rawat di kamar bayi, menan-
dakan banyak jenis pro-
duk/model jean keluaran oleh 
”Danim”

 Iklan Kagetan 

Media grafis komunikasi ini 
tidak menyimpang dari asas-
asas dari kampanye sebe-
narnya, tetapi seringkali digu-
nakan “meriem kaliber lebih 
besar”. Yang mencerminkan 
diri dalam bentuk format dan 
kadang-kadang dalam agre-
sivitas pertanyaan yang me-
ngantarkan. Media grafis 
komunikasi ini merupakan 
pancingan yang berkelan-
jutan/beberapa kali agar ma-
syarakat “bertanya-tanya” apa 
maksud dari media grafis 
komunikasi tersebut. 

Salah satu contoh di salah 
satu halaman surat kabar 
terdapat kolom diblok hitam 
disertai tulisan di bawah 
berbunyi “kita masih dalam 
kegelapan”. Keesuk harinya 
muncul lagi sedikit adanya 
perubahan, yaitu setengah 
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Gambar 12.24:  
Seorang bapak terheran-heran  

Gambar 12.25:  
Seorang ibu terkesima  

kolom diblok dengan warna 
hitam dengan dipadu tulisan di 
bawahnya berbunyi “ada me-
nuju penerangan”. Hari ketiga 
muncul media grafis komu-
nikasi lanjutan media grafis 
komunikasi tersebut di posisi 
yang sama dengan munculnya 
tulisan ukuran besar yang 
mengarahkan suatu produk 
berbunyu “terus terang PHILIP 
terang terus”. 

Secara visual, jenis media 
grafis komunikasi ini kadang 
menonjolkan tipografinya (ba-
hasa verbal) atau ilustrasinya 
(bahasa visual). Kesemuanya 
diterapkan tergantung daya 
tariknya yang dianggap jitu 
untuk menggaet mangsa. Bila 
ditampilkan ilustrasi, strategi 
yang dipakai antara lain, 
seperti produk ”hemaviton”. 

a. Ilustrasi pertama, meng-
gambarkan konotasi yang 
jauh dari apa yang akan 
diinformasikan, baik pro-
duk tertentu, daya tarik 
tertentu yang mengajak 
mata menuju sesuatu yang 
menggugah pera-saan 
atau pikiran yang aneh. 

b. Ilustrasi kedua, audien 
dikacaukan lagi karena 
tenggapan terhadap me-
dia grafis komunikasi 
pertama meleset, dan 
mencoba untuk menafsir 
produk / jasa apa yang 
dikomunikasikan.

c. Ilustrasi ke tiga meru-
pakan bomnya sebuah 
strategi, kalayak diajak 

memahami terhadap apa 
yang diinformasikan se-
sungguhnya, yang diang-
gapnya sebagai klimak. 
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Gambar 12.26:  
Louncingsebuah produk baru  

D. Pendalaman 
Buatlah kliping iklan produk 
yang mengarah pada: 
1. Penekanan pada produk, 

antara lain: 
o Merek 
o Kualitas 
o Manfaat 
o Status 
o Lembaga 

2. Penekanan pada sisi visual 
o Kelembutan 
o Kelucuan 
o Kejelekan 
o Kebosanan 
o Tokoh 
o Kontras 

3. Penekanan pada teknik 
penyampaian. 
o Suara 
o Musiman 
o Bersama 

o Pariwara 
o Lanjutan 
o Berseri 
o Kagetan 

Masing-masing minimal satu 
buah lembar iklan. Tiap  kliping 
iklan tersebut di tempelkan di 
atas kertas A4 yang rapi serta 
dijilid. 
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Kita pernah melihat patung 
“pemikir” karya seniman Au-
guste Robin. Patung tersebut 
merupakan lambang kemanu-
siaan kita sebagai makhluk 
yang berpikir sejak lahir hingga 
meninggal dunia. Berpikir me-
rupakan hakekat manusia 
untuk menghasilkan pengeta-
huan atau pemecahan masa-
lah. Pengetahuan merupakan 
produk kegiatan berpikir 
sebagai fondamen peradaban 
manusia untuk menentukan 
dirinya dan menghayati hidup 
yang sempurna. Manusia da-
lam berpikir untuk memperoleh 
pengetahuan didasarkan oleh 
tiga masalah, yaitu:  

1)  Apa yang ingin diketahui? 

2) Bagaimana caranya untuk 
memperoleh pengetahu-
an? 

3) Apa manfat pengetahuan 
tersebut bagi manusia? 

Manusia yang mendewa-
dewakan ilmu sebagai satu-
satunya sumber kebenaran 
biasanya tidak mengetahui 
ilmu itu yang sebenarnya, 
karena masih ada sumber lain 
yang benar seperti agama dan 
filsafat. Sebaliknya orang yang 
memalingkan muka dari ilmu, 
berarti tidak mau melihat 
kenyataan betapa ilmu telah 
membentuk peradapan atau 
kebudayan sekarang ini.  

 

Oleh karena itu diantara ilmu 
satu dengan ilmu yang lain 
adalah saling mengisi dan 
membutuhkan, seperti ucapan 
Einstein bahwa ilmu tanpa 
agama adalah buta, agama 
tanpa ilmu adalah lumpuh. 

Ilmu selalu berkembang. Per-
kembangan ini tidak dapat 
lepas dari dua pokok yang 
saling menjalin, yaitu dorong-
an ingin tahu (dimiliki oleh 
manusia normal), dan keguna-
an praktis dari pengetahuan 
yang diperoleh dari pere-
nungan penelitian. Rasa ingin 
tahu menyebabkan manusia 
selalu ingin tahu tentang 
rahasia alam, kekuatan-ke-
kuatan yang berada dibalik 
gejala-gejala alam yang dapat 
memperbaiki hidup manusia di 
masa mendatang. Dorongan 
ingin tahu pada diri manusia 
merupakan gambaran suatu 
gejala atau ide (gagasan) yang 
perlu diketahui. 

A. Terobosan Desainer 
dalam Berkreatifitas 

Kreativitas merupakan pene-
kanan suatu proses yang 
berbeda atau menghasilkan 
sesuatu yang baru dan mena-
rik dari hasil gagasan sebe-
lumnya. Kebanyakan orang 
menganggap, bahwa kreati-
vitas dapat dinilai melalui 
gagasan oleh seseorang atau 

XIII. KREATIFITAS DALAM MERANCANG DESAIN 
GRAFIS KOMUNIKASI 
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Gambar 13.1:  
Evolusi Gagasan (Ide) 

kelompok. Kreativitas berarti 
sebagai proses yang berlang-
sung untuk menghasilkan 
gagasan yang baru. 

Orang yang kreatif tentu 
memiliki ide orisional dengan 
menggunakan suatu cara baru 
yang berbeda dari cara orang 
lain, yaitu memandang sesu-
atu dari sudut pandang yang 
unik. Kreativitas muncul ada-
nya proses kerja yang berkali-
kali melalui penemuan ide 
yang dihasilkan. Beaty menga-
takan bahwa, untuk mencapai 
hasil yang baik melalui krea-
tivitas kadang penulis dalam 
berkarya mengikuti aturan 
sendiri guna menghasilkan se-
suatu yang baru. 

Kreativitas merupakan ga-
bungan semua gagasan yang 
dapat dilihat dari proses dan 
hasil gagasannya untuk meng-
hasilkan bentuk baru melalui 
pemikiran dan perenungan 
terus-menerus (evolusi). 

 

 

 

 

 

 

 

 

 

 

1. Terobosan Seseorang 
untuk Berkreativitas 

Manusia mampu melakukan 
tugas mulia memalui gagasan 
yang inovatif dan hangat 
(penemuan dan pembaharu-
an) yang dihasilkan. Terobos-
an-terobosan melalui gagasan 
tersebut merupakan reaksi dari 
gejala masyarakat yang terus 
berkembang. Manusia bagian 
dari masyarakat yang mempu-
nyai nyali baik pikiran maupun 
rasa untuk berbuat demi 
menyenangkan batinnya. Ke-
mampuan berpikir (rasio) dan 
rasa (felling) ditambah kemam-
puan kreatif melalui pendi-
dikan yang terus menerus 
akan dapat mencerna gejala 
yang terus berkembang di 
masyarakat. 

Proses kreatif menurut Bea-
kley pada hakekatnya sama di 
semua ilmu pengetahuan. 
Setiap perilaku merupakan 
respon individu terhadap suatu 
masalah yang ada, apakah 
timbul dari luar maupun dari 
dalam diri sendiri. Semuanya 
didasarkan atas kemauan diri 
untuk mengaktualisasikan me-
lalui proses pemikiran se-
hingga tercipta gagasan yang 
diharapkan. 

Ide-ide baru yang dimiliki 
seseorang umumnya memiliki 
pengalaman yang sama dalam 
proses kreatif yang mereka 
alami. Munculnya ide melalui 
inspirasi bukanlah para penulis 
itu sadar atas inspirasi itu, 
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melainkan berpikir dengan 
cara melupakan keadaan 
sekelilingnya guna bekerja 
dengan serius yang tidak 
henti-hentinya pada saat ins-
pirasi itu muncul. Helmhotz, 
merupakan tokoh pertama 
yang mencoba menganalisa 
proses kreatif dari segi 
tahapan proses, yaitu: 

 Tahap persiapan 

Tahapan ini merupakan pro-
ses pendekatan, penelaahan 
dengan pemikrian berbagai 
arah, artinya melihat suatu 
masalah yang belum jelas 
agar lebih jelas dengan cara 
pengumpulan informasi dan 
data-data yang diperlukan. 

 Tahap inkubasi 

Tahapan ini merupakan pro-
ses pengendapan di dalam 
otak, yaitu pada saat individu 
tidak memikirkan masalah 
yang telah dikumpulkan yang 
seolah-olah dilupakannya. 

 Tahap illuminasi 

Tahapan ini merupakan pro-
ses munculnya gagasan, ide 
dan penemuan baru yang 
ditimbulkan oleh “insight” atau 
timbulnya “titik terang” 
gagasan baru serta proses 
psikologis. 

 

2.  Verifikasi 
Tahapan ini merupakan pem-
bentukan sikap memilih atau 

mengevaluasi terhadap ga-
gasan yang timbul, yaitu 
memilih yang terbaik dari 
berbagai ide atau gagasan. 

Manusia dalam memecahkan 
persoalan tentunya berbeda-
beda tergantung bagaimana 
cara pemecahannya. Hal ini 
tergantung dari latar belakang 
mereka, apakah dari pendidik-
annya, pengetahuannya mau-
pun pengalamannya. Secara 
teoritis, pendidikan formal dan 
non formal sangat menen-
tukan dasar kreativitas seseo-
rang dalam menangani suatu 
masalah.  

Menyinggung tentang hal ini, 
siswa teknologi grafis komu-
nikasi sebagai calon praktisi 
yang mengenyam pendidikan 
formal yang mendapat bebe-
rapa mata pelajaran merupa-
kan sebagai dasar utama 
inspirasi dalam berkreasi. Apa 
yang menim-bulkan inspirasi 
dalam diri manusia untuk 
berkreasi? Beakley menjelas-
kan bahwa timbulnya inspirasi 
disebabkan oleh : 

 Minat terhadap sesuatu 
masalah dan hasrat untuk 
mengatasi masalah ter-
sebut. 

 Tidak ada masalah besar 
yang menghambat. 

 Menguasai informasi yang 
relevan terhadap masalah. 

 Informasi dapat dicerna dan 
diolah secara siste-matik. 

 Jiwa merasa tenang dan 
senang. 
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 Merasa bebas dari te-
kanan. 

 Tidak ada rintangan terha-
dap fungsi pemikiran, se-
perti cemas.  

 Menggunakan rangsangan 
yang membantu penyele-
saiannya, seperti memba-
ca, diskusi, ceramah dan 
sebagainya. 

 Mengusahakan kesempat-
an yang tenang agar timbul 
inspirasi. 

Dari uraian di atas maka 
kreativitas dapat dipengaruhi 
oleh pendidikan dan tekanan 
terhadap individu manusia, 
makin besar tekanan yang 
dideritanya, makin besar pula 
pengaruhnya terhadap krea-
tivitas. 

B. Kreatifitas Perancangan 
dan Hambatannya 

Desainer sebagai pencipta 
karya-karya yang indah diha-
rapkan dapat memuaskan 
dirinya sendiri maupun orang 
lain (sebagai penikmat/peng-
hayat) dalam segi fungsi atau 
kegunaan karya penciptanya. 
Pada karya-karya grafis 
komunikasi, kualitasnya tidak 
semurni pada karya seni rupa 
murni, hal ini disebabkan 
karena dalam grafis komuni-
kasi ada tuntutan faktor lain di 
luar faktor estetik, seperti 
faktor komunikasi, faktor 
informasi, faktor fungsi, faktor 
ekonomi, faktor target, dan 
sebagainya. Karena itulah 
kualitas estetik terjepit dian-

tara ketidak puasan desainer 
dan kebebasan desainer guna 
pencapaian tujuan tertentu, 
seperti grafis komunikasi yang 
berkualitas sesaat dimana ter-
belenggu oleh pesanan klien 
yang memaksa tampilnya 
suatu karya. 

Karya grafis komunikasi tidak 
hanya mementingkan penam-
pilan kualitas estetik saja, 
tetapi juga diharapkan bisa 
dinikmati oleh masyarakat. 
Jadi tugas praktisi grafis tidak 
hanya menciptakan karya 
yang estetik dan bernilaiguna 
saja, melainkan desainer grafis 
juga diharapkan jeli membaca 
audience (masyarakat) guna 
menginformasikan dan meng-
komunikasikan suatu berita. 

Di industri (lembaga jasa grafis 
komunikasi) merupakan orga-
nisasi yang komplek, dari 
departemen kreatif, departe-
men layanan klien, departe-
men media, departemen 
research, dan departemen 
produksi. Bagian-bagian dari 
departemen ini saling mengisi 
dan berperan untuk menetap-
kan kualitas estetik desain 
yang diciptakannya, meskipun 
kualitas estetik yang dite-
tapkan selalu mempunyai 
keterbatasan dikejar waktu 
dan dituntut kebutuhan bisnis. 
John Wistrand berkata bahwa 
bekerja di industri merupakan 
keadaan yang tidak mengun-
tungkan, karena dihadapkan 
pada banyak masalah, yaitu di 
satu sisi cenderung pada 



 

Desain Grafis Komunikasi 

 
354 

masalah bisnisnya dan sisi lain 
cenderung pada masalah 
estetikanya. Penciptaan karya 
desain di sini dipengaruhi oleh 
masalah pemasaran (bisnis), 
seperti hal-hal yang menyang-
kut penjualan tahun lalu dan 
kompetisi. 

Antara masalah bisnis dan 
masalah estetika desain indus-
tri grafis tidak dapat dipisahkan 
satu dengan lainnya yang 
terikat olah suatu hubungan 
yang saling membutuhkan dan 
mengisi. Suatu karya grafis 
komunikasi dapat dikatakan 
berhasil bila dapat diterima 
masyarakat (pasar) dengan 
aspek tertentu.  

Dalam grafis komunikasi, as-
pek yang perlu diper-
timbangkan adalah bahan, 
fungsi, keefektifan, lingkung-
an, dan dampak produk karya 
terhadap manusia. Suatu 
produk muncul karena adanya 
suatu fungsi tertentu dan 
sekaligus untuk memberikan 
suatu kepuasan / kesenangan 
bagi pemakainya. Dilihat dari 
sudut ekonomi, maka grafis 
komunikasi dibuat untuk 
memenuhi permintaan (pasar) 
dengan tingkat khusus dari 
harga produk karya yang 
dipasarkan.  

Desain adalah salah satu 
bentuk manifestasi kebuda-
yaan yang berwujud. Desain 
adalah produk karya dari nilai-
nilai yang berlaku pada kurun 
waktu tertentu. Sebagai pro-

duk karya kebudayaan, desain 
tidak terlepas dari fenomena 
kebudayaan yang sifatnya 
abstrak dan spiritual, desain 
selalu terkait dengan sistem 
ekonomi, dan sistem sosial. 

C. Sikap Mental dalam 
Usaha Dunia Grafis 
Komunikasi 

Negara kita tampaknya sudah 
terlalu lama dilanda kemero-
sotan perekonomian yang 
mengakibatkan banyaknya te-
naga kerja yang di PHK 
(Pemutusan Hubungan Kerja). 
Bila hal ini tidak segera 
ditangani, maka makin ba-
nyaknya pengangguran yang 
mengakibatkan bertambahnya 
kejahatan dan keonaran di 
mana-mana. Salah satu cara 
untuk mengatasi keadaan 
tersebut adalah menggairah-
kan dan menciptakan kewira-
usahaan baru yang sesuai 
dengan program pemerintah 
dan permintaan masyarakat. 
Wirausaha yang potensial, 
salah satunya adalah produk / 
jasa seni dan desain. 

Wirausaha dari kata “wira” 
atau “prawira” yang artinya 
“priyantun” (orang/pahlawan), 
dan “usaha” artinya “upajiwa” 
(pekerjaan). Poerwadarminta 
mengatakan bahwa “wira” 
adalah pahlawan, “usaha” 
adalah kegiatan dengan me-
ngerahkan tenaga pikiran atau 
badan untuk mencapai keber-
hasilan tertentu.  
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Gambar 13.2: Pola dasar 
kewirausahaan 

Wirausaha dapat didefinisikan 
sebagai orang yang melaku-
kan kegiatan, mengorganisasi 
faktor-faktor  produksi, dan 
memberikan hasil yang pro-
diktif. Pendapat tersebut dapat 
disimpulkan bahwa wirausaha 
merupakan orang yang ber-
jiwa pahlawan untuk melaku-
kan kegiatan yang positif 
dengan mengerahkan harta, 
benda dan pikiran agar 
mencapai suatu keuntungan 
yang lebih. 

Wirausaha, secara langsung 
atau tidak langsung telah 
dilakukan sebagian besar 
masyarakat Indonesia, seperti 
terjadinya transaksi jual-beli 
(bisnis) atau membuat sesu-
atu yang laku dijual. Langkah 
yang dimulai dari kecil-kecilan 
di lingkungan keluarga, ling-
kungan sekolah, lingkungan 
kerja atau di lingkungan 
manapun untuk menawarkan 
produk/jasa merupakan suatu 
bukti bahwa masyarakat kita 
senang akan berwirausaha. 
Anak-anak muda mulai tertarik 
pada profesi yang menjanjikan 
ini, seperti jual-beli sepeda 
motor, bekerja di waktu 
liburan, atau membuat sesu-
atu produk/jasa pada dekade 
tertentu antara lain kartu 
ucapan ulang tahun, kartu 
Natal dan kartu Lebaran.  

Guna memperdalam pengeta-
huan di bidang ini, mereka 
mencoba mempersiapkan diri 
berupa mental, ketrapilan, dan 
ilmu. Persiapan ketrampilan 

mereka dapatkan dari kursus, 
pelatihan, dan magang. Pe-
nambahan ilmu pengetahuan 
melalui buku, media masa, 
atau tanya kepada orang yang 
sudah sukses di bidangnya 
merupakan tambahan bekal 
niat ke arah wirausaha. 

Agar lebih terwujud dalam 
menekuni kewirausahaan, 
perlu adanya pembekalan pola 
dasar kewirausahaan yang 
benar dan luhur yaitu sikap 
mental (attitude), kepemim-
pinan (leadership), ke-tatalak-
sanaan (management), serta 
ketrampilan (skill). 

 

 

 

 

 

 

 

 

 

 

 

Sikap mental merupakan 
bagian inti yang menentukan 
berhasil atau tidaknya sese-
orang berkiprah di dunia 
usaha. Di bagian ini perlu 
adanya sikap mental yang baik 
guna menentukan keber-
hasilan seseorang, karena 
dalam kandungannya terdapat 
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nilai-nilai positif seperti; pro-
aktivitas, motivasi, kejujuran, 
etika, dan ketekunan. 

Unsur kedua adalah kepemim-
pinan guna menentukan arah 
dan mendasari setiap proses 
pengambilan keputusan. Sifat 
kepemimpinan perlu dimiliki 
seseorang pengusaha karena 
guna mengendalikan perusa-
haan ke arah yang benar, 
seperti menentukan kepu-
tusan. 

Unsur ketiga adalah tata 
laksana atau manajemen se-
bagai sistem pengelolaan. 
Manajemen diperlukan untuk 
semua orang atau organisasi 
agar teraturnya suatu peker-
jaan. Dalam pengaturannya 
diperlukan sejak dini agar 
usaha berjalan lebih baik, 
berjalan dengan lancar dan 
berkembang. 

Unsur keempat merupakan 
ketrampilan teknis yang me-
nentukan tinggi rendahnya 
kualitas produk. Unsur ini 
dalam pelaksanaannya perlu 
adanya dukungan dari ketiga 
unsur di atas yaitu sikap 
mental yang baik, sifat kepe-
mimpinan, dan kemampuan 
mengelola sehingga usaha 
yang dijalankan akan maju 
dengan baik dan benar. Ada 
tujuh ciri yang melekat pada 
diri wirausaha, yaitu : 

 Kepemimpinan 

Wirausahawan harus mem-
punyai keunggulan kepemim-

pinan yang berorientasi pada 
sasaran, hubungan kerja / per-
sonal, dan efektivitas dengan 
tampil hangat, mendorong 
pengambangan karir staf ba-
wahannya, dan selalu ingat 
pada sasaran yang hendak 
dicapai. 

 Inovasi 

Inovasi yang dimaksud me-
rupakan bukan arti infovasi 
secara sebenarnya yaitu 
penemuan yang luar biasa, 
tetapi penemuan yang ber-
daya guna sebagai sumber 
ekonomi ke arah produksi. 
Seorang wirausah sebagai 
inovator harus memperhatikan 
gerakan ekonomi di masya-
rakat dan selalu siap mengan-
tisipasi terhadap gerakan 
tersebut dengan mengguna-
kan inovasi. 

 Pengambilan Keputusan 

Suatu keputusan merupakan 
hasil pemecahan masalah 
yang telah terjadi. Wirausa-
hawan dalam memecahkan 
masalah kadang-kadang ku-
rang dimengerti anggota 
bawahannya karena hasil 
yang diputuskannya. Hasil 
keputusan pemimpin yang 
cemerlang tersebut meru-
pakan penggabungan kerja 
intuisi dan inisiatif dalam otak 
manusia yang seakan-akan 
memiliki indera keenam. 
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 Tanggap Terhadap 
Perubahan 

Sikap tanggap wirausahawan 
terhadap perubahan relatif 
tinggi dibanding dengan orang 
lain. Setiap perubahan yang 
mengandung peluang bisnis 
merupakan masukan dan 
rujukan terhadap pengambilan 
keputusan. 

 Bekerja Ekonomis dan 
Efisien 

Seorang wirausahaan tidak 
bergaya seperti seorang man-
dor, namun harus melakukan 
kegiatannya dengan gaya 
yang cerdas, pintar, dan bijak. 
Seorang wirausahawan harus 
bekerja keras, ekonomis dan 
efisien agar dapat mencaai 
hasil yang maksimal. 

 Visi Masa Depan 

Visi ibarat benang merah yang 
tidak terlihat bila ditarik sejak 
awal hingga akhir. Visi pada 
hakekatnya adalah sebagai 
pencermin komitmen  kompe-
tensi-konsistensi agar usaha-
nya mempunyai wawasan ke 
depan. 

 Siap Terhadap Resiko 

Seorang Wirausahawan ada-
lah penentu resiko dan bukan 
sebagai penanggung resiko. 
Dalam menetapkan keputusan 
telah memahami secara sadar 
resiko yang bakal dihadapi, 
dalam arti bahwa resiko itu 
sudah dibatasi sehingga 

kemungkinannya kecil. Kepu-
tusan yang cemerlang dari 
hasil inovasi merupakan usaha 
yang kreatif untuk mem-
perkecil kemungkinan terjadi 
resiko. 

Kesuksesan wirausaha terle-
tak pada diri pribadi untuk 
melakukan sesuatu yang 
positif.  Thomas J. Watson, 
pendiri perusahaan raksasa 
IBM (Internasional Business 
Machines) mengatakan bahwa 
kesuksesan tidak ditentukan 
oleh bakat, tidak juga oleh 
tingkat pendidikan atau ke-
cerdasan, melainkan keu-letan 
dan kegigihan. Keuletan dan 
kegigihan hanya ada kalau 
ada niat atau kemauan. 

D. Pendalaman 
Sebagai generasi muda, 
bersemangatlah untuk berkar-
ya, dan pantang menyerah. 
Berkarya terus-menerus, dan 
selalu memcoba sesuatu yang 
baru, karena desain selalu ada 
yang baru melalui proses 
evolusi. Berlatihkan berkarya 
ke arah manajemen produksi, 
dan manajemen pemasaran 
agar lebih profesional. 
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Persaingan antar produk di 
pasaran mendorong produsen 
gencar untuk berpromosi yang 
dapat menarik perhatian kon-
sumen. Promosi dapat dilaku-
kan melalui berbagai cara, 
antara lain; melalui promosi 
penjualan, publisitas umum, 
penjulan pribadi, dan periklan-
an. Promosi melalui periklanan 
sangatlah efektif karena dapat 
memberikan informasi yang 
jelas terhadap produk pada 
segmen tertentu.  

 
A. Pasar sebagai Sasaran 

Produk 
Strategi komunikasi yang 
sering dipergunakan dalam 
membidik pasar sasaran ada-
lah adanya pengelompokan 
pasar/segmen sebagai wilayah 
calon pembeli/ pemakai. Pemi-
lihan kelompok pasar yang 
spesifik akan lebih mudah 
mengkomunikasikan produk 
melalui media periklanan. Me-
nurut Philip Kotler, segmentasi 
pasar adalah memilahmi-
lahkan suatu pasar yang luas 
ke dalam kelompok-kelompok. 

1. Faktor Geografis 
Segmen pasar berdasarkan 
faktor geografi merupakan 
tujuan pasar dalam unit 
geografis yang berbeda. Pada 
segmen ini, advertiser/praktisi 

memutuskan dalam mende-
sain produk yang mengacu 
pada :  

 Beroperasinya produk ke 
dalam satu atau beberapa 
wilayah geografis, seperti 
iklan rokok Long Beach 
ditujukan kepada masya-
rakat wilayah Asean yang 
berselera rokok putih,  

 Beroperasinya produk ke 
dalam semua wilayah de-
ngan memperhatikan vari-
asi-variasi kebutuhan dan 
pilihan geografis, seperti 
”Indomi” rasa kedaerahan, 
ada rasa Rawon Sura-
baya, Sate Madura, Ren-
dang Padang dan lain-lain.  

Jenis produk yang berda-
sarkan kewilayahan tersebut 
sering dilakukan advertiser 
dalam menciptakan desain 
periklanan ke local genius. 
Perbedaan konsep acuan 
pada daerah tertentu dalam 
desain periklanan yang mem-
berikan kekhasan daerah 
tertentu, seperti seni dan 
budaya yang ada, merupakan 
penekanan informasi yang 
melekat pada produk. Sebagai 
contoh daerah Jawa Timur 
yang mengangkat seni Ludruk, 
Jawa Tengah mengangkat 
seni Wayang Purwa, Jawa 
Barat dengan seni jaipong-
annya, Bali yang diekpos tari 
Kecaknya dan daerah lain 
atau budaya yang ada di 

XIV. PRODUK DESAIN GRAFIS KOMUNIKASI         
YANG MENGARAH TUNTUTAN PASAR 
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daerahnya untuk diangkat 
sebagai pendukung tampilnya 
suatu iklan. Seperti iklan rokok 
Djei Sam Soe 234 kretek yang 
selalu mengang-kat seni dan 
budaya sebagai pendukung 
misi “produk warisan para 
leluhur”. 

2. Faktor Demografis 
Segmen pasar berdasarkan 
faktor demografi merupakan 
pembagian pasar ke dalam 
kelompok-kelompok variabel 
demografi (kependudukan). 
Pemilihan variabel pada seg-
men pasar ini yaitu tingkat usia 
dan daur hidup, dan jenis 
kelamin. 

a. Tingkat usia dan daur hidup 

1) Golongan anak-anak 

Masa perkembangan anak-
anak merupakan masa per-
kembangan ke arah keremaja-
an, seperti perkembangan 
fisik, motorik,bicara, emosi, 
bermain, kreativitas, moral, ke-
pribadian, dan perkembangan 
lainnya. 

 Produk yasng mengarah 
pada segmen pendidikan 
anak antara lain iklan 
Pepsodent fersi “yuk ber-
main” dengan misinya 
“bagaimana cara merawat 
gigi yang sehat”, susu 
Bendera 123 yang mengin-
formasikan tentang bagai-
mana ibu muda mendidik 
anaknya dalam berkomu-
nikasi dan bermain. 

 Iklan yang mengarah ke 
segmen hiburan atau per-
mainan anak, antara lain 
boneka, mobil-mobilan, je-
nis makanan ringan anak-
anak yang ditunjang de-
ngan hadiah didalamnya.  

 Segmen anak-anak yang 
diarahkan pada khayalan 
atau meniru tokoh-tokoh 
“Super” seperti, iklan susu 
Bendera yang menam-
pilkan tokoh “Kapten Ben-
dera yang mengajak ter-
bang ke Roma” sebagai 
hadiah bagi anak-anak 
yang mengkonsusinya. 

2) Golongan remaja 

Masa remaja ini disebut 
sebagai masa penghubung 
atau masa peralihan antara 
masa kanak-kanak ke masa 
dewasa. Pada periode ini 
terjadi perubahan-perubahan 
besar dan esensial mengenai 
kematangan psikologis dalam 
menemukan dirinya dan 
mencari nilai-nilai kebaikan, 
kebijaksanaan, keindahan, se-
nang terhadap tokoh idola 
(terkenal), tertarik lawan jenis, 
dan lain-lain. 

 Penginformasian produk 
melalui iklan yang me-
ngarah ke segmen pasar 
remaja perempuan antara 
lain; iklan Lux “sabun 
kecantikan bintang-bintang 
film” yang diperuntukan 
bagi perempuan yang me-
ngidolakan para bintang 
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film. Sunsilk Ginseng “me-
miliki rambut panjang 
hitam yang menggoda”, 
yang ditujukan pada pe-
rempuan penuh percaya 
diri terhadap rambutnya 
yang dapat menarik lawan 
jenisnya, begitu juga iklan 
produk Pon’s White Beauty 
yang membuat kaum pria 
tertarik pada yang mema-
kaianya 

 Iklan produk yang menga-
rah ke segmen remaja laki-
laki agar lebih dekat pada 
perempuan, antara lain 
EXTRA JOSS sebagai 
kekuatan otot lelaki yang 
menjadi dambaan wanita. 

3) Golongan dewasa Segmen  

Pasar yang diarahkan ke 
kelompok orang dewasa 
merupakan segmen yang luas 
bila dibandingkan dengan 
golongan anak-anak dan 
remaja. Hal ini dapat diketahui 
dari ciri-cirinya, seperti peman-
tapan letak kedudukan, orien-
tasi tugas kebersamaan, 
hubungan sosial yang tinggi 
dan sebagainya. Segmen 
pasar yang mengarah pada 
pemantapan kedudukan (ja-
batan, ekonomi) merupakan 
produk-produk eklusif, seperti 
produk ramah lingkungan.  

Hubungan sosial dalam kehi-
dupan orang dewasa meru-
pakan salah satu kerukunan 
hidup di masyarakat. Hubu-
ngan bermasyarakat di antara 

tetangga bisa dilakukan de-
ngan cara bertamu, mem-
bantu yang membutuhkan 
ataupun yang lain. Produk 
yang diarahkan ke segmen pa-
sar ini antara lain kopi 
Torabika yang “siap dihi-
dangkan sewaktu-waktu”. 

b. Jenis kelamin  

Segmen pasar jenis kelamin 
merupakan pelemparan pro-
duk seni dan desain ke 
pasaran dengan memper-
hatikan kesempatan kebutuh-
an pria, wanita atau kedua-
duanya.  

 Segmen ke arah wanita 
remaja yang lebih cen-
derung untuk melihat se-
suatu yang lemah lembut, 
anggun, dan harmonis, 
seperti produk jamu Hay-
ping, sebagai “jamu pe-
langsing tubuh merupakan 
dambaan setiap wanita”.  

 Segmen yang diarahkan 
pada pria remaja yang 
mempunyai sifat gagah. 
Pemberani, dan penuh 
percaya diri, sperti pada 
iklan kemeja Arrow, rokok 
Marlboro, dan rokok Jarum 
Super.  

3. Faktor Psikologis 
Segmen pasar berdasarkan 
faktor psikologi merupakan 
jangkauan pasar berdasarkan 
unsur kejiwaan dalam diri 
manusia. Pada segmen pasar 
ini para pembeli dibagi ke 
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dalam kelompok yang ber-
beda-beda berdasarkan kelas 
sosial, gaya hidup, dan ciri-ciri 
kepribadian.  

a. Kelas sosial 

Kelas sosial adalah kelompok-
kelompok yang relatif abadi 
dalam suatu masyarakat yang 
tersusun secara hirarkis dan 
para anggota masyarakatnya 
mempunyai nilai, minat, dan 
tingkah laku yang sama. 
Produk yang ditujukan pada 
kelas sosial sangat melekat 
dengan status si pembeli 
(konsumen). Seperti produk 
jamu yang dikemas kapsul, 
dengan harapan agar si 
pembeli lebih cepat mene-
lannya dan kelihatan lebih 
modern (seperti obat). 

b. Gaya hidup 

Gaya hidup seseorang me-
nunjukkan pola hidup ma-
syarakat yang diperlihatkan 
dalam kegiatan. Gaya hidup 
seseorang mencerminkan ke-
seluruhan pribadi orang 
tersebut dalam pergaulan 
dengan lingkungannya. Gaya 
hidup memperlihatkan sesuatu 
yang lebih dari pada sekedar 
kelompok sosial atau priba-
dinya sendiri. Gaya hiduplah 
yang menggambarkan keselu-
ruhan pola bertindak dalam 
pola interaksi seseorang yang 
mempunyai ciri psikologis. 

Gaya hidup tidak sepenuhnya 
dipengaruhi oleh pendapatan 

ekonomi yang tinggi, melain-
kan suatu gejala yang timbul 
dari diri manusia untuk 
mencapai kepuasan batin 
terhadap benturan tuntutan di 
masyarakat. Misalnya, Hand 
Pone merupakan alat komu-
nikasi langsung, juga adanya 
kepuasan batin agar tidak 
dikatakan ketinggalan jaman, 
begitu juga Mc. Donald’s yang 
mengangkat tuntutan spiko-
logis bagi yang membelinya. 

c. Kepribadian 

Kepribadian yang dimaksud 
adalah ciri-ciri psikologis sese-
orang yang menimbulkan 
tanggapan secara relatif, kon-
sisten terhadap lingkungan-
nya. Kepribadian bisa berguna 
untuk menganalisis tingkah 
laku konsumen jika terdapat 
hubungan antara jenis kepri-
badian tertentu dengan pro-
duk. Sifat kepribadian, seperti 
lemah lembut, ceria, suka 
bergaul, ingin tampil beda dan 
sebagainya, yang kesemua-
nya dapat ditangkap sebagai 
pengguna produk yang akhir-
nya muncul desain kemasan 
rokok yang berjiwa muda, 
seperti rokok Stard Mile, dan 
make up Putri yang dibuat 
warna-warni penuh keceriaan. 

4. Faktor Behavioristik 
Segmen pasar berdasarkan 
faktor behavioristik merupakan 
jangkauan pasar yang me-
ngarah pada perilaku konsu-
men dengan memperhatikan 
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kelompok-kelompok tertetu 
berdasarkan pengetahuan, si-
kap, kegunan atau tanggapan 
terhadap produk yang dijual. 
Dalam Segmen pasar ini terdiri 
dari faktor kesempatan, man-
faat yang dicari, status 
pemakai, dan tingkat pemakai. 

a. Kesempatan 

Para pembeli bisa membe-
dakan menurut kesempatan 
ketika memperoleh gagasan 
membeli atau memakai pro-
duk. Penciptaan iklan ber-
dasarkan kesempatan ini 
tentunya advertiser meman-
dang dalam segi fungsi 
tertentu. Produk-produk terse-
but antara lain produk 
Energent yang “dikonsum-
sikan bagi orang yang tidak 
sempat sarapan pagi”. 

b. Manfaat yang dicari 

Bentuk segmen pasar yang 
kuat adalah klasifikasi pada 
konsumen menurut perbedaan 
manfaat yang konsumen 
(masyarakat) cari dari produk 
yang dipasarkan. Konsumen 
mencari produk yang membe-
rikan manfaat-manfaat ter-
tentu bagi si pemakai. Produk 
yang dimaksud antara lain 
susu Anlene untuk “membantu 
mencegah osteoporosis”. 

c. Status pemakai 

Status pemakai merupakan 
segmen penerapan produk 
berdasarkan pada kelompok 

tertentu, seperti non pembeli, 
eks pemakai, calon pemakai, 
pemakai pertama, dan pema-
kai tetap sebuah produk. 
Produk yang dipasarkan ber-
dasarkan segmen pasar ini 
merupakan cara untuk mene-
kankan kepercayan terhadap 
produk, memperkenalkan pro-
duk atau mengingatkan produk 
yang telah lama ditinggalkan, 
seperti jasa asuransi. 

d. Tingkat pemakaian 

Tingkat pemakaian merupa-
kan bentuk segmen pasar 
berdasarkan pengelompokan 
pemakai produk baik ringan, 
menengah, dan berat. Untuk 
menentukan pengelompokan 
segmen pasar ini sebaiknya 
dibuat presentasi berdasarkan 
tingkat ekonomi dan selera. 
Sebagai contoh masyarakat 
berekonomi tinggi dan mem-
punyai selera yang tinggi akan 
membeli mobil BMW atau 
Marcedes-Bend, begitu juga 
sabun colek UMO yang ditu-
jukan masyarakat ekonomi 
rendah di masa krisis. 

Berbagia macam segmen pasar 
tersebut di atas meru-pakan 
acuan untuk melempar produk 
kepada masyarakat 
(konsumen). Di samping itu 
pengenalan terhadap kondisi 
pasar secara menyeluruh, dan 
pemahaman terhadap penge-
lompokan segmen pasar se-
suai dengan produk yang akan 
dipasarkan melalui periklanan. 
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B. Pasar sebagai Tuntutan 
Kebutuhan Konsumen 

Setiap orang akan selalu 
berusaha untuk dapat meme-
nuhi kebutuhannya dengan 
menggunakan atau mengkon-
sumsi prosuk/jasa yang ada. 
Usaha untuk memenuhi 
kebutuhan ini sebagian besar 
dilakukan melalui “pasar”. 
Pentingnya pasar di dalam 
masyarakat dapat dilihat da-
lam kehidupan sehari-hari, 
seperti toko, warung, kios, 
swalayan, supermarket atau 
shopping center selalu dipe-
nuhi oleh konsumen. 

Semakin tinggi taraf hidup dan 
tingkat sosial suatu masya-
rakat, semakin banyak tingkat 
pilihan masyarakat tersebut 
untuk memenuhi keinginan 
dalam kebutuhan. Untuk dapat 
mengikuti kebutuhan masya-
rakat yang semakin meningkat 
itu, kegiatan pemasaran tidak 
saja menyangkut masalah 
mengalirnya produk dari pro-
dusen ke konsumen me-
lainkan juga hal-hal kegiatan 
penelitian produk baru.  

Pengembangan produk yang 
ada yang dilakukan sejalan 
dengan pengembangan ting-
kat kesejahteraan masyarakat 
serta perubahan persepsi 
masyarakat terhadap produk-
produk di pasaran, penetapan 
harga, dan pelayanan kepada 
konsumen atau langganan. 

Kegiatan pasar berasal dari 
adanya kebutuhan manusia 

dan usahanya untuk meme-
nuhi kebutuhan tersebut me-
lalui “pertukaran” atau “barter”. 
Di dalam masyarakat yang 
system perekomomiannya ter-
batas ini, tiap individu dalam 
masyarakat berusaha untuk 
memenuhi kebutuhannya me-
lalui hasil produksinya sendiri. 
Jika mendapatkan produk lain 
yang yang tidak dihasilkannya, 
mereka akan berusaha mem-
perolehnya dari individu lain 
yang menghasilkan kebutuh-
annya tersebut untuk kemu-
dian saling bertukar produk.  

Di dalam perkembangannya, 
ditemukan “alat pertukaran” 
sehingga kemudian kita me-
ngenal “ kegiatan transaksi 
jual-beli”. Pada saat itulah 
pemasaran menjadi arena 
kegiatan transaksi jual beli, 
dimana seluruh barang yang 
dihasilkan atau diproduksi de-
ngan mudah dapat dijual. 
Usaha meningkatkan produksi 
jumlah barang termasuk pula 
jumlah jasa untuk memenuhi 
kebutuhan manusia ini menim-
bulkan adanya kegiatan “per-
dagangan” dan “usaha pendis-
tribusian” barang / jasa dari 
produsen ke konsumen. 

Adanya peningkatan taraf hi-
dup masyarakat yang tercer-
min dalam kesejahteraan yang 
meningkat, orang tidak saja 
memikirkan tantang kebu-
tuhannya (needs), melainkan 
juga meningkatkan pemikiran 
akan keinginan (wants).  
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Pasar dituntut mampu meme-
nuhi keinginan konsumen 
yang tidak hanya terbatas 
pada kebutuhan untuk makan 
dan minum saja. Jenis ke-
butuhan jadi semakin kom-
pleks, antara lain kebutuhan 
hidup, keamanan, sosial dan 
akhirnya kebutuhan pribadi 
yaitu kebutuhan individu yang 
tidak berhubungan dengan pi-
kiran atau perbuatan lainnya. 

 
1. Produk yang Dibutuhkan 

Konsumen 
Produk dikatakan berhasil 
apabila desain tersebut dapat 
diterima dengan baik oleh 
masyarakat selaku konsumen. 
Untuk mengetahui selera 
pasar, tidaklah cukup hanya 
melalui survey pasar saja 
namun juga penelitian psi-
kologi konsumen guna ter-
capainya proses desain.  

 

 

 

 

 

 

 

 

 

 

 

 

Melalui ilmu psikologi dapat 
diketahui masalah kebutuhan 
dasar manusia yang diha-
rapkan dapat dipuaskan me-
lalui desain produk yang akan 
dibuat. Teori psikologi me-
ngatakan bahwa individu 
selalu dipengaruhi oleh keku-
atan lingkungan. 

Pada gambar di atas, men-
jelaskan bahwa manusia se-
lalu didorong oleh kebutuhan-
kebutuhan (keinginan) saat ini 
dan sebagian dipengaruhi oleh 
lingkungan dimana dia ting-
gal/hidup. Tampak pula suatu 
kebutuhan saat ini dipengaruhi 
oleh keadaan masa lampau 
atau merupakan antisipasi 
kebutuhan waktu mendatang. 
Desain yang dibutuhkan kom-
sumen dapat diketahui melalui 
perilaku konsumen yang 
mendasari kebutuhan hakiki 
bagi manusia. 

Gambar 14.1:  
Produk kebutuhan konsumen
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Berhasilnya desain produk 
yang berbasis local genius 
yang mengacu tuntutan pasar 
setidaknya melalui beberapa 
tahapan proses, yaitu: 

 Pemikiran masalah, yaitu 
merencanakan tujuan dan 
fungsi dari benda yang 
akan dibuat. 

 Penggalian ide dari unsur 
yang ada ke dalam bentuk 
nyata sesuai dengan fungsi 
dan teknologi proses. 

 Persiapan dan pemilihan 
bahan dan alat yang akan 
digunakan. 

 Membuat alternatif model 
desain yang dimungkinkan 
terserap pasar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Memilah dan memilih bebe-
rapa desain yang dianggap 
bagus, bisa dikerjakan de-
ngan teknologi yang ada, 
dan layak jual. 

 Merencanakan 
terselesainya proses pro-
duksi. 

2. Produk yang Mengacu 
pada Siklus Hidup 
Produksi 

Pengertian “siklus hidup” disini 
adalah tahapan dari kehi-
dupan usaha produk atau 
tahapan yang terjadi di dalam 
suatu perusahaan dalam me-
masarkan suatu produk atau 
jasa. 

Siklus hidup ini diawali dengan 
adanya tahap perkenalan, 
dimana produk mulai mema-
suki pasaran. Suatu partum-
buhan akan terjadi apabila 
banyak pembeli menyerbu 
pasar bila suatu produk baru 
terbukti berhasil menarik minat 
konsumen.  

 

 

 

 

 

 

 

 

 

 

Pada titik tertentu, pertumbuh-
an akan berhenti dan menuju 
pada tingkat pertumbuhan 
normal yaitu produk hanya 
dibeli oleh suatu kelompok 
pembeli yang memang mem-
butuhkan produk tersebut. 
Pertumbuhan akan menurun 

Gambar 14.2:  
Produk yang mengacu pada siklus hidup produksi
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apabila muncul produk baru. 
Penjelasan di atas, bahwa 
siklus hidup terdiri dari 4 
tahap, yaitu tahap perke-
nalan, pertumbuhan, kedewa-
saan, dan penurunan.  

Maka tahap kedewasaan bagi 
jenis barang shopping khsus-
nya pakaian jadi relatif 
pendek. Pengaruh aliran mode 
serta pakaian jadi sebagai 
sandang (di samping sebagai 
kebutuhan pokok, juga ber-
fungsi sebagai  bagian dari 
gaya hudup. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C. Pendalaman 
Carilah karya desain grafis 
yang mengarah ke faktor 
geografis, faktor demografis, 
faktor psikologis, dan faktor 
behavioristik. Kumpulkan kar-
ya tersebut dalam bentuk 
kliping dan dijilid. 
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A. Kita Kaya Berbagai 
bentuk Seni 

Kesenian etnik dalam perkem-
bangannya secara beransur-
angsur telah mengalami peru-
bahan fungsi, hal ini meru-
pakan suatu kondisi alamiah. 
Bahwa setiap masyarakat 
selalu mengalami kondisikon-
disi tertentu mencapai tingkat 
peradaban. Peradaban yang 
dicapai mengalami berbagai 
variasi yang saling tergantung 
satu dengan yang lainnya. 

Kesenian dalam kerangka 
mengembangkan cita-cita ma-
nusia mencapai tingkat pera-
daban yang tinggi, yang lebih 
mengutamakan berbagai me-
kanisme yang bersifat “teknik” 
atau cara yang memudahkan 
berbagai kebutuhan kehi-
dupan. Berkembangnya tek-
noligi di Negara-negara ber-
kembang seperti Indonesia 
lebih menekankan pada sebu-
ah sistem yang bertolak pada 
nilai-nilai tradisional. Hal ini 
menjadi sebuah harapan atau 
cita-cita yang bertumpu pada 
nilai-nilai historis.  

Pada hal tertentu seringkali 
mengalami kendala proses 
yang mengarah pada sebuah 
“jalan pintas”. Sehingga ada 
fenomena ”alih teknologi”, hal 
ini terserap juga dalam 
kehidupan berkesenian.  

Hanya saja proses tersebut 
seringkali terkendala oleh 
sebuah mentalitas yang tidak 
kunjung dapat menyesuaikan 
diri dengan cepat, tetapi me-
ngakibatkan terjadinya sebuah 
pola kehidupan berkesenian 
yang lebih Mengatamakan hal-
hal yang bersifat ”instan”, 
kesesaatan yang bersifat 
menghibur. Kondisi demikian 
ini membutuhkan sebuah kon-
sep yang meletakan pada 
pemikiran yang berorentasi 
pada ”ekologis”.  

”Ekologi” adalah sebuah pe-
ngertian yang bersifat alamiah, 
yaitu tempat kita tinggal. 
Artinya kesenian berkembang 
dengan dasar dan orentasi 
apapun diharapkan mampu 
menunjukan pola yang bersifat 
narutal, alamiah. Seperti kehi-
dupan ini, bahwa semua 
makluk selalu mempunyai cara 
untuk mengadaptasi perubah-
an situasi dan kondisi 
lingkungan yang berubah.  

Konsep ”ekologis” dimungkin-
kan terjadinya sebuah iklim 
berkenian yang mencapai 
sebuah pola idealistik yang 
mampu mengimbangi perkem-
bangan di zamannya, se-
hingga terjadi penyesuaian 
bentuk, pola, dan tata cara 
tertentu  pada kehiadirannya.  

Fungsi kesenian pada waktu 
yang lampau adalah diten-
tukan oleh pola bertolak pada 
kebutuhan adat atau tatacara 

XV. FREE DESIGN
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kehidupan masyarakatnya, te-
tapi perkembangan zaman 
menjadi sangat berbeda. 
Fungsi kesenian mencari ke-
terkaitan tertentu pada sebuah 
kehadian pola prilaku manu-
sianya, sehingga dibutuhkan 
pemikiran tertentu. Asumsi da-
sar yang membentuk hal 
tersebut diharapkan terjadinya 
sebuah kondisi pebuahan cara 
orang memandang kesenian, 
sehingga tidak lagi kesenian 
dipandang dari sisi kepen-
tingan masyarakatnya, tetapi 
bertolak pada bentuk atau 
medel kesenian itu hadir di 
tengah-tengah kehidupan. Se-
hingga manusia akan meman-
dang kehadiran kesenian itu 
dalam sebuah konstelasi ke-
hidupan.

Kesenian tidak lagi sebagai 
objek, pelengkap, atau sebuah 
cara untuk mencapai suatu 
tujuan tertentu. Tetapi lebih 
ditekankan pada hubungan 
interaktif kesenian itu dengan 
pola hidup masyarakatnya. 
Dengan demikian, kesenian 
dan pola kehidupan masya-
rakat diharapkan mempunyai 
titik temu tertentu, pertemuan 
antara progresifitas kehidupan 
masyarakat dan kehadiran 
kesenian.

Oleh karenanya berbagai 
kesenian etnik yang mencapai 
tingkat evolosi bentuk, dalam 
berbagai kondisi dibutukan 
sebuah cara dalam mentras-
formasikan dalam kehidupan 
manusia. Jika tidak dipikirkan, 

maka kehidupan manusia 
yang terus mencapai tingkat 
pradaban tertentu akan me-
ningalkan kesenian, sebab 
kesenian yang tidak mampu 
mentrasfomasi kearah dalam 
kondisi jiwa zaman, akan 
mengalami kepunahan.  

Punahnya kesenian tidak 
dapat ditahan, atau dicegah. 
Jika terjadi demikian, maka 
sebuah proses trasformasi 
kesenian itu dalam sebuah titik 
zaman tertentu menjadi gagal. 
Kegagalan ini tidak dapat 
disesalkan, tetapi bagi mereka 
yang memang benar-benar 
memikirkan bentuk dan nilai-
nilai kesenian yang dianggap 
pada masa yang lalu mampu 
memberikan arti penting dalam 
kehidupan setidaknya dilaku-
kan usaha-usaha yang bersifat 
alternatif.

Banyak negara-negara ber-
kembang yang berhasil 
melakukan trasfromasi kese-
nian dalam kehidupan metro-
polis, hanya saja acapkali 
terjadai sebuah pola pikir yang 
seolah-olah ingin mengem-
balikan kondisi kehidupan dan 
tata nilai ke arah zaman 
lampau. Hal tersebut tentunya 
sangat sulit. Tetapi tata nilai 
pada zaman ini diharapkan 
memiliki sentuhan nilai-nilai 
lama yang bersifat luhur untuk 
mengantarkan kehidupan ma-
syarakat yang ”beradab”, 
bertatanilai yang humanistik, 
dan mencapai tingkat kebi-
jakan dalam memandang 
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berbagai fenomena zaman 
secara lebih positif. 

Pola perilaku trasformasi yang 
dipikirkan pada paparan 
tulisan ini setidaknya ada 3 
pola, yaitu:

1) pola penguatan eksistensi 
bentuk seni 

2) pola penumbuhan bentuk 
seni

3) Pola Progresifitas estetik 
atau bentuk spiritual.  

1. Pola Penguatan Eksis-
tensi Bentuk Seni 

Pola penguatan eksistensi 
bentuk seni adalah sebuah 
cara untuk memandang ben-
tuk kesenian etnik dari sisi 
keberadaan. Tetapi tidak lagi 
dilihat dari sisi fungsi, karena 
fungsi yang melekat pada 
kesenian etnik seringkali telah 
”mati”, sehingga kita hanya 
dapat mencermati kembali 
eksistensi bentuk yang mam-
pu kita kenali. Setidaknya da-
pat ditemukan unsur-unsurnya.  

Pola ini seringkali digunakan 
isitilah ”revitalisasi”, yaitu 
bentuk-bentuk dari kesenian 
etnik yang telah ditinggalkan 
oleh fungsi adat atau tra-
disinya dikuatkan kembali, 
tentunya diberikan sebuah ru-
ang gerak tertentu yang 
memungkinkan bentuk seni 
tersebut mampu diadaptasikan 
pada berbagai pola kehidupan 
masyarakatnya. Sebagai con-
toh, berbagai bentuk desain 

batik tradisional direvitali-
sasikan kepola-pola bentuk 
yang sedang dibu-tuhkan oleh 
masyarakat misal-nya untuk 
tas, atau benda-benda lain 
yang fungsinya sangat berbe-
da. Sehingga nilai-nilai yang 
terkandung dalam batik 
tersebut tidak menjadi pertim-
bangan utama, tetapi pola-
pola batik yang mulai 
ditinggalkan mampu diadap-
tasikan pada berbagai prodak 
yang memiliki arti penting 
dalam kehidupan sekarang.  

2. Pola Penumbuhan Ben-
tuk Seni 

Pola penumbuhan bentuk seni 
yaitu sebuah cara yang 
seringkali dibsebut sebagai 
”rekonstruksi” yaitu sebuah 
cara untuk membangun 
kembali tata bentuk dan juga 
tata nilai yang lebih mampu 
beradaptasi dengan zaman-
nya. Berbagai pola kehidupan 
masa lalu yang memiliki pesan  
moral yang dalam dan bersifat 
filosofis diangkat kembali 
dalam bentuk yang lebih 
progresif, seperti munculnya 
tokoh - tokoh ”Superman”, 
”Satra bajahitam”, atau ” X-
man” adalah sebuah cara 
mengkonstruksi ide-ide ”patri-
otis” dari kehidupan etnik 
masa lalu. Tetapi diolah dalam 
spirit baru untuk memberikan 
makna yang lebih up to date.
Pola rekonstruktif dilakukan 
oleh Negara-negara maju 
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untuk memberikan spirit za-
mannya, karena dalam ma-
syarakat kontemporer salah 
satunya adalah mengalami 
krisis identitas. Sehingga gaya 
hidup dan berbagai pola 
kehidupan menjadi seragam, 
sama, citarasa hidup tidak 
memiliki perbedaan yang khas. 
Maka hal ini dimungkinkan 
memunguti kembali spirit masa 
lalu agar menemukan jatidiri. 
Sungguhpun ”jatidiri” atau 
eksitensial secara kolektif 
sudah tidak ditubuhkan, tetapi 
spirit masa lalu masih tetapi 
ditubuhkan dalam membangun 
kekuatan emosional dalam 
menempuh masa depan yang 
bergerak sangat cepat.  

3. Pola Progresifitas estetik 
atau bentuk spiritual.
Pola progresifitas estetik  atau 
bentuk spiriual  adalah sebuah 
kerja kreatif yang terus 
menerus dihayati dan dikem-
bangkan dalam jiwa seniman 
dan masyarakat. Pada tataran 
ini yang dipikirkan tidak lagi 
bentuk atau wujud, tetapi 
sebuah proses yang potensial 
dalam memahami kehadiran 
bentuk.

Seniman tidak lagi dimung-
kinkan untuk berkubang terlalu 
lama pada teknik produksi, 
tetapi dimungkinkan bergerak 
maju dalam pengembaraan. 
Pemikiran yang bersifat kon-
septual dan menyerap potensi 
energi masa lalu serta 

melontarkan jangkauannya pa-
da masa depan yang penuh 
dengan kearifan, toleransi 
yang bijak, dan menemuan 
esensi pada setiap kehadiran 
karya seni.  

Sehingga proses berkesenian 
tidak menitik beratkan pada 
pelatihan kemampuan teknik 
untuk trapil, mencapai sebuah 
tataran kesulitan tertentu yang 
menahan berbagai impresi 
yang liar. Mengikuti pola 
patron yang tidak diharapkan 
mengurangi dan melebihkan.

Pola kreatif masa kini  yang 
dibutuhkan adalah sebuah 
penemuan dan memekakan 
pengalaman estetik yang digali 
dari pengembaraan panca 
indara, empati yang tinggi 
terhadap berbagai perwujudan 
yang lebih bervariasi, menje-
lajahi berbagai bentuk yang 
selalu muncul dalam berbagai 
visi, pengingkaran terhadap 
fungsi dan menganggap se-
buah kehadiran bentuk bukan 
sebuah satu-satunya cara 
untuk melahirkan alternatif 
kesenian yang baru. Tetapi 
menyadari tentang makna ke-
senian dalam konstelasi 
kehidupan yang lebih nyata. 
Misalnya, sebuah konstruksi 
yang memerangi naturalistik 
kehidupan manusia, kekeras-
an, pornografis, atau kecong-
kakan yang bersifat individual.  

Itu semua  dibutuhkan cara 
penaklukan diri sendiri dengan 
menciptakan strategi yang 
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lebih homanistik. Tetapi tidak 
mengingkari bahwa zaman ini 
adalah sebuah zaman yang 
tidak dapat diputar kembali 
kemasa lalu, tetapi spirit masa 
lalu dimungkinkan dapat hidup 
pada zaman ini.

Pada pola ini adalah kesenian 
mencapai makna kesenian, 
bukan fungsi. Karena fungsi 
kesenian sudah mati, yang 
dihidupkan adalah potensi 
estetik manusia. Maka yang 
digarap dalam tataran ini 
adalah manusia dalam ber-
bagai segmen kehidupan, seni 
lebih dibutuhkan memberikan 
suaranya yang terdalam, yaitu 
membuat manusia lebih bijak-
sana, lebih arif, dan lebih 
toleran dalam menangkap 
berbagai kehadiran bentuk.  

Seni tidak lebih dimanfaaatkan 
atau dieksploitasi sebagai 
sebuah produk yang selalu 
diburu nilai bentuk yang 
alternatif, tetapi semua orang 
mampu menangkap bahwa 
kehadiran berbagai perwu-
judan lingkungannya adalah 
sebuah citra estetik.  

                                                                                                                               
B. Local Genius sebagai 

Pijakan Karya Grafis 
Sebuah desain dikatakan 
memiliki unsur local genius
adalah sebuah desain yang 
mampu menampilkan sebuah  
sentuhan ekspresi kebuda-
yaan lokal asli Indonesia pada 
desainnya. Ada beberapa cara 

untuk mengangkat desain kita 
ke kancah Internasional rasa 
Indonesia, antara lain dengan 
cara pelestarian, penggalian, 
pengembangan, dan pencip-
taan.

1. Pelestarian 
Setiap kelompok masyarakat 
tentu memiliki seni yang 
sesuai dengan ciri dan kebu-
tuhan masyarakat tersebut. 
Bagai masyarakat yang masih 
melestarikan budaya praseja-
rah atau dari nenek moyang, 
mereka memerlukan seni 
hampir pada semua kegiatan 
serta peristiwa penting yang 
dianggap ritual. Di samping itu, 
seni merupakan ungkapan 
pribadi yang berfungsi sebagai 
persembahan. Pelestarian se-
ni dan budaya mempunyai ciri-
ciri sebagai berikut: 

a. Mempertahankan karakter 
seni dan budaya lama.  

b. Secara visual maupun 
verbal, seni dan budaya 
tetap seperti peninggal 
dulu.

c. Adanya kegiatan ber-ke-
senian dan berbudaya 
agar karya besar nenek 
noyang tersebut tidak 
hilang

d. Seni dan budaya tetap 
dilakukan dari generasi ke 
generasi.

e. Seni dan budaya tetap di 
uri-uri (dilestarikan) 
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Gambar 15.2:  
Siapa yang tidak tahu Punakawan, yang selalu muncul dalam karya Indonesia 

Gambar 15.1:  
Perlu mempertahankan seni dan budaya masa lalu sampai masa kini 
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Gambar 15.3:  
Seni dan budaya peninggalan Keraton masa lalu tetap dijaga dan ditampilkan 

2. Penggalian 
Perancangan grafis bisa 
ditentukan melalui penggalian 
seni dan budaya lama yang 
telah menghilang untuk diang-
kat kembali. Penggalian ini 
merupakan cara nostalgia ter-
hadap produk lama. Dengan 
adanya program penggalian ini 
dimaksudkan generasi baru 
bisa meningmati dan mem-
bandingkan produk berkese-
nian dulu dengan produk 
berkesenian sekarang. Mak-
sud diadakannya penggalian 
seni dan budaya ini adalah: 

a. Pencarian yang telah lama 
hilang

b. Nostalgia yang lama telah 
hilang

c. Diadakan agar menjadi 
tradisi

3. Pengembangan 
Teknik pengembangan meru-
pakan cara mengolah yang 
telah ada menjadi baru. Agar 
masyarakat tidak jenuh maka, 
perlu penyegaran dengan cara 
pengolahan seni dan budaya 
lama menjadi baru, walaupun 
masih membawa nafas lama. 
Ciri-cirinya grafis yang menga-
cu pada teknik pengembangan 
ini adalah: 

a. Baru tetapi seperti lama 
b. Bersumber dari yang telah 

ada (tradisi) 
c. Memadukan beberapa 

yang telah ada 
d. Memodifikasi yang telah 

ada
e. Tiruan dari aslinya 
f. Bentuk mini atau singkat 

dari aslinya 
g. Penuh variasi 
h. Tidak sakral  
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Gambar 15.6:  
Penggalian seni dan budaya masa lalu melalui cerita, dan naskah lama merupakan 

cara mencapatkan ide dalam penggalian karya grafis 

Gambar 15.4: Tokoh Bima dari 
pewayangan dikemas menjadi sebuah 

gaya komik merupakan terobosan 
dalam karya grafis 

Gambar 15.5: Apapun gaya dan olahan 
grafisnya, punakawan masih tampak 

karakternya, dan lucu 
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Gambar 15.8: 
Iklan layanan masyarakat yang didramatisir  

kehidupan di masyarakat 

Gambar 15.7:  
Sebuah cover buku yang mengacu 
karakter Indonesia 

4. Penciptaan 

Perancangan grafis komu-
nikasi bisa juga dilakukan 
melalui cara penciptaan. Yang 
dimaksud penciptaan adalah 
membuat rancangan yang 
belum ada tetapi masih me-
ngacu pada akan seni dan 
budaya Indonesia. Ciri-ciri 
karya yang termasuk kelom-
pok penciptaan ini adalah: 

a. Sesuatu yang baru, tetapi 
bernafas tradisi 

b. Baru, namun tetap menga-
cu pada budaya setempat. 

C. Pendalaman 
Pelajari buku tentang budaya 
Indonesia, baca dan amati 
komik bercerita budaya Indo-
nesia, cermati karya desain 
grafis yang bernafaskan Indo-
nesia, setelah itu buatkan 
sebuah karya komik yang 
bersumber dari budaya Indo-
nesia.
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Perencanaan media adalah 
proses pengarahan pesan 
melalui media komunikasi ke 
khalayak sasaran (masya-
rakat) pada waktu dan tempat 
yang tepat serta menggu-
nakan saluran yang tepat. 
Perencanaan media harus 
memperhatikan empat kelom-
pok kegiatan, yaitu: memilih 
kelompok sasaran masya-
rakat, tujuan media, jenis 
media dan sasarannya. 

1) Memilih kelompok sasar-
an masyarakat 

Berhasil atau tidaknya media 
komunikasi yang dirancang 
bisa ditentukan olek pemilihan 
kelompok sasaran masyarakat 
yang dituju. Kelompok masya-
rakat yang mempunyai ka-
rakteristik tertentu yang 
cenderung bertindak serupa 
dan mempunyai keinginan 
serupa. Kelompok ini sebagai 
kelompok segmen dan kelom-
pok pembeli melalui kemiripan 
tertentu dalam membeli pro-
duk atau jasa. 

2) Memilih tujuan media 
Suatu perusahaan / pemesan 
media komunikasi tentunya 
mempunyai tujuan-tujuan ter-
tentu agar produk/jasa yang 
dikomunikasikan melalui me-
dia  isa  diterima  masyarakat.  

Tujuan perencanaan media, 
meliputi:

Jangkauan, merupakan target 
segmentasi sesuai dengan 
wilayah jangkauan yang di-
bidik melalui media komu-
nikasi, misalnya iklan yang 
dikomunikasikan melalui mas-
media RADAR kota tertentu 
yang memiliki jangkauan pada 
kota tersebut, sangat beda 
dengan masmedia KOMPAS 
yang jangkauannya masional. 

Frekuensi, merupakan sebe-
rapa sering khalayak sasaran 
melihat, membaca, maupun 
mendengar selama dekade/ 
periode tertentu. Misalnya 
berapa kali iklan diterbitkan 
disurat kabar, berapa kali 
orang melihat poster yang 
dipasang di jalan protokol, 
atau berapa kali sehari orang 
mendengar iklan di radio. 

Berkelanjutan, suatu produk/ 
jasa harus di komunikasikan 
secara terus-menerus dan 
berkelanjutan. Untuk membe-
rikan perhatian, tanggapan, 
dan ingatan seseorang terha-
dap produk/jasa maka di-
perlukan promosi / mengko-
munikasikan terhadap produk/ 
jasa.

Biaya, merupakan jantung 
akan terwujudnya suatu media 
komunikasi. Dalam mewujud-
kan media komunikasi ten-
tunya diperlukan biaya, baik 

XVI. DESIGN: APLIKASINYA
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pra produksi, proses produksi, 
dan paska produksi. 

3) Memilih  jenis media dan 
sasarannya 

Pemilihan jenis media komuni-
kasi ditentukan beberapa hal, 
antara lain; biaya, segmen, 
sasaran, kebutuhan, dan se-
bagainya. Iklan yang dipu-
blikasikan di koran, majalah, 
tabloit, maupun di luar ruang, 
atau media lain seperti poster, 
leaflet, booklet, katalog, yang 
kesemuanya itu tentunya 
mempunyai program dan tu-
juan producen dalam memilih 
media.

Perusahaan/produsen dalam 
menggunakan satu jenis me-
dia yang diyakininya masya-
rakat bisa konsentrasi penuh 
pada satu media yang ber-
dampak khusus. Di sisi lain 
perusahaan/produsen mem-
promosikan/mengkomunikasik
an rodak/jasanya mengguna-
kan beberapa media agar 
teriakan sering terdengar dan 
cepat lebih ingat terhadap 
yang dikomunikasikan. 

A. Mempersiapkan tempat, 
bahan dan peralatan ker-
ja desain 

Dalam mendesain media ce-
tak diperlukan tempat yang 
mewadai, seperti ruang yang 
bersih, santai, tenang agar 
lebih leluasa dalam menger-
jakan desain.  

Adapun bahan dan peralatan 
yang dibutuhkan dalam mem-
buat desain adalah: 

 Kamera fotografi (SLR/ 
digital)

Merupakan alat untuk memo-
tret obyek yang akan digu-
nakan sebagai ilustrasi dalam 
desain media cetak. Caranya 
hasil bidikan dalam kamera di 
transfer ke komputer, yang 
selanjutnya diolah menjadi 
desain.

 Scanner 
Alat yang dipakai untuk mem-
baca dokumen yang tertulis/ 
tergambar pada sebuah ker-
tas, dengan cara melewatkan 
pendeteksi image pada kertas 
tersebut. Alat ini merupakan 
alat optis yang dapat meng-
konversikan citra seperti foto 
ke dalam bentuk digital supaya 
dapat disimpan atau diubah di 
komputer.

 Komputer (softwear Corel 
Draw, dan Photoshop)

merupakan perangkat elektro-
nik yang dapat dipakai untuk 
mengolah data dengan peran-
taraan sebuah program dan 
mampu memberikan informasi 
dan pengolahan tersebut. 
Jenis alat ini merupakan 
prasarana untuk mempercepat 
proses desain. Pengerjaan 
melalui alat inilah yang di-
katakan proses mendesain 
atau produksi hingga desain 
komprehenship.
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 Printer 
Merupakan perangkat output 
yang bekerja sebagai pen-
cetak. Sebuah printer menge-
luarkan data yang terlihat pada 
layer komputer pada selembar 
kertas. Adanya alat ini, karya 
desain akan terlihat seperti 
aslinya.

 Kertas 
Merupakan bahan untuk men-
cetak. Jenis kertas yang 
dibutuhkan antara lain, kertas 
HVS 80 gram, inkjet paper 105 
gsm, dan premium inkjet 
glossy paper 150 g. 

B. Pembuatan Corporate 
Identity 

1. Icon, Graphic System & 
Piktograf

Ikon dan Graphic System 
adalah tanda yang didasarkan 
atas “keserupaan” atau “kemi-
ripan” berupa gambar-gambar 
figur sederhana yang mudah 
dipahami antara pengirim pe-
san dengan penerima pesan.  
Yang dimaksud kemiripan 
adalah masih melekatnya cirri 
khas meskipun sudah menga-
lami pengurangan atau peru-
bahan bentuk. 

Gambar 16.1: 
Sumber ide buah gandum 

Gambar 16.2:  
Pencarian alternatif desain  
melalui proses evolusi 

Gambar 16.3:  
Penyederhanaan bentuk perlu 
dilakukan asal tidak mengurangi bobot 
makna yang terkandung 
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Piktograf merupakan tanda 
berupa gambar sederhana 
yang sering kita jumpai di 
tempat-tempat tertentu. Seca-
ra psikologi, manusia lebih 
cepat mempelajari dan lebih 
lama mengingat sesuatu bila 
ditampilkan secara visual, se-
derhana, singkat, dan jelas. 
Piktograf termasuk media 
grafis komunikasi yang meme-
nuhi syarat didaktif, oleh 
karena itu piktograf secara 
langsung bisa berkomunikasi 
dengan audient. Suatu infor-
masi bila dikomunikasikan 
lelalui tulisan maupun sede-
retan angka tidak terlalu mena-
tik, jenuh, bahkan bosan. 
Maka munculah piktograf se-
bagai media yang bisa 
mewakili informasi melalui 
bahasa gambar, bahkan para 
ahli menciptakan piktograf
tingkat internasional, seperti 
tanda lalu-lintas, atau tanda 
yang dipasang di kamar kecil 
pria maupun wanita, dan 
sebagainya.

Bila penciptaan piktograf baru 
maka awalnya harus dileng-

kapi dengan bahasa verbal 
(tulisan) agar tidak ada kesa-
lahan persepsi dalam berko-
munikasi. Agar cepat lebih 
komunikatif, maka penggam-
baran dibuat sederhana 
mungkin.

Gambar 16.4:  
Alternatif desain kadang terpilih semuanya 

sebagai pijakan desain akhir 

Gambar 16.5: Berbagai bentuk piktograf
dengan warna kuning merupakan tanda 
perhatian atau hati-hati 

Gambar 16.6: Warna merah pada 
poktograf yang berarti larangan atau 
harap waspada 
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2. Tagline 
Tagline / slogan merupakan 
baris kalimat penutup yang 
digunakan sebagai alat untuk 
mengungatkan atau mencip-
takan citra merek atau peru-
sahaan. Tagline/slogan dicip-
takan sebagai bagian dari 
kampanye identitas produk 
atau perusahaan. Ada bebe-
rapa yang harus diperhatikan 
dalam membuat tagline/ slo-
gan, antara lain: 

 Kata-kata yang dibuat ha-
rus bersifat menjual ter-
hadap produk/perusahaan. 

 Kata-kata yang dibuat 
harus mudah dipahami 
oleh pembaca. 

 Kata-kata yang dibuat ha-
rus menyegarkan, misal-
nya: ”sekarang juga, me-
ngapa harus besuk”. 

 Kata-kata yang digunakan 
harus menarik perhatian, 
misalnya ”beli satu dapat 
dua”

 Kata-kata yang digunakan 
harus membangun image 
positif, misalnya ”kemana-
pun anda pergi, kami sela-
lu menemanimu”. 

 Kata-kata yang digunakan 
harus singkat, padat, be-
risi, efektif dan efisien, 
agar pembaca mudah 
membaca, memahami, 
mudah diingat, dan mudah 
dihafal.

Contoh slogan yang telah 
terpilih untuk digayakan sesuai 
dengan isi dan maksud slogan 
tersebut agar lebih melekat 
dan mengena. 

3. Logo: Logotype, Logo-
gram

Logo adalah lambang atau 
tanda dari sebuah perusa-
haan/lembaga. Adanya logo, 
preusan / lembaga bisa lebih 
berwibawa dan terpercaya. 
Dalam pembuatan logotype 
(logo yang bentukkan ke 
huruf) dan logogram (logo 
yang mengarah ke simbol) 
bisa dibuat dengan manual 
atau dengan komputer, Namur 
tetap hasil akhirnya menggu-
nakan dengan teknik komputer 
agar lebih rapi dan bagus. 

a. Teknik Manual 
Tidak harus dengan teknologi 
teinggi, manualpun juga bisa 
berekspresi melalui goresan 
tangan

Gambar 16.7:  
Pemilihan jenis tipografi sangat 
menentukan untuk mendukung 

maksud slogan 
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b. Teknik Komputer 
Melalu teknologi komputer, 
seorang desainer atau praktisi 
lebih mudah dan cepat me-
rancang sebuah logo dalam 
waktu singkat. 

Gambar 16.8:  
Proses penggalian ide secara visual

Gambar 16.9 a,b,c: 
Deain terpilih barulah diwarna 

dengan spidol/pewarna 

Gambar 16.10:  
Bagaimana mengaplikasikan logo 
ke dalam mobil dinas perusahaan 

Gambar 16.11:  
Desain komprehensif logo yang 
diterapkan ke mobil dinas perusahann 
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Grid Standart Manual (GSM) 
merupakan keharusan dalam 
membuat logo, karena dengan 
adanya GSM akan lebih 
mempermudah dalam menga-
plikasikan dalam media atau 
tempat lain sesuai skala yang 
ada. Disamping GSM, ukuran 
kadar warna  CMYK harus 
ditampilkan pula, agar lebih 
mudah pembuatannya atau 
sama warnanya.  

Ukuran warna ini sering 
digunakan untuk identitas 
perusahaan / lembaga, atau 
kemasan produk. Bila ukuran 
warna ini bisa dijaga kesa-
maannya, maka kebibawaan 
lembaga akan tetap terjaga. 

Gambar 16.12:  
GSM pada logo atau Trade amark 
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1) Alternatif Logo 

Alternatif logo selalu diguat 
agar desain lebih kaya secara 
visual maupun verbal. Adanya 
alternatif desain logo meru-
pakan media komunikasi me-
lalui bahasa visual pada waktu 
desainer presentasi dihadap-
an pemesan karya. Intinya, 
dengan adanya alternatif de-
sain logo akan memudahkan 
kita mengembangkan yang 
lebih baik dan mengena 
sasaran

2) Logo Terpilih 

Logo terpilih merupakan salah 
satunya yang terbaik untuk 
diterapkan ke berbagai media 
grafis komunikasi. Logo terpilih 
harus mudah dilihat, mudah 
komunikasi, mudah diterap-
kan, dan mudah di proses. 

4. Company Profile (Trade 
Mark/Brand)

Brand merupakan suatu alat 
merketing yang sangat kuat. 
Dalam situasi pasar modern 
saat ini, brand merupakan 
panduan bagi konsumen untuk 
mendapatkan barang atau 
jasa dengan karakter atau 
kualitas tertentu yang mereka 
harapkan. Hal ini sangat disa-
dari oleh perusahaan-perusa-
haan terkemuka, oleh karena 
itu membangun suatu brand 
merupakan tugas berat yang 
harus dilakukan.  

Salah satu hal penting dalam 
membangun brand adalah 
menentukan yang biasa dise-
but “Brang Architecture”, yaitu 
suatu strategi penyusunan 
brand yang menentukan 

Gambar 16.14: Alternatif logo 
memudahkan kita untuk memilih

yang terbaik 

Gambar 16.15:  
Desain Logo terbaik untuk bisa 
diterapkan ke media grafis 
komunikasi

Gambar 16.13:  
CMYK merupakan usuran  
kadar warna suatu  
lembaga/produk 
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hubungan antar brand dalam 
suatu perusahaan. Strategi ini 
sangat penting, karena sesu-
atu yang ditampilkan akan 
mempengaruhi konsumen da-
lam memandang dan memper-
sepsikan brand-brand yang 
ada dalam suatu perusahaan 
sekaligus mempengaruhi kon-
sumen dalam membuat kepu-
tusan pembeli. 

Kadang orang tertarik untuk 
membeli bukan berawal dari 
harga, tetapi brand yang su-
dah diakui masyarakat. Bila 
brand sudah melekat di hati 
masyarakat, tentunya bagai-
manapun jenis produknya 
akan selalu menerima. 

Gambar 16.16: Berbagai merek yang beredar di pasaran 
telah menjalani perjalanan panjang diantara kompetitor 
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C. Penerapan 
1. Kemasan Produk 
Sebelum merancang kemasan 
produk sebaiknya harus me-
ngetahui, apa bahasa rupa 
dalam desain kemasan?. 

Bahasa rupa adalah bahasa 
visual, bahasa simbol yang 
diungkapkan melalui gambar, 
bentuk, warna, identitas peru-
sahaan, dan huruf.  

Grafis harus dapat mengan-
tarkan pesan yang ingin 
disampaikan oleh produsen 
melalui kemasan yang dicip-
takan, baik informasi menge-
nai isi maupun penjelasan 
cara pemakaian produk di 
dalam kemasan. Keberhasilan 
daya tarik kemasan ditentukan 
oleh estetik yang menjadi 
pertimbangan sejak pra 
desain, desain, dan paska 
desain.

Gambar 16.17: 
Sulitnya merancang merek agar bisa melekat dibenak konsumen 
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Pada dasarnya nilai estetik 
harus terkandung dalam ke-
serasian antara bentuk dan 
penataan grafis tanpa melu-
pakan kesan jenis, ciri, dan 
sifat barang yang diproduksi.  

Ada beberapa pertimbangan 
yang harus dipertimbangkan 
dalam merancang kemasan, 
yaitu; gambar/ilustrasi, bentuk, 
warna, identitas perusahaan, 
dan huruf. 

Gambar 16.18:  
Beberapa elemen yang mendukung dalam desain kemasan 
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Gambar 16.19:  
Alternatif warna dalam desain kemasan 
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Gambar 16.20:  
Penegasan warna tergantung dari rasa produk yang dikemas 
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Gambar 16.21:  
Harus mengetahui anatomi pecah desain 
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 Gambar/ilustrasi 

Fungsi utama darai gambar/ 
ilustrasi adalah untuk mengin-
formasikan visual tentang 
produk, sebagai pendukung 
teks, penekanan yang mem-
berikan kesan tertentu, atau 
sebagai penangkap mata 
untuk menarik calon pembeli. 
Gambar/ilustrasi dapat diung-
kapkan melalui gambar ta-
ngan, fotografi, maupun kom-
puter. Gambar/ilustrasi dengan 
teknik fotografi sering diguna-
kan untuk produk kemasan 
makanan yang menunjukkan 
adanya bahan dasar alami 
untuk merangsang selera dari 
produk tersebut.  

 Bentuk 

Strategi produsen dalam mem-
promosikan produknya bisa 
dibuat cara melalui tampilan 
bentuk kemasan. Kemasan 
yang eklusif akan mengun-
dang perhatian banyak orang, 
sekaligus memberi kesan 
produk elegan, eklusif, dan 
kesan mahal (meskipun pro-
duknya tidak mahal). Bila 
kemasannya menarik tentunya 
pembeli jarang/tidak akan 
membuang bungkus produk 
setelah dipakainya. Kemasan 
tadi bisa untuk tempat/wadah 
barang lain atau di seimpan 
sebagai barang hias dalam 
ruangan.

Gambar 16.22:  
Satu paket dummy  (contoh visual lengkap) kemasan 
berdasarkan aneka warna disesuaikan dengan rasa 
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 Warna  

Warna merupakan hal yang 
sangat penting dalam komu-
nikasi dengan konsumen. 
Warna dalam perencanaan 
grafis kemasan dapat dira-
sakan kegunaannya sebagai 
media komunikasi dan infor-
masi produk, seperti warna 
kuning menandakan warna 
produknya berwarna kuning, 
rasa jeruk, atau produk 
bervitamin C. Warna tidak saja 
ditampilkan sebagai dasar 
kemasan, tetapi juga sebagai 
pendukung komunikasi tam-
pilnya huruf.

Potensi warna dapat diterap-
kan dengan baik dalam 
perancangan kemasan. Se-
perti kekuatan warna dalamm 
pandangan segi psikologi, 
bahwa warna lebih dekat 
dengan hubungan kepada 
faktor emosi daripada bentuk., 
Sebuah warna dalam kemas-
an akan tampil lebih awal 
dibandingkan dengan bentuk 
kemasannya.

Bagaimana warna dalam 
huruf?. Bentuk huruf nama 
produk harus tampil utama, 
tidak terganggu oleh penam-
pilan warna-warna kontras 
yang menyilaukan, sebab 
warna kontras (keras) hanya 
dapat berteriak, tapi tidak 
menyampaikan pesan. Tek 
yang dicetak dengan warna 
kuning dasaran hitam akan 
sangat jelas terbaca, sebalik-
nya tulisan warna biru di 

dasaran warna merah akan 
bergerak memusingkan mata, 
dan warna kuning di atas 
warna dasar putih akan sulit 
terbaca dengan cepat.  

 Identitas perusahaan 

Identitas perusahaan atau 
identitas produk sangat poten-
si dalam membidik kepercaya-
an pembeli. Pembeli akan 
mencari produk yang telah 
habis tentunya akan mencari 
produk yang sama dari 
perusahaan yang sama pula. 
Kepercayaan akan tertanam 
dalam hati si pembeli karena 
ada nama produk yang telah 
memberi apa yang diharapkan 
konsumen, dan konsumen 
akan lebih percaya kalau 
identitas perusahaan lebih 
besar dan berwibawa. Bila ada 
produk baru, orang akan 
melihat identitas perusahaan 
yang mengeluarkan, dan bila 
pembeli sudah percaya 
terhadap perusahaannya tentu 
tanpa pikir panjang langsung 
mempercayai produk tersebut 
dan membelinya. 

 Huruf 

Pemilihan tipe huruf yang 
berkarakter sesuai dengan 
jenis barang/produk, harus 
jelas, singkat, benar, mudah 
terbaca, dan menyatu dengan 
elemen grafis yang lain. 
Pemilihan tipe huruf yang 
sederhana akan lebih 
menguntungkan dari pema-
kaian huruf yang dekoratif. 



Desain Grafis Komunikasi 392

Memperhitungkan tinggi dan 
tebal huruf yang seimbang dan 
pengaturan jarak spasi antar 
huruf akan mengkomunika-
sikan pesan lebih mudah 
terbaca. Pemakaian teks, 
gunakan kata-kata yang tidak 
terlalu panjang, tidak berarti 
ganda, tidak menyembunyikan 
sesuatu, mudah dimengerti 
dan dipahami, karena konsu-
men selalu mencari produk 
yang praktis dan bermanfaat 
baru kemudian mempertim-
bangkan soal harga.  

a. Merancang Produk Mi-
numan

Merancang produk minuman, 
setidaknya harus mengetahui 
jenis minuman, rasa minuman, 
bahan pembuatan minuman, 
untuk siapa, dan dari peru-
sahaan mana. Semua data ini 
sangat membantu dalam ter-
ciptanya kemasan produk 
minumam, khususnya dalam 
menampilkan jenis warna, je-
nis tipografi. 

Gambar 16.23:  
Merek lokal rasa global pada sebuah minuman 



Desain Grafis Komunikasi 393

Gambar 16.24:  
Elemen pendukung dalam desain kemadan produk minuman 
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Gambar 16.26: 
Alternatif desain dalam bentuk tiga 
dimensi sebuah produk minuman 

Gambar 16.25: Alternatif desain 
berdasarkan rasa dan warna 

sebuah produk minuman 

Gambar 16.27: 
Skala desain kemasan 

sebuah produk minuman 

Gambar 16.28: Dummy desain kemasan  
sebuah produk minuman 
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b. Merancang Produk ma-
kanan

Perancangan produk makan-
an hampier sama dengan 
produk minuman, yang mem-
berdakan hanyalah dari segi 
isi produk. Untuk produk 
makanan, bagaimana calon 
pembeli terpengaruh terhadap 
yang dikomunikasikan melalui 
kemasan, seperti gambar 
ilustrasi yang sama dengan isi 
kemasan, warna mengarah ke 
rasa, serta komposisi unsur 
yang lain. 

c.   Memelihara  tempat,  ba -
han, dan alat desain 
kemasan

 Bersihkan ruangan dari 
aneka kertas yang tidak 
dipakai serta kotoran yang 
mengganggu pandangan, 
serta kesehatan.  

 Rapikan kembali antara 
kertas yang telah dipakai 
dengan kertas yang belum 
dipakai. Bila perlu simpan 
pada tempat tertentu yang

Gambar 16.29: Elemen pendukung estetika 
merupakan cara memperindah tampilnya 

sebuah kemasan

Gambar 16.30: Gambar ilustrasi merupakan  
penunjuk isi produk didalam kemasan 

Gambar 16.31:  
Layout pecah desain kemasan  
produk makanan ringan 

Gambar 16.32:  
Dummy desain kemasan  
sebuah produk makan ringan 



Desain Grafis Komunikasi 396

terhidar dari jangkauan 
anak-anak agar hasil kerja 
tidak diambilnya, atau me-
ngambil kertas cetak yang 
dianggap biasa untuk 
keperluannya.

 Simpan hasil printout 
desain kemasan yang 
berbentuk 3D (prototype) 
yang tidak terkena sinar 
matahari agar warna tidak 
pudar. Bila perlu laminating 
karya kemasan tersebut 
agar lebih lama warnanya, 
dan tidak mudah tergores 
oleh benda lain. 

 Komputer merupakan se-
bagai penyimpan file atau 
data, maka semua karya 
harus tersimpan rapi pada 
nama file tertentu agar 
mudah diingat dan mudah 
mencarinya.  

 Sebelum meninggalkan ru-
angan, pastikan peralatan 
komputer, scanner dan 
printer dalam keadaan 
mati, kabel tidak nyam-
bung dengan listrik. 

2. Media Masa 
Di masa Romawi kuno, pu-
blikasi informasi awalnya ha-
nya diciptakan untuk kalangan 
terbatas, yang dikirim dan 
dipasang di tempat-tempat 
umum hal-hal yang berkaitan 
dengan isu Negara dan berita 
local. Baru sekitar abad 17-18 
masmedia pertama kali diter-
bitkan di wilayah Eropa Barat, 
Inggris, dan Amerika Serikat. 

Media masa sering mendapat 
tantangan dan sensor dari 
penguasa setempat. Baru 
pada pertengahan abad 18 
ketika beberapa negara me-
ngesahkan undang-undang 
kebebasan pers. 

Di Indonesia tahun 1910 telah 
terbit masmedia mingguan 
”Medan Priyayi” yang dibiayai 
dan dipimpin oleh orang 
pribumi. Dalam perkembang-
an selanjutnya, masmedia 
menjadi salah satu alat perju-
angan kemerdekaan bangsa 
Indonesia. Media masa sema-
kin menguat di akhir tahun 
1945 dengan terbitnya 
beberapa koran yang mem-
propagandakan kemerdekaan 
Indonesia, seperti ”Soeara 
Merdeka” dan ”Berita 
Indonesia”.

Di era 1990-an, penggunaan 
teknologi komputer yang 
dilengkapi modem, teknologi 
wireless, internet atau satelit 
sehingga mempermudah dan 
mempercepat pengiriman foto 

Gambar 16.33: Masmedia merupakan 
konsumsi berita bagai masyarakat  

yang membuthkan 
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dan teks secara jarak jauh. Di 
era munculnya jurnalistik 
multimedia ini, perusahaan-
perusahaan masmedia raksa-
sa sudah merambah keber-
bagai segmen pasar dan 
pembaca berita, tidak hanya 
bisnis media cetak, tetapi juga 
radio, televisi, internet dengan 
space iklan yang tak kalah 
luasnya.

a. Merancang Buku 
Beberapa hal yang harus 
dipersiapkan dalam meran-
cancang buku, adalah sebagai 
berikut:
1) Mempelajari naskah yang 

akan dikerjakan. 

Pertama kali kita menerima 
naskah yang sudah diada-
kannya penyuntingan, baik 
dari isi buku maupun dari segi 
bahasanya. Adanya catatan ini 
kita bisa mempelajari maksud/ 
tujuan penerbitan tersebut dan 
memperhatikan saran dari 
editor/redaksi.

2) Menyiapkan pola tata letak 
(layout).

Selanjutnya mementukan for-
mat (ukuran) buku, selanjutnya 
menentukan frame (bingkai) 
ruang cetaknya. Setelah itu 
buatkan bantuan garis hori-
zontal maupun vertical yang 
disebut irama tata letak, 
selanjutnya meletakkan angka 
halaman. Ini semua sebagai 
pedoman untuk pedoman 
menata tata elemen-elemen 

layout yang berupa huruf, ilus-
trasi, maupun margin buku 
sebagai pertimbangan penji-
lidan.

3) Membuat visualisasi pe-
nyajian.

Ide penyajian wajah buku 
perlu divisualisasikan be-rupa 
layout komprehensif untuk 
memberikan wujud yang lebih 
nyata sebuah buku, baik 
sampul maupun bagian teks-
nya. Hal ini perting untuk 
menghindari keterlanjuran ke-
salahan sebelum naskah 
tersebut masuk di bagian 
produksi mulai pengesetan 
sampai ke penjilidan, sekaligus 
untuk menguji apakah sudah 
berfungsi sebagai sarana 
komunikasi. 

4) Menyiapkan gambar kerja 
(art work).

Gambar kerja (art work)
merupakan model yang akan 
dikerjakan sesuai dengan acu-
an cetak dan sesuai dengan 
keinginan desainer perwa-
jahan yang digambarkan pada 
layout komprehensif. 

5) Instruksi pelaksanaan de-
ngan tertulis 

Beberapa petunjuk tertulis 
akan menyertai visualisasi ran-
cangan. Maka diharapkan 
desainer bisa menyiapkan 
rancangan penyajian fisik buku 
dan bersama naskah rancang-
an yang selanjutnya di 
serahkan ke bagian produksi. 
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Instruksi yang harus diper-
hatikan antara lain: 

o Ukuran bersih barang ce-
tak.

o Jenis kertas. 
o Jenis huruf. 
o Jarak spasi huruf. 
o Lebar dan jenis su-sunan. 
o Jenis penjilidan 
o Instruksi ilustrasi. 

Keberhasilan penyampaian 
pesan/informasi dari penulis 
kepada pembaca antara lain 
ditentukan oleh kesempurna-
an penyajian sarana komuni-
kasinya. Dalam penyajian ini 
perlu adanya perencanaan 
perwajahan yang mengeks-
presikan secara visual dengan 
menampilkan huruf, ilustrasi, 
warna, dan tata letak sebaik-
baiknya. Mengapa kegiatan 
perwajahan diperlukan dalam 
penerbitan buku?. Banyaknya 
jenis barang terbitan menye-
babkan timbulnya persaingan 
untuk merebut hati calon 
pembaca yang bertindak se-
lektif terhadap barang cetakan 
(buku) yang akan dibacanya. 
Ciri-ciri buku adalah: 

o Berbentuk lembaran- lem-
baran cetak berformat le-
bar yang berisi berita atau 
cerita.

o Diterbitkan secara periodik 
dengan rentang waktu 
tertentu atau moment. 

o Komunikator media ini 
adalah lembaga, atau pe-
rusahaan.

o Audien utama media ini 
adalah para pelajar 

o Ada pembiayaan produksi 
dari sponsor atau iklan. 

Agar perwajahan buku me-
ngena pada sasaran, maka 
diperlukan persiapan-persiap-
an, antara lain; mempelajari 
naskah yang akan dikerjakan, 
menyiapkan pola tata letak, 
membuat visualisasi penyajian 
baik sampul maupun bagian 
teks, menyiapkan gambar 
kerja (art work), khususnya 
sampul, dan instruksi pelaksa-
naan dengan tertulis.

 Mempelajari naskah yang 
akan dikerjakan. 

Naskah buku yang diterima 
benar-benar sudah diadakan 
penyuntingan (editing), bila 
kita menerima naskah belum 
diedit, kerja perwajahan buku 
akan diualng beberapa kali 
sehingga memerlukan pembo-
rosan tenaga dan waktu. Lain 
halnya bila kita menerima 
naskah yang telah diedit, kita 
bila langsung bisa mempe-
lajari naskah, maksud/tujuan 
penerbitan, keinginan penulis 
atau editor, memikirkan gam-
bar/ilustrasi yang sesuai, dan 
bagaimana rancangan tata 
perwajahan yang akan diker-
jakan.

 Menyiapkan pola tata letak. 

Proses selanjutnya, adalah 
menentukan format (ukuran) 
buku serta menentukan frame 
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(bingkai) ruang cetak secara 
vertikal dan horisontal, dan 
yang terakhir adalah mele-
takkan posisi angka halaman. 
Pola tata letak inilah sebagai 
acuan untuk pedoman menata 
elemen-elemen lay-out baik 
berupa huruf, warna, dan 
gambar/ilustrasi.

 Membuat visualisasi penya-
jian, baik sampul maupun 
bagian teks. 

Untuk mengetahui sejauh ma-
na hasil visual wajah cover 
maupun tata perwajahan isi 
buku perlu divisualisasikan 
berupa layout komprehensif.  
Layout komprehensif merupa-
kan gambaran sebelum men-
jadi buku, yaitu color print out
sebagai contoh untuk presen-
tasi atau yang diberikan 
kepada pemesan atau editor 
untuk dikoreksi akhir yang 
dinantikan untuk dilanjutkan ke 
arah percetakan. Adanya 
layout ini memberikan gam-
baran lebih nyata bagaimana 
buku nantinya disajikan baik 
sampul maupun bagian teks-
nya. Proses ini perting, karena 
untuk menghindari kesalahan 
besar sebelum maskah dicetak 
hingga dijilid.  

 Menyiapkan gambar kerja 
(art work), khususnya sam-
pul.

Gambar kerja dibuat berda-
sarkan layout komprehensif 
yang sudah disetujui, yaitu 
merupakan suatu model yang 

akan dikerjakan selanjutnya 
dibagian acuan cetak, yaitu 
bagian reproduksi. Gambar 
kerja merupakan pembagian 
kelompok perencanaan grafis 
berdasarkan empat warna 
cetakan (sparasi), yaitu cyan,
magenta, yellow, dan black.

 Instruksi pelaksanaan de-
ngan tertulis. 

Proses ini merupakan proses 
terakhir sebelum buku dicetak, 
yaitu berupa catatan atau 
petunjuk tertulis tentang : 

o Ukuran bersih barang ce-
takan

o Jenis kertas 
o Jenis huruf dan ukurannya 
o Berapa kali cetak 
o Lebar susunan 
o Macam penjilitan 
o Instruksi/tanggapan 

terhadap ilustrasi 
o Dan petunjuk yang lain. 

1) Cover Buku 

Sampul buku merupakan pintu 
masuk, sebagai informasi isi 
buku, dan sebagai pelindung 
isi buku. Di samping itu, 
sampul buku juga berfungsi 
sebagai sarana komunikasi 
antara pengirim berita melalui 
berita kepada penerima yaitu 
calon pembaca.

Cover (sampul) buku meru-
pakan pintu masuk dan 
sebagai pelindung isi buku. 
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Ciri-ciri
o Ukuran kertas A4 (21 x 

29,7 cm/satu muka), dan 
A3 (A3 (29,7 x 42 cm/dua 
muka).

o Bagian muka terdiri dari; 
judul buku menggunakan 
huruf besar, dan tampilan 
gambar yang diminan se-
bagai pendukung judul 
buku.

o Warna diusahakan cerah 
untuk membangkitkan gai-
rah membaca. 

o Tertera penulis buku dan 
penerbit buku. 

o Bagian belakang berisi 
tentang deskripsi isi buku. 

Kelebihan
o Lebih komunikatif, karena 

pembaca tampa membuka 
isi buku sudah tahu isi 
buku, karena sudah bisa 
terlihat/terbaca pada cover
buku.

o Orang lebih cepat mencari 
masalah kelimuan yang 
dikehendaki, karena sudah 
tampak di judul buku. 

Kelemahan
o Sedikit membosankan, ka-

rena dalam sebuah buku 
hanya membahas satu ju-
dul atau tema saja. 

o Bila buku pengetahuan 
umum, pembaca tidah ter-
lalu percaya pada judul 
buku, namun harus melihat 
daftar isi buku. 

2) Tata Perwajahan Isi Buku 

Tata perwajahan buku sangat 
beda dengan tata perwajahan 
cover buku, perbedaannya 
terletak pada penempatannya, 
dan ilustrasinya. Tata letak 
perwajahan ilustrasi dangat 
tergantung dengan naskah bu-
ku, apakah buku Taman 
Kanak-kanak, Sekolah Dasar, 
Sekolah Menengah Pertama, 
Sekolah Menengah Atas, atau 
Perguruan Tinggi.

Jenis dan ukran huruf, spasi 
antar kalimat, gaya ilustrasi, 
maupun warna. Sebagai con-
toh untuk buku Sekolah Dasar, 
yang tampil sangat seria, 

Gambar 16.34: Sampul yang bagus 
akan menarik minat untuk membaca 

yang akhirnya membeli buku 
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ilustrasinya didekatkan pada 
karakter anak, warna cerah, 
tulisannya arial ukuran antara 
12 hingga 14, spasi satu. 

Ciri-ciri desain isi buku (me-
nata tata letak dan tipografi) 
o Ukuran kertas A4 (21 x 

29,7cm), B5 (18,2 x 25,7 
cm)

o Tampilnya judul bab dan 
sub bab buku. 

o Ada materi pelajaran/ ba-
hasan/cerita. 

o Tampilnya gambar (ilus-
trasi) sebagai pendukung 
cerita, dan sebagai pe-
ngatur komposisi bidang 
halaman.

o Sebagai penanda atau 
untuk mengingat batasan 
membaca, maka diperlu-
kan nomor halaman buku. 

Kelebihan
o Bila halaman buku ter-

desain dengan baik, maka 
dalam membaca tidak 
akan lesu. 

o Mempercantik halaman, 
agar tidak monoton. 

o Memberi kesan hidup, 
atraktif, dan wibawa terha-
dap buku tersebut. 

Kelemahan
o Bila ilustrasi lebih menonjol 

dan besar, akan mengaki-
batkan minimnya isi cerita 
yang dikemas. 

o Membosankan bila posisi 
gambar di tempat yang 
sama ditiap halaman.  

3) Membuat Dummy (peran-
cangan prototype buku) 

Ciri-ciri
o Buku sudah dirancang 

hingga cetak komprehen-
ship sebagai gambaran 
sejauh mana buku nan-
tinya akan jadi.

o Protopype ini merupakan 
contoh sementara yang 
bisa mewakili buku yang 
akan dicetak.  

o Dalam tampilannya sudah 
komplit, dari cover, isi 
buku, materi, dan sebagai-
nya dalam bentuk buku 
berwarna.

o Produk yang dihasilkan 
seperti buku yang sudah 
dicetak, berupa jilidan. 

Gambar 16.35: Layout halaman buku 
yang bagus akan meningkatkan daya 

baca tinggi terhadap siswa 
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Kelebihan
o Sudah bisa mengetahui, 

sejauhmana hasil produk 
yang akan dicetak. 

o Sudah mendekati penyele-
saikan, tinggal menunggu 
proses cetak. 

Kelemahan
o Bila tidak teliti, maka 

kerusakan/kesalahan baru 
akan terlihat setelah pro-
duk dicetak, maka akan 
rugi di bagian biaya pro-
duksi.

o Bila ada kesalahan, maka 
harus diperbaiki dari awal. 

b. Merancang Majalah 
Majalah adalah penerbitan 
pers berkala yang menggu-
nakan kertas sampul yang 
memuat berbagai tulisan yang 
dihiasi ilustrasi maupun foto-
foto. Perkembangan industri 
majalah di Indonesia menun-
jukkan pertumbuhan yang luar 
biasa sehingga bisa melayani 
kebutuhan pendidikan, kese-
hatan, hokum, ekonomi, hu-
kum, hingga hiburan kepada 
masyarakat berlatar belakang 
pendidikan dan kelas sosial 
yang berbeda.

o Berbentuk lembaran-lem-
baran cetak yang dijilid 
berbentuk seperti buku, 
berisi berita dan informasi 
secara tematik dan fokus.  

o Diterbitkan secara periodik 
dengan     rentang     waktu  

o tertentu, misalnya minggu-
an, dwi mingguan, bulan-
an, dan sebagainya. 

o Komunikator media ini 
adalah lembaga atau or-
ganisasi, dan perusahaan. 

o Audien utama media ini 
adalah khalayak banyak 
sesuai dengan tema yang 
diambil majalah. Misalnya, 
majalah Kartini yang dikon-
sumsikan pada kaum 
perempuan dewara, maja-
lah sepak bola, maka 
audience utamanya ada-
lah para penggemar sepak 
bola.

o Ada pembiayaan produksi 
dari sponsor atau iklan. 

Setiap majalah diterbitkan un-
tuk memenuhi berdasarkan 
tipe/target audien berdasarkan 
segmentasi, sehingga terwu-
judlah Jenis majalah, seperti: 

 Majalah konsumen 

Majalah konsumen diterbitkan 
guna memenuhi masyarakat 
yang butuh informasi ringan 
bersifat hiburan.  Majalah kon-
sumen yang dapat diklasi-
fikasikan ke dalam kategori ini, 
seperti majalah umum: Tem-
po, Gatra; majalah wanita: 
Kartini, Dewi, Femina; majalah 
pria: Matra, ME; majalah 
kesehatan: Senior, Higina; 
majalah olah raga: Bola, Adi-
raga; majalah wisata: Travel, 
Tamasya; dan sebagainya.  
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 Majalah bisnis 

Majalah bisnis diterbitkan 
untuk para pebisnis, masya-
rakat pekerja, sektor industri, 
atau masyarakat yang mem-
punyai jiwa bisnis. Majalah 
bisnis dirancang untuk men-
jangkau para professional 
yang    ingin    tahu     berbagai  

informasi yang relevan ten-
tang perusahaan, industri, pe-
masaran, perdagangan, peker-
jaan, produk, maupun karir 
yang ditekuni. Majalah yang 
termasuk kategori ini, seperti 
majalah Marketing, Cakram, 
dan sebagainya.

Gambar 16.36: 
 Berbagai majalah hiburan yang beredar di masyarakat 
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 Majalah Pertanian 

Majalah pertanian dirancang 
untuk memenuhi kebutuhan 
bagi masyarakt pembaca yang 
mempunyai minat dalam per-
tanian dan peternakan. Maja-
lah ini yang ditargetkan kepa-
da petani atau masyarakat 
peminat pertanian. Majalah 
yang termasuk kategori ini 
adalah; majalah Trubus, Agro-
bisnis dan sebagainya. 

 Majalah Komputer/internet 

Majalah yang ditargetkan ke-
pada masyarakat pengguna/ 
hoby komputer dan internet. 
Jenis majalah ini memberi-
takan tentang perkembangan 
komputer/internet bagi pem-
baca yang membutuhkannya. 
Majalah yang termasuk kelom-
pok ini adalah; PC Magazine, 
Chip, Computer easy, dan 
sebagainya.

Gambar 16.37: Majalah yang membidik  
masyarakat yang mempunyai jiwa bisnis 

Gambar 16.38: Majalah pertanian  
yang selalu ditunggu tentang  

masalah pertanian 

Gambar 16.39: Majalah komputer 
yang selalu dibutuhkan bagi 

pengemar teknologi komputer 
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3) Cover Majalah gambar 

Dalam merancang cover ma-
jalah, sebaiknya sebelumnya 
harus mengetahui segmen 
majalah yang akan di rancang, 
untuk siapa (pria atau wanita), 
umur berapa, membahas 
tentang apa, dan sebagainya. 
Data sedikit ini perlu untuk 
mengarahkan rancangan gra-
fis komunikasi yang akan 
dikerjakan.

4) Tata Perwajahan Majalah

Bagaimana majalah bisa enak 
dibaca, mudah dimengerti, 
mudah difahami, dan tidak 
menjenuhkan, maka perlu 
adanya tata perwajahan yang 
baik. Agar ini semua bisa 
tercapai adalah dengan cara 
mengatur layout, penegasan 
warna pada head line/sub 
head line, ilustrasi yang me-
ngena, serta komposisi dari 
berbagai untuk perwajahan 
halaman majalah. Disamping 
itu dalam merancang halaman 
majalah perlu memperhatikan 
karajter majalah tersebut, 
seperti jumlah kolom yang 
digunakan, serta pada rubrik 
apa naskah tersebut diter-
bitkan.

Gambar 16.41: Perlu model cover
girl untuk rancangan cover majalah 

Gambar 16.42 a,b,c,d: Alternatif warna 
dalam cover majalah remaja 

Gambar 16.40 a,b: Model yang biasa bila 
dikemas dengan sungguh-sungguh akan 

menghasilkan yang luar biasa 
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c. Merancang Koran

Koran mempunyai cici-ciri se-
bagai berikut: 
 Berbentuk lembaran-lem-

baran cetak berformat lebar 
yang berisi berita. 

 Diterbitkan secara periodik 
dengan rentang waktu yang 
umumnya terbit harian. 

 Komunikator media ini ada-
lah lembaga, atau perusa-
haan.

 Audience utama media ini 
adalah khalayak banyak 
untuk semua segmen 

 Ada pembiayaan produksi 
dari sponsor atau iklan. 

Gambar 16.43:  
Pembaca akan senang dan nyaman bila 

tata perwajahan majalah dibuat yang 
sebagus-bagusnya 

Gambar 16.44:  
Tata perwajahan dua halaman dalam majalah dengan penekanan 

 pada gambar yang ditampilkan 
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5) Cover Koran 

Koran, agar lebih menarik 
pada calon pembeli atau pem-
baca perlu di buat cover
(halaman depan) yang mena-
rik. Kepenarikan bisa ditem-
puh dengan jalan menonjolkan 
gambar, atau mempertegas 
judul (head line) yang penuh 
konotasi yang ditampilkan de-
ngan cara mempertebal huruf, 
atau warna ditampilkan yang 
menyolok di halaman depan. 

Gambar 16.45:  
Terbitnya berbagai jenis koran untuk memenuhi kebutuhan pelanggan  

di berbagai segmen 

Gambar 16.46:  
Alternatif tata

perwajahan  
(layout kasar)

cover koran 
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6) Tata Perwajahan Koran 

Bagaimana agar pembaca 
tidak jenuh dan pembaca bisa 
membaca sambil lalu. Kondisi 
inilah yang menciptakan layout
halaman Koran dibuat sejum-
lah kolom. Blok-blok sejumlah 
kolom inilah yang mengantar 
pembaca bisa membaca sam-
bil minum kopi.

Dalam perwajahan perlu ada-
nya perhtian serius khususnya 
dalam penempatan gambar 
dan head line, sub head line,
maupun body copy. Disamping 
itu rubrik atau menu dalam 
berita Koran tetap diperha-
tikan, yang ditampilkan pada 
halaman-halaman tertentu. 

Gambar 16.47:  
Layout komprehenship/dummy cover koran dan majalah 
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3. Merancang Media Lini 
Atas (Above The Line)

a. Mempersiapkan bahan, 
alat, dan desain 

Bahan dan peralatan yang 
dibutuhkan dalam membuat 
desain Media Lini Atas, 
adalah;
 Pensil dan pena, untuk 

membuat sket gambar 
(berwujut outline gambar). 

Scanner; Alat yang dipakai 
untuk membaca dokumen 
yang tertulis/tergambar pa-
da sebuah kertas, dengan 
cara melewatkan pende-
teksi image. Alat ini meru-
pakan alat optis yang 
dapat mengkonversikan ci-
tra seperti foto ke dalam 
bentuk digital supaya da-
pat disimpan atau diubah 
di komputer. 

Gambar 16.48: 
 Lay-out kasar dan komprehenship pada halaman koran  
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 Kamera fotografi (SLR/-
digital); merupakan alat 
untuk memotret obyek 
yang akan digunakan se-
bagai ilustrasi dalam de-
sain iklan. Caranya hasil 
bidikan dalam kamera di 
transfer ke komputer, yang 
selanjutnya diolah menjadi 
desain.

 Komputer (softwear Corel 
Draw, Photoshop); meru-
pakan perangkat elektronik 
yang dapat dipakai untuk 
mengolah data dengan 
perantaraan sebuah pro-
gram dan mampu membe-
rikan informasi dan pengo-
lahan tersebut. Jenis alat 
ini merupakan prasa-rana 
untuk mempercepat proses 
desain. Pengerjaan melalui 
alat inilah yang dikatakan 
proses mendesain atau 
produksi hingga desain 
komprehenship.
Printer; merupakan pe-
rangkat output yang be-
kerja sebagai pencetak. 
Sebuah printer mengeluar-
kan data yang terlihat pada 
layer komputer pada se-
lembar kertas. Adanya alat 
ini, karya desain akan 
terlihat seperti aslinya. 

 Kertas; merupakan bahan 
untuk mencetak. Jenis 
kertas yang dibutuhkan 
antara lain, kertas HVS 80 
gram, inkjet paper 105 
gsm, dan premium inkjet 
glossy paper 150 g. 

Jenis media komunikasi yang 
termasuk media lini atas 
adalah berbagai media yang 
diinformasikan dan komunika-
sikan melalui masmedia 
seperti surat kabar, televisi, 
radio, dan internet. Adapun 
jenis media grafis komunikasi 
(media cetak) adalah media 
yang dipasang atau dikomuni-
kasikan di melalui masmedia 
saja namun sifatnya sewa 
media (membayar pada pihak 
masmedia), yaitu Koran, ta-
bloid, majalah, dan buku. 
Media grafis komunikasi ini 
sifatnya sesaat, yaitu muncul 
pada waktu-waktu tertentu, 
sesuai permintaan pemesan 
atau sesuai perjanjian. 

b. Iklan Majalah 

Majalah merupakan sarana 
informasi dan promosi. Pada 
masmedia inilah seseorang/ 
masyarakat bisa mengiklan-
kan produk / jasa pada 
masmedia tertentu.  Di mas-
media biasanya sudah ada 
jenis dan tarip iklan yang akan 
dipasang untuk dikomunika-
sikan.

Ciri-ciri desain iklan majalah 
o Ukuran Iklan majalah (dis-

play) antara lain, satu 
halaman, setengah halam-
an, dan seperempat hala-
man majalah. 

o Iklan majalah (display)
merupakan iklan yang 
terdiri judul (headline) dan 
teks serta kombinasi foto 
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(gambar) atau tampilan 
viaual lainnya. 

o Secara visual, tampilan 
yang ditonjolkan adalah 
gambar berwarna, baru 
kearah judul (headline)
maupun body copy.

Kelebihan
o Jangkauan pasar secara 

selektif (khusus). 
o Berkualitas, karena dicetak 

di atas kertas yang berkua-
litas tinggi. 

o Memiliki kreatifitas yang 
tinggi dalam penyajian 
iklan.

o Memiliki daya hidup pesan-
nya lebih lama. 

o Memiliki keunggulan pres-
tise bila iklan diterbitkan 
pada majalah ternama. 

o Fleksibel dan dapat me-
nyesuaikan materi iklan 

o Mampu menyajikan pesan 
secara terperinci 

o Mudah dibawa kemana-
mana.

Kelemahan
o Penerbitan di majalah me-

merlukan biaya yang tidak 
sedikit.

o Jangkauan dan frekuensi 
terbatas.

o Proses pemuatan iklan 
membutuhkan waktu yang 
relative lama. 

o Makin banyak persaingan 
iklan bila majalah terkenal. 

o Hanya orang-orang terten-
tu yang membeli majalah. 

Berdasarkan ukurannya dan 
penempatannya, iklan majalah 
bisa dikelompokkan menjadi 
beberapa jenis, yaitu: 

 Iklan cover, yang ditam-
pilkan di depan bagian 
dalam, di belakang bagian 
luar, dan di belakang bagian 
dalam.

 Iklan dua halaman, biasanya 
ditengah-tengah. 

 Iklan satu halaman 
 Iklan setengah halaman 
 Iklan baris atau kolom 

Gambar 16.49:  
Rancangan iklan dua halaman majalah  
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c. Iklan Koran 

Koran merupakan masmedia 
yang murah untuk berkomu-
nikasi dengan masyarakat 
melalui iklan. Masmedia ini 
mempunyai keuntungan mau-
pun kekurangan dari berbagai 
segi.

Ciri-ciri desain iklan Koran 

o Ukuran Iklan Koran (di-
splay) antara lain, satu 
halaman, setengah halam-
an, dan seperempat ha-
laman sebuah koran. 

o Iklan Koran (display)
merupakan iklan yang 
terdiri judul (headline) dan 

Gambar 16.50: Iklan 
baris/kolom yang mengakar 

pada budaya daerah  

Gambar 16.51: Iklan layanan 
masyarakat sebesar satu halaman 

yang diterbitkan dalam majalah. 

Gambar 16.53: Iklan setengah 
halaman yang telah diterbitkan di 

salah satu media. 

Gambar 16.52: Iklan yang diterbitkan di 
cover depan bagian dalam. 
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teks serta kombinasi foto 
(gambar) atau tampilan 
viaual lainnya. 

o Secara visual, tampilan 
yang ditonjolkan adalah 
gambarnya, baru kearah 
judul (headline).

 Kelebihan 
o Jangkauan pasar cukup 

luas, khususnya di perko-
taan.

o Fleksibilitas, bisa ditulis 
sewaktu-waktu dan diter-
bitkan.

o Sikap penerimaan au-
dience lebih baik terhadar 
isi dan iklan yang disam-
paikan dalam surat kabar. 

o Surat kabar (koran) meru-
pakan media yang menye-
diakan segala macam 
ukuran untuk iklan, penem-
patan yang cepat, dan 
interest dari audience

o Pembaca secara umum 
menganggap surat kabar 
sebagai sumber informasi 
dan menggunakannya se-
bagai media untuk mempe-
ngaruhi masyarakat 

o Dapat menjangkau daerah 
lokal, regional ataupun 
nasional (jangkauan khala-
yak lebih luas) 

o Fleksibel dan dapat me-
nyesuaikan materi iklan 

o Mampu menyajikan pesan 
secara terperinci 

o Mudah dibawa kemana-
mana.

Kelemahan
o Kualitas cetak rendah ka-

rena menggunakan kertas 

koran, kertas paling ren-
dah.

o Harga pasang iklan mahal 
o Konsumsi pembaca dapat 

berubah
o Masa hidup yang singkat 

karena biasanya tidak 
akan bertahan di tangan 
pembaca yang enggan 
memperhatikan iklan. 

o Adanya persaingan iklan 
pada terbitan yang sama 
dalam satu Koran. 

Ciri-ciri desain iklan kolom 
o Iklan kolom lebarnya 

sesuai dengan lebar kolom 
Koran, sedangkan panjang 
disesuaikan dengan baris 
kalimat yang ditampilkan. 

o Secara umum terdiri kata-
kata (teks) dalam jumlah 
terbatas.

o Tampilannya terdiri dari 
judul (headline) dan teks 
yang dikombinasikan de-
ngan gambar. 

 Kelebihan 
o Jangkauan pasar cukup 

luas, khususnya di perko-
taan.

o Fleksibilitas, bisa ditulis 
sewaktu-waktu dan diter-
bitkan.

o Sikap penerimaan au-
dience lebih baik terhadar 
isi dan iklan yang disam-
paikan dalam surat kabar. 

o Surat kabar (koran) me-
rupakan media yang 
menyediakan segala ma-
cam ukuran untuk iklan, 
penempatan yang cepat, 
dan interest dari audience
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o Pembaca secara umum 
menganggap surat kabar 
sebagai sumber informasi 
dan menggunakannya se-
bagai media untuk mem-
pengaruhi masyarakat 

o Dapat menjangkau daerah 
lokal, regional ataupun na-
sional (jangkauan kha-
layak lebih luas) 

o Fleksibel dan dapat me-
nyesuaikan materi iklan 

o Mampu menyajikan pesan 
secara terperinci 

o Mudah dibawa kemana-
mana.

Kelemahan
o Kualitas cetak rendah ka-

rena menggunakan kertas 
koran, kertas paling ren-
dah.

o Harga pasang iklan mahal 
o Konsumsi pembaca dapat 

berubah
o Masa hidup yang singkat 

karena biasanya tidak 
akan bertahan di tangan 
pembaca yang enggan 
memperhatikan iklan. 

o Adanya persaingan iklan 
pada terbitan yang sama 
dalam satu Koran. 

Iklan yang dipasang dalam 
koran hampir sama dengan 
yang dipasang di majalah, 
hanya saja space-nya lebih 
luas dibanding dengan maja-
lah. Berdasarkan ukurannya 
dan penempatannya, iklan 
koran bisa dikelompokkan 
menjadi beberapa jenis, yaitu: 

 Iklan satu halaman 
 Iklan setengah halaman 
 Iklan seperempat halaman 
 Iklan kolom/baris 

c. Menyelesaikan pekerjaan, 
merawat bahan dan alat 

Sebagai praktisi desain yang 
handal dan bertanggung ja-
wab, maka perlu menye-
lesaikan tugasnya dengan 
baik, yaitu mendesain sampai 
desain terpilih hingga finishing 
siap terbit di media cetak. 
Setelah menyelesaikan peker-
jaan dengan lancar, tugas 
selanjutnya adalah merawat 
bahan dan alat.  
 Rapikan kembali antara 

kertas yang telah dipakai 
dengan kertas yang belum 
dipakai.

 Bila perlu simpan pada 
tempat tertentu yang 
terhidar dari jangkauan 
anak-anak.

Gambar 16.54: Iklan baris/kolom 
yang diterbitkan di koran  
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 Simpan hasil printout de-
sain iklan pada media 
cetak di tempat yang sejuk 
yang tidak terkena sinar 
matahari agar warna tidak 
pudar.

 Semua karya harus ter-
simpan rapi pada nama file 
tertentu agar mudah di-
ingat dan mudah menca-
rinya.

 Tinggalkan ruangan, pas-
tikan peralatan komputer, 
scanner dan printer dalam 
keadaan mati tertata rapi, 
serta kabel tidak nyam-
bung dengan listrik. 

4. Merancang Media Lini 
Bawah (Bellow The Line)

Dalam mendesain media cetak 
Lini Bawah diperlukan tempat 
yang mewadai, seperti ruang 
yang bersih, santai, tenang 
agar lebih leluasa dalam 
mengerjakan desain. Adapun 
bahan dan peralatan yang 
dibutuhkan dalam membuat 
desain adalah;
 Kamera fotografi (SLR / 

digital); merupakan alat 
untuk memotret obyek 
yang akan digunakan se-
bagai ilustrasi dalam desa-
in media promosi. Caranya 
hasil bidikan dalam kamera 
di transfer ke komputer, 
yang selanjutnya diolah 
menjadi desain. 

 Scanner; Alat yang dipakai 
untuk membaca dokumen 
yang tertulis / tergambar 
pada sebuah kertas, de-

ngan cara melewatkan 
pendeteksi image pada 
kertas tersebut. Alat ini 
merupakan alat optis yang 
dapat mengkonversikan ci-
tra seperti foto ke dalam 
bentuk digital supaya da-
pat disimpan atau diubah 
di komputer. 

 Komputer (softwear Corel 
Draw, dan Photoshop);
merupakan perangkat 
elektronik yang dapat 
dipakai untuk mengolah 
data dengan perantaraan 
sebuah program dan mam-
pu memberikan informasi 
dan pengolahan tersebut. 
Jenis alat ini merupakan 
prasarana untuk memper-
cepat proses desain. 
Pengerjaan melalui alat 
inilah yang dikatakan pro-
ses mendesain atau 
produksi hingga desain 
komprehenship.

 Printer; merupakan pe-
rangkat output yang 
bekerja sebagai pencetak. 
Sebuah printer menge-
luarkan data yang terlihat 
pada layer komputer pada 
selembar kertas. Adanya 
alat ini, karya desain akan 
terlihat seperti aslinya. 

 Kertas; merupakan bahan 
untuk mencetak. Jenis ker-
tas yang dibutuhkan antara 
lain, kertas HVS 80 gram, 
kertas duplek 300 g, kertas 
stiker, inkjet paper 105 
gsm, dan premium inkjet 
glossy paper 150 g. 
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a. Merancang Stasionery
Strasionery merupakan media 
yang terbuat dari kertas yang 
berhubungan dengan sarana 
atministrasi sekaligus sebagai 
alat komunikasi/promosi peru-
sahaan atau produk tertentu. 

1) Merancang Kartu Nama 

Kartu nama terbuat dari kertas 
atau sejenisnya berukuran 
sebesar kartu tanda penduduk 
(KTP)  yang mengkomunika-
sikan tentang identitas nama 
seseorang (si empunya), 
jabatan,  alamat kantor/peru-
sahaan, dan alamat rumah. 

Ciri-ciri desain kartu nama 
o Ukuran kecil 5,5 x 9 cm, 

agar bisa masuk di saku/ 
dompet

o Desain kebanyakan me-
ngarah ke horizontal 

o Tertulis alamat lengkap; 
rumah dan kantor atau 
perusahaan 

o Komunikatif mudah dibaca 
o Kadang ditampilkan gam-

bar atau ilustrasi yang 
menggoda

o Lembaga biasanya kearah 
desain yang formal 

o Perseorangan/probadi 
kearah desain yang 
informal

o Sebagai media untuk 
kenalan dengan orang lain 

Kelebihan
o Ukuran kecil sehingga 

mudah disimpan 
o Mudah dibawa kemanapun 
o Mudah dibagikan kepada 

orang lain 
o Biaya murah 

Kelemahan
o Ukuran kecil kadang sulit 

pencarinya
o Karena tulisannya kecil, 

sehingga orang tua sulit 
membaca.

Gambar 16.55: Antara kartu nama, memo, 
ketras surat dan amplop harus ada 
kesamaan tetapi mempunyai nafas 

laian/gaya tampilan lain  

Gambar 16.56: Alaternatif layout miniatur 
pada perancangan kartu nama  
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2) Merancang Amplop 

Kantong yang terbuat dari 
kertas berbentuk segi empat 
yang berfungsi sebagai tem-
pat surat yang akan dikirim ke 
tempat tujuan. Amplop dalam 

lembaga/perusahaan biasa di-
cantumkan logo perusahaan, 
nama perusahaan, dan alamat 
yang diatur berdasarkan kom-
posisi luasnya amplop. 

Ciri-ciri desain amplop 

o Ukuran amplop 11 x 23 cm 
o Kebanyakkan yang 

didesain di bagian depan 
o Desain kearah horizontal 

atau memanjang amplop 
o Penempatan desain di 

bagian atas amplop 
o Bidang yang dibutuhkan 

untuk desain seluas 
seperempat dari lebar 
amplop

o Informasi yang 
disampaikan, antara lain; 
logo,
produk/perusahaan/lemba
ga, dan alamat lengkap. 

o Desain sifatnya formal 

Kelebihan
o Sebagai tempat surat, 

sekaligus sebagai infor-
masi dan promosi peru-
sahaan/lembaga.

o Sangat mengena pada 
sasaran yang dikirim. 

o Sangat cepat untuk me-
ngetahui pengirimnya. 

o Bila surat tidak sampai ke 
tempat yang dituju, maka 
secara cepat akan meng-
hubungi alamat pengirim 
atau mengembalikannya. 

Kelemahan
o Bila tidak di arsipkan, 

maka alamat perusa-
haan/lembaga akan hilang 
dalam ingatan. 

Gambar 16.57: Alternatif lay-out  
komfrenhenship pada perancangan 

kartu nama

Gambar 16.58: Rancangan (desain) 
terpilih pada kartu nama  
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o Tidak semua orang me-
ngetahui informasi tentang 
perusahaan/lembaga.

3) Merancang Kertas/Kop 
Surat

Kop surat merupakan selem-
bar kertas berukuran folio, 
kuarto, atau A4 yang mencan-
tumkan logo perusahaan, 
nama perusahaan, dan alamat 
yang diatur berdasarkan 
komposisi luasnya kertas. 
Desain kop surat disamakan 
dengan amplop, karena kedua 
jenis media komunikasi ini 
adalah satu kesatuan. 

Ciri-ciri desain kop surat 
o Ukuran kertas A4 (21 x 

29,7cm), kuarto (21,5 x 
28cm), folio (21,5 x 33cm). 

o Tampilan desain harus 
sepadan dengan amplop 

o Bila formal, alamat ditem-
patkan di bagian atas, 

Gambar 16.59: Alaternatif layout miniatur
pada perancangan amplop  

Gambar 16.60: Alternatif layout  komfrenhenship 
pada perancangan amplop  

Gambar 16.61: Rancangan (desain) 
terpilih pada amplop  

Gambar 16.62: Rancangan (desain) amplop 
dan isi surat undangan formal suatu lembaga 
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sedang informal ditem-
patkan di bawah 

o Desain kearah horizontal 
atau kearah lebar kertas 

o Informasi yang disampai-
kan, antara lain; logo, 
produk/perusahaan/lemba
ga, dan alamat lengkap. 

Kelebihan
o Surat, sekaligus sebagai 

informasi dan promosi 
perusahaan/lembaga.

o Sangat mengena pada 
sasaran yang dikirim, mes-
kipun sifatnya rahasia. 

o Sangat cepat untuk me-
ngetahui pengirimnya. 

Kelemahan
o Bila tidak di arsipkan, 

maka alamat perusa-
haan/lembaga akan hilang 
dalam ingatan. 

o Tidak semua orang me-
ngetahui informasi tentang 
perusahaan/lembaga.

o Perusahaan/lembaga tidak 
mudah terbaca, karena 
terfokus pada isi surat. 

4) Merancang Map 

Map terbuat dari kertas yang 
dilipat berukuran dua kali lebih 
besar dari folio, sebagai 
tempat kertas atau surat. Map 
dalam perusahaan/lembaga 
secara khusus dirancang de-
ngan memperhatikan dalam 
segi promosi dan komunikasi, 
baik nama perusahaan/ lem-
baga, alamat, atau produk 
beserta kegunaannya. 

Ciri-ciri desain map 
o Ukuran map 36x25cm 

(satu muka), 36x50cm 
(dua muka) 

o Di bagian depan map 
merupakan desain pokok/ 
baku, sedangkan di bagian 
belakang sebagai desain 
pendukung. Gambar 16.63: Alaternatif layout miniatur 

pada perancangan kertas surat 

Gambar 16.64: Alternatif layout
komfrenhenship pada 

perancangan kertas surat 
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o logo,produk / perusahaan / 
lembaga, dan alamat ter-
tulis lengkap. 

o Adanya kesatian antara 
desain bagian depan de-
ngan bagian belakang 
map.

o Ilustrasi fotografi sering 
ditampilkan di bagian 
depan map agar membe-
rikan kesan mewah dan 
informasi yang efektif. 

Kelebihan
o Bisa disimpan lebih lama. 
o Bisa dipakai untuk doku-

men lain. 
o Tidak mudah hilang. 

Kelemahan
o Sering di simpang di 

tumpukan berkas lainnya, 
sehingga sulit di cari. 

o Merepotkan dalam mem-
bawa, kadang sulit dima-
sukkan ke dalam tas. 

5) Merancang Formulir 

Terbuat dari selembar kertas 
berukuran folio, kuarto, atau 
A4 yang menampilkan logo 
perusahaan, nama dan alamat 
perusahaan. Dalam kertas ini 
lebih mengutamakan daftar 
isian identitas pengisi. 

Ciri-ciri desain formulir 
o Ukuran kertas A4 (21 x 

29,7cm), kuarto (21,5 x 
28cm), folio (21,5 x 33cm). 

o Biasa wujudnya satu 
lembar, bisa satu muka 
maupun dua muka 

o Ada logo, produk/ peru-
sahaan/lembaga, dan ala-
mat pengirim yang jelas 

o Sifat berita sebagai infor-
masi pengiriman pesan 

o Berisi isian identitas 
audience secara rinci 

o Ada perintah penunjuk 
isian

o Ada tanda tangan pengisi 
(audience)

 Kelebihan 
o Informasi lebih nyata, kare-

na diisi oleh audience.
o Informasi berupa perta-

nyaan, sehingga audience 
bisa aktif mengikuti pe-
tunjuk pengisian. 

 Kelemahan 
o Banyak pertanyaannya, 

sehingga audience malas 
mengisi

o sian data harus dikemba-
likan pada pengirim, maka 
kadang audience enggan 
mengembalikannya

Gambar 16.65: Format data 
formulir harus lengkap dan jelas, 
karena untuk menjaring pengisi 
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6) Merancang Memo 

Memo terbuat dari kertas 
berukuran kecil yang fung-
sinya untuk memberikan infor-
masi pejabat kepada stafnya, 
atau dari seseorang kepada 
orang lain yang sifat-nya 
terbuka. Memo dirancang 
dengan ukuran kecil agar lebih 
praktis dan mudah dibawa 
agar cepat tersampaikan. 

Ciri-ciri desain memo 
o Ukuran kertas kurang lebih 

10 x 12 cm 
o Sifatnya surat pesan, 

dari/untuk sesama teman 
atau dari atasan ke 
bawahan dalam suatu 
perusahaan/lembaga

o Ada logo, produk/peru-
sahaan/lembaga, dan ala-
mat yang jelas biasa 
ditempatkan di sisi atas 
kertas

o Desain mengutamakan 
pengaturan bidang kosong 
sebagai tempat pengirim 
pesan.

Kelebihan
o Lebih praktis dan komu-

nikatif
o Tidak boros kertas, karena 

hanya membutuhkan ker-
tas kecil 

o Tidak ada rahasia terha-
dap yang dinformasikan. 

o Bisa dipergunakan siapa 
saja

Kelemahan
o Ukuran terlalu kecil, sulit 

diarsipkan dan sulit dicari. 

o Tidak bisa menulis dengan 
banyak kalimat, karena 
bidangnya kecil. 

o Sifatnya lebih terbuka, se-
hingga bila atasan menulis 
pesan, semua bida mem-
baca pesan tersebut.

b. Merancang Sticker
Sticker adalah sebuah mer-
chandise yang sangat umum 
digunakan. Biayanya murah 
untuk produksinya dan sering 
diminati. Sticker dipilih menjadi 
varian merchandise karena 
media stiker mampu men-
jangkau area yang  luas. 
Ruang penempatannya yang 
sangat fleksibel merupakan 
kelebihan sticker dalam 
menyampaikan pesannya. 
Karena stiker adalah media 
yang sangat umum dan 
banyak sekali ditemui, maka 
perancangan merchandise ini 

Gambar 16.66: Format data 
formulir harus lengkap dan jelas, 
karena untuk menjaring pengisi 
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perlu dipertimbangkan segi 
point of interestnya, supaya 
dapat menarik perhatian yang 
lebih baik daripada sticker-
sticker lain yang mungkin 
ditempatkan pada area yang  
sama . 

Ciri-ciri desain stiker 
o Huruf, gambar dan warna 

sangat menyolok. 
o Tampilan lebih diutamakan 

tulisan dari pada gambar. 
o Media komunikasi yang 

disampaikan dengan cara 
melekatkan di tempat ter-
tentu.

o Kalimat yang diinforma-
sikan sangat pendek agar 
mudah dibaca dengan 
cepat.

Kelebihan
o Biayanya murah dan mu-

dah memasangnya. 
o Bisa dibuat sauvener atau 

hadiah
o Pemasangan stiker tetap di 

tempat tidak akan berubah. 
o Bila pemasangan stiker 

dengan tepat akan me-
nambah keindahan benda 
yang dipasang stiker. 

Kelemahan
o Bila stiker sudah menem-

pel, sulit dicabut kembali. 
o Informasi yang disampai-

kan sangat singkat, 
sehingga memberi kesan 
membosankan. 

Gambar 16.67: Potongan sticker
yang mengikuti arah huruf RCTI, 

merupakan salah satu 
pendekatan estetika 

Gambar 16.68: Sticker cutting,
dan proses menempelkannya 
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c. Merancang Leaflet
Berwujud sehelai kertas dari 
bahan agak kaku yang mudah 
dilipat sebagai sarana untuk 
menginformasi dan mengko-
munikasikan produk/jasa. Da-
lam prakteknya bisa berupa 
sisipan dalam majalah 

Ciri-ciri desain leaflet 
o Desain leaflet terdiri dari 

dua muka (halaman), yang 
dirancang sesuai dengan 
bentuk lipatan kertas. 

o Informasi yang disampai-
kan singkat, padat, berisi. 

o Informasi yang disampai-
kan, antara lain; logo, 
produk/perusahaan/lemba
ga, alamat lengkap, dan 
program secara lengkap. 

o Gambar yang ditampilkan 
sesuai dengan berita yang 
diinformasikan.

o Tata letak gambar biasa 
diarahkan sebagai pengisi 
bidang untuk mengejar 
komposisi.

o Warna cerah agar 
pembaca lebih bergairah 
untuk membaca leaflet. 

Kelebihan
o Jenis media ini praktis, 

mudah dibawa, dan mudah 
disimpan. Bila sewaktu-
waktu dibutuhkan. 

o Sudah sering dilihat oleh 
masyarakat banyak, se-
hingga mempermudah pe-
nerimaan pesan pada 
target audience.

o Mudah penyebarannya da-
lam waktu yang sama 
sekaligus.  

o Mudah dibaca di manapun 
dalam waktu lama. 

o Mampu memuat informasi 
tentang perusahaan/lem-
baga lebih detail. 

 Kelemahan 
o Umurnya tidak tahan lama, 

apabila masyarakat kurang 
berminat maka leaflet ini 
akan dibuang begitu saja. 

o Bersifat statis sehingga 
mudah menimbulkan kebo-
sanan.

o Bila tampilan visual kurang 
menarik maka leaflet ha-
nya akan dibaca secara 
singkat dan memungkin-
kan untuk tidak dibaca 
kembali.

Gambar 16.69: Karya siswa SMK (dalam LKS), 
Lay-out dan informasi yang beda dalam lembar 

yang beda pula, depan-belakang dalam 
rancangan leaflet 
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d. Merancang Kartu Pos 
Kartu pos merupakan selem-
bar kertas yang berukuran 3 R 
atau 4R bermuka dua yang 
berisi isian berita sifatnya 
terbuka yang berfungsi untuk 
dikirim jarak jauh melalui pos. 

Kartu pos merupakan media 
pos yang paling sederhana 
yang dapat untuk mengirim 
pesan secara terbuka. Jenia 
media ini sangat praktis, 
murah, dan efektif yang dikirim 
ke berbagai pelosok negeri 
dengan bantuan pegawai pos. 

Ciri-ciri desain kartu pos 
o Ukuran kertas 10,5 x15,75 

cm 
o Kertas yang digunakan 

berukuran tebal dan kaku 
(300-400 gram) 

o Desain dibuat dua sisi, 
muka dan belakang 

o Bagian depan sebagai 
informasi berupa gambar 
dan alamat perusahaan/ 
lembaga

o Bagian belakang merupa-
kan tempat data pengirim 
kartu pos 

 Kelebihan 
o Ukuran kecil, sehingga 

mudah dibawa dan disim-
pan sebagai koleksi. 

o Praktis, bila mengirim kartu 
pos tanpa amplop 

o Pengirim kartu pos tidak 
perlu membuat kalimat 
yang panjang untuk meng-
informasikan kepada pene-
rima.

o Mudah dikirim ke penjuru 
wilayah.

 Kelemahan 
o Sifatnya terbuka, sehingga 

semua orang bisa mem-
baca pengirim kartu pos 

o Bila aka mengirim kartu 
pos, harus membeli prang-
ko sesuai jauh-dekatnya 
kota yang di tuju. 

o Jenis media ini bila 
desainnya tidak bagus 
tidak akan terbeli/terpakai 
karena kalah dengan 
teknologi HP (SMS). 

o Kadang tidak tepat waktu 
dalam pengirimannya. 

Gambar 16.70: Contoh lain rancangan  
leafle bagian muka 

Gambar 16.71: Contoh lain rancangan  
leaflet bagian belakang 
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e. Merancang Poster 
Selembar kertas yang dicetak 
berukuran besar berfungsi 
untuk mengumumkan atau 
mengkomunikasikan sesuatu 
yang dipasang di tempat 
umum. Poster adalah iklan 
warna berbentuk dasar yang 
dicetak pada selembar kertas 
dan ditempatkan pada panel, 
dinding atau kaca. Poster 
mempunyai ciri-ciri sebagai 
berikut:

 Berupa suatu lukisan/ 
gambar

 Menyampaikan suatu pe-
san, atau ide tertentu 

 Memberikan kesan yang 
luas terhadap yang diin-
formasikan

 Menangkap penglihatan 
dengan seksama terhadap 
orang-orang yang meli-
hatnya.

 Menarik dan memusatkan 
perhatian orang yang me-
lihatnya

 Menggunakan ide dan 
maksud melalui fakta yang 
tampak

 Merangsang orang yang 
melihat untuk mengikuti 
maksud poster 

 Berani, langsung, dinamis, 
dan menimbulkan kejutan 

 Ilustrasi tidak terlalu ba-
nyak, menarik, dan mudah 
dimengerti

 Teks ringkas, jelas dan 
bermakna

 Harus ada keseimbangan 
antara elemen satu de-
ngan lainnya 

 Dapat mudah dibaca da-
lam waktu singkat 

Poster merupakan media luar 
ruang yang digunakan untuk 
menjangkau semua lapisan 
masyarakat dan penontonnya 
tidak terbagi-bagi seperti 
masyarakat pada media lain. 
Alasan pemilihan media ini 
adalah sebagai berikut. 

Kelebihan
o Area penyampaian yang 

cukup luas 
o Biaya yang dikeluarkan 

relatif lebih murah 
o Bila memungkinkan dapat 

diproduksi dengan jumlah 
yang sangat banyak 

Gambar 16.72:  
Contoh rancangan kartu pos 
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sehingga area penyebaran 
menjadi lebih luas lagi 

o Dapat ditampilkan dalam 
berbagai event seperti pa-
meran produk, laun-ching 
bahkan dapat pula menjadi 
souvenir, ataupun door-
prize bila memungkinkan. 

o Unsur warna dan gambar 
yang lebih dominan dapat 
menarik perhatian audi-
ence

o Berisi pesan singkat, 
sehingga memudahkan au-
dience untuk mengetahui 
isi pesan 

o Mudah untuk dipasang dan 
ditempel

o Bisa terpasang di mana-
mana

o Fleksibel secara geografis. 

Kelemahan
o Jangkauan target au-

dience yang sangat kecil 
pada titik pemasangan 
tertentu saja 

o Biaya yang berlebihan 
menyebabkan pengaliran 
dana yang sia-sia ( bila 
diproduksi dengan jumlah 
banyak)

o Umur poster sangat pen-
dek karena materialnya 
yang biasanya mudah 
robek, kecuali bila penem-
patan deprogram pada titik 
tertentu.

o Poster untuk buletin 
interaktif  “Brainstorming”
memerlukan peremajaan 
setelah diterbitkannya edisi  
baru. Edisi lama akan 
mnjadi tidak relevan untuk 

di pasang bila telah terbit 
edisi selanjutnya. 

o Penempatan yang tidak 
teratur dan sembarangan 
akan dapat merusak kein-
dahan fasilitas umum. 

o Watu di pasang (temple) 
tingkat kerusakannya lebih 
besar

o Dianggap mengotori masa-
lah lingkungan  

o Pembaca kurangnya kon-
sentrasi memperhatikan 
poster karena melihat 
sambil lalu. 

Gambar 16.73:  
Contoh rancangan poster  

posisi vertikal 
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Ciri-ciri desain billboard 
(baliho)
o Ukuran besar, dengan 

bandingan 2:3 
o Warna kontras, agar lebih 

mudah terbaca. 
o Huruf dan ilustrasi beru-

kuran besar, agar mudah 
dilihat dan dibaca sambil 
berjalan.

o Dipasang di pertigaan atau 
perempatan jalan. 

Kelebihan
o Informasi yang disampai-

kan singkat dan jelas  
o Komunikasi dapat men-

jangkau daerah lokal. 

o Tepat sasaran bagi 
masyarakat yang lewat di 
depan billboard (baliho), 
karena langsung bisa 
membaca suatu yang 
diinformasikan.

Kelemahan
o Perubahan cuaca yang 

sering terjadi akan menye-
babkan kerusakan pada 
billboard (baliho) karena 
letaknya yang diluar 
ruangan (out door)

o Apabila penempatan bill-
board (baliho) berada di 
pinggir jalan raya akan 
mempunyai resiko untuk 
dilewatkan atau tidak 
sengaja terlewatkan oleh 
pengendara dengan kece-
patan tinggi. 

o Memerlukan tempat yang 
luas dalam pemasangan-
nya.

Ciri-ciri Spanduk 
o Ukuran 90/100 x 800 cm 
o Kalimatnya pendek, tulis-

annya besar. 
o Warna menyolok atau 

kontras agar mudah di lihat 
dan dibaca. 

o Di tempatkan di perem-
patan jalan atau tempat 
yang strategis 

Kelebihan
o Proses pembuatan tidak 

terlalu rumit. 
o Jangkauan pemasangan 

sangat luas dan frekuensi 
tinggi.

o Mencakup semua target 
audience.

Gambar 16.74: Contoh serupa hanya saja 
dalam penempatan ke arah horisontal yang 

memberi kesan lain 

Gambar 16.75: Contoh alternatif poster 
Indonesian Idol
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o Penempatannya fleksibel 
secara geografis. 

o Mudah diingat sebelum 
membeli produk. 

o Bisa dilihat berulang-ulang 
oleh pengguna jalan. 

Kelemahan
o Kurang efektif, karena 

sebagian masyarakat yang 
lewat di depan spanduk. 

o Waktu pemasangan seca-
ra singkat. 

o Tidak bisa menampilkan 
informasi secara lengkap. 

o Bila frekuensinya terlalu 
tinggi, mengakibatkan ke-
bosanan pada target 
audience.

o Mengganggu keindahan 
lingkungan, bila terpasang 
tidak teratur. 

f. Merancang Kelender 
Poster

Kalender poster merupakan 
penggabungan poster dengan 
kalender. Peran utama adalah 
sebagai poster, namun dalam 
fungsinya tidak sekedar hias-
an ruang/kamar, tetapi juga 
berfungsi sebagai penunjuk 
waktu berupa kalender. Uku-
ranya sama dengan poster, 
yaitu kurang lebih A2. Jenis 
media ini sering dipakai toko-
toko yang ingin mempro-
mosikan nama toko dengan 
menggunakan poster kalen-
der, agar lebih praktis dan 
murah.

Ciri-ciri kalender poster 
o Fungsi utama jenis media 

ini, adalah tampilan desain 
yang diarahkan ke desain 
terapan penghias ruangan. 

o Gambar sangat ditonjolkan 
dan menarik, adapun 
angka penunjuk waktu 
(hari, tanggal, bulan, ta-
hun) merupakan elemen 
pendukung tambahan. 

o Penempatan gambar sela-
lu berukuran besar yang 
ditempatkan di tengah, sisi 
kiri, sisi kanan, atau di 
bagian atas. 

o Penunjuk waktu (hari, 
tanggal, bulan, tahun) 
ditempatkan di sela-sela 
tampilnya gambar yang 
dominant.

o Nama lembaga, gambar, 
serta penunjuk waktu (hari, 
tanggal, bulan, tahun) di 
tampilkan dalam satu 
lembar kalender poster. 

 Kelebihan 
o Ada rasa kebanggaan, 

sehingga audience ke-
pingin memasang di 
ruangnya.

o Sebagai media promosi 
yang murah yang mem-
punyai jangkauan hingga 
ke rumah-rumah. 

o Fungsi ganda, antara 
gambar sebagai penghias 
ruangan dan informasi 
waktu (hari, tanggal, bulan, 
tahun).

 Kelemahan 
o Umurnya pendek, maksi-

mal setahun. 
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o Kurang memfokus terha-
dap apa yang diinforma-
sikan.

o Penempatan pada ruang 
tertentu, sehingga tidak 
semua orang bisa melihat/ 
membacanya. 

g. Merancang Folder
Selembar bahan cetakan 
berukuran cukup besar, dalam 
penampilannya diperingkas 
dengan cara melipat folder 
(fold) menjadi dua seperti map 
buku atau dilipat menjadi 
beberapa halaman yang ter-
pisah tanpa dipotong agar 
mudah dibawa. 

h. Merancang Brosur 
Media cetak setebal sekitar 
enam halaman atau lebih yang 
didesain berwarna de-ngan 
foto-foto yang menarik berisi 
informasi produk atau kegiatan 
organisasi.

Gambar 16.76: Contoh rancangan 
posterkalender posisi vertikal 

Gambar 16.77: Contoh rancangan 
poster kalender posisi horisontal 

Gambar 16.78 a-h: Contoh rancangan 
blosur di bagian isi 
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i. Merancang Manual Book
Manual book terbuat dari 
kertas jilidan, yang gunanya 
untuk menulis, seperti buku 
tulis.

j. Merancang Katalog 
Berupa kumpulan kertas yang 
dijilid ukurannya sebesar saku 
maupun buku terlpon ter- 
gantung keperluannya yang 
berisi informasi secara detail 
tentang produk dari suatu 
perusahaan, baik gambar 
produknya maupun harganya, 
serta alamat penjualannya. 
Beda lagi kalau katalog untuk 
kegiatan pameran, yaitu berisi 
tentang visual gambar/lukisan, 
judul, konsep, ukuran, bahan 
pembuatan, nama seniman, 
bila perlu harga lukisan. 

Ciri-ciri adesain Katalog 
o Jenis media ini berupa 

beberapa lembaran kertas 
yang dijilid. 

o Lembar luar dibuat cover
yang menarik agar audi-
ence tertarik untuk 
membaca informasi yang 
disampaikan. 

o Cover sangat mengutama-
kan gambar lembaga atau 
produk.

o Katalog biasa menginfor-
masikan tentang profil 
lembaga.

Kelebihan
o Bisa dibaca dalam waktu 

lama.
o Bisa menginformasikan 

semua yang dikomunika-
sikan.

o Menarik dan praktis, se-
hingga bisa disimpan oleh 
pembaca.

Gambar 16.79 a,b: Contoh rancangan 
blosur di bagian depan dan belakang 

Gambar 16.80 a,b (di atas): Contoh 
rancangan manuali book, dari layout

kasar hingga rancangan 
konferenhenship, dan rancangan yang 
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o Pembaca bisa santai 
dalam membaca informasi-
kan yang disampaikan. 

o Bisa dibaca dimana-mana 
tanpa mengenal tempat 
dan waktu. 

Kelemahan
o Informasi yang disampai-

kan sangat banyak se-
hingga memberi kesan 
tebal.

o Begitu banyak informasi 
yang disampaikan sehing-
ga tidak semua terbaca. 

o Bila informasikan tidak 
sesuai dengan pembaca, 
maka catalog tidak akan 
dibaca atau diinformasikan 
pada orang lain. 

k. Merancang Kalender Din-
ding

Kalender dinding adalah me-
dia komunikasi yang terbuat 
dari kertas ukuran rata-rata 
A2. Dalam tampilannya, satu 

lembar kalender bisa digu-
nakan 1 bulan, 2 bulan, 3 
bulan, 4 bulan, 6 bulan, atau 1 
tahun. Secara visual, desain 
kelender dinding harus mem-
perhatikan untuk estetika 
ruang, yaitu kesesuaian 
kalender dipasang di ruang 
tamu atau kamar. Seni 
komunikatif, yaitu mudah 
dibaca waktu yang tertera, 
seperti nomor tanggalnya, hari, 
bulan, tahun, dan alamat 
penyampai pesan (lembaga). 

Ciri-ciri kalender dinding 
o Ukuran kertas A3 (29,7 x 

42 cm) dan A2 (59,5 x 84 
cm)

o Media yang sifatnya multi 
fungsi, antara media pro-
mosi, waktu (hari, tanggal, 
bulan, tahun), dan sebagai 
desain terapan (benda 
hias).

o Angka ditampilkan secara 
dominan, karena sering 
untuk dibaca. 

o Desain dibuat beberapa 
jenis kaleneder, yaitu satu 
bulanan, dua bulanan, tiga 
bulanan, empat bulanan, 
enam bulanan, dan dua 
belas bulanan. 

o Ilustrasi bisa memberi 
kesan eklusif. 

o Penonjolan komunikasi di-
arahkan pada nama lem-
baga.

 Kelebihan 
o Sebagai media promosi 

yang murah yang mem-
punyai jangkauan hingga 
ke rumah-rumah. 

Gambar 16.81: Contoh katalog 
pameran lukisan anak-anak tingkat 

Internasional
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o Bisa dipakai sebagai hia-
san dinding. 

o Dapat dilihat berulang-
ulang, karena kebutuhan 
pembaca untuk melihat 
waktu (tanggal). 

o Bila desainnya bagus, 
biasa disimpang sebagai 
koleksi

Kelemahan
o Membacanya sambil lalu, 

hanya membaca angka 
tanggal.

o Umurnya terbatas, maksi-
mal 1 tahun 

o Bila kalender terdiri dari 
beberapa lembar (dalam 
bulan), kadang malas un-
tuk membuka lembar beri-
kutnya (bulan yang baru). 

o Tidak semua orang bisa 
melihat/membacanya, 
karena penempatannya 
terbatas pada ruangan 
tertentu.

Gambar 16.82: Kalender bulan 
Januaru-Februari (Program 

Pasca Sarjana) 

Gambar 16.83: Kalender bulan 
Maret-April (Fakultas Ilmu 

Pendidikan)

Gambar 16.84: Kalender bulan 
Mei-Juni (Fakultas Sastra) 
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l. Merancang Kalender 
Meja

Kalender meja terbuat dari 
kertas ukuran kecil yang 
berfungsi sebagai media infor-
masi tentang waktu yang 
diletakkan di atas meja. 

Ciri-ciri kalender meja 
o Ukuran kurang-lebih 12 x 

22,5 cm. 
o Media yang sifatnya multi 

fungsi, antara media pro-
mosi, waktu (hari, tanggal, 
bulan, tahun), dan sebagai 
desain terapan (benda 
hias).

o Terdiri dari dua halaman, 
yaitu halaman gambar 
yang didampingi logo, 
produk/perusahaan/lemba
ga, serta alamat yang 

Gambar 16.87: Kalender bulan 
November-Desember (Fakultas 

teknik)

Gambar 16.85: Kalender bulan Juli-
Agustus (Fakultas Matematika dan Ilmu 

Pengetahuan Alam) 

Gambar 16.86: Kalender bulan 
September-Oktober (Fakultas Ekonomi) 
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jelas, dan halaman yang 
menonjolkan tentang wak-
tu (hari, tanggal, bulan, 
tahun).

o Biasa ditempatkan di meja 
kerja, khususnya di kantor. 

Kelebihan
o Sebagai penghias meja. 
o Bisa dilihat berulang-ulang, 

karena kebutuhan pemba-
ca untuk melihat waktu 
(tanggal).

o Bila desainnya bagus, 
biasa disimpang sebagai 
koleksi

Kelemahan
o Umurnya terbatas, maksi-

mal 1 tahun. 
o Tidak semua orang bisa 

melihat/membacanya, ka-
rena penempatannya ter-
batas pada ruangan 
tertentu.

m. Merancang Agenda 
Agenda adalah jilidan kertas 
yang tertuliskan kegiatan yang 
akan dijalankan. Dalam agen-
da terdapat data, seperti pada 
halaman depan tertulis nama, 
alamat, pekerjaan yang punya 
agenda, adapun di lembar 
berikutnya terdapat data hari, 
tanggal, tahun, dan kegiatan. 
Di agenda itu pula terdapat 
beberapa alamat hotel, depar-
temen, telpon penting, dan 
lain-lain.

n. Merancang Iklan 
Layanan Masyarakat 

Masa penjajah, Grafis yang 
divisualkan melalui media 
Poster pada masa penjajahan 
Jepang dan Belanda meru-
pakan cikal bakal berkem-
bangya karya Grafis yang 
sesungguhnya pada masa 
sekarang ini. Pada masa 
penjajahan Jepang, Grafis 
mendapat kesempatan untuk 

Gambar 16.88: Kalender meja berukuran 
sama sisi yang memberi kesan formal 

Gambar 16.89: Kalender meja mengarah 
horisontal yang memberi kesan tanang 
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berkembang sebatas kepen-
tingan politik. Pihak Jepang 
memanfaatkan seniman Indo-
nesia dilatih membuat media 
komunikasi untuk kepentingan 
sekutu. Pengalaman inilah 
dimanfaatkan oleh para seni-
man grafis untuk menyum-
bangkan tenaganya dalam 
membuat media propaganda. 
Secara visual grafis pada 
masa ini lebih mengutamakan 
segi informatif verbal yang 
ditampilkan pada tulisan (head
line/bodycopy).

Grafis pada waktu ini 
ditampilkan secara sederhana, 
karena belum adanya unsur 
teknologi sebagai pendukung 
terselesainya ilkan tersebut. 
Bila diperhatikan iklan yang 
mempunyai head line “Armada 
Nippon” dan bodycopy “Setia, 
kenang semangat-poesakaja 
teroes berjoeang sampai 
menang” sangat komunikatif, 
hanya saja unsur propaganda 
begitu melekat. Jepang sangat 
luar biasa mengambil hati 
bangsa Indonesia agar berpe-
rang melawan Belanda. 

Belanda pada masa itu juga 
mencoba mendekati bangsa 
Indonesia untuk perperang 
melawan Jepang. Mencoba 
membangkitkan kesadarannya 
agar tidak mau diajak kerja 
sama dengan pihak Jepang. 
Iklan yang dipublikasikan sa-
ngat keras memojokkan pihak 
Jepang.

Media Grafis  pertama, men-
coba penyadaran propa-ganda 
Belanda agar bangsa Indo-
nesia tidak dikuasai oleh 
Jepang. Jepang mempunyai 
beberapa cara untuk menda-
patkan bangsa Indonesia 
sebagaimana digambarkan 
“seekor cumi-cumi yang 
mempunyai beberapa kor”. 
Iklan kedua Belanda mencoba 
merebut hati bangsa Indo-
nesia untuk masuk menjadi 
angkatan laut.

Jaman kemerdekaan, meru-
pakan jaman kemandirian 
dalam membuat Grafis untuk 
mengusir Belanda. Karya 
Grafis sangat membantu 
pemerintah dalam membang-
kitkan semangat para peju-
ang, maupun dalam melawan 
propaganda Belanda yang re-
latif maju.  Perbedaan visi 
politik dan strategi yang digu-
nakan oleh kekuatan-kekuatan 
revolusi dalam menghadapi 
Belanda telah mempengaruhi 
seniman grafis dalam mengha-
silkan karyanya.  

Gambar 16.90: Media grafis buatan Belanda 
yang digunakan sebagi propaganda 
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Kebijakan resmi propaganda 
dari pemerintah tidak ada, 
sehingga para seniman grafis 
bebas menentukan sendiri 
bentuk maupun propaganda. 
Pemerintah menyediakan da-
na dan fasilitas bagi seniman 
grafis untuk berkarya, yang 
kebanyakan mendokumentasi 
kejadian/peristiwa pertempur-
an dengan membuat sketsa, 
cetak lubang, dan cetak sa-
ring. Semaraknya karya Grafis 
yang disebar ke berbagai 
penjuru membuat gusarnya 
pihak Belanda untuk membuat 
karya Grafis tandingan. Karya 
yang dibuat dengan goresan 
tangan para seniman grafis 
merupakan luapan emosional 
pada waktu itu. Masmedia 
Fikiran Ra’yat membuat karya 
Grafis: Moesoeh tidak menga-
moek?, Boeat keseriboe kali-
nja Boeng Karno berteriak: 
“Kaoem Marhaen bersatoelah 
!”.

Karya yang dibuat dengan 
cetak lubang, yaitu dengan 
cara melubangi kertas lalu 
disemprot dengan cat. Karya 
bergaya ini sangat dominan 
diwaktu itu. Salah satu contoh 
karya Grafis berupa poster 
“Kanti Legolilo, ra’jat njum-
bangke barang darbeke”. 
Poster tandingan dari pihak 
Belanda dengan tampilan 
halus yang dibuat dengan 
cetak saring, seperti karya 
Grafis “Keluarga, kampung 
dan halaman saudara jang 
binasa, karena kelalaian 
saudara jang membabi-buta !”.  

Di era 1970-an ketika biro 
grafis asing mulai berdtangan 
ke Indonesia. Generasi 
brikutnya, terbentuk era 1985 
yaitu munculnya generasi yang 
lebih muda, sehingga akhirnya Gambar 16.91: Poster persatuan untuk 

melawan penjajah 

Gambar 16.92: Kemarahan Belanda 
yang diwujudkan dalam sebuah poster 
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terjadi sebuah gelombang 
baru (new wafe) dalam bidang 
grafis. Masa periode ini 
Pemerintah dan swasta saling 
bergandengan tangan mema-
inkan peran utama dalam 
suatu kegiatan masalah 
ekonomi. Kuatnya peran pe-
merintah, sehingga mempe-
ngaruhi kedalaman pesan 
yang disampaikan ke-pada 
masyarakat, sehingga Grafis 
komunikasi  pada waktu itu 
lebih bersifat informatif. Secara 
visual sudah menggunakan 
teknologi fotografi untuk 
menghasilkan gambar yang 
bagus, namun secara verbal 
lebih bersifat menggurui, 
seperti tampilnya body copy
yang cenderung panjang.  

Karya Grafis yang pernah 
dibuat dibuat oleh Matari 
Advertising, yang diangkat dari 
karya pujangga asal Libanon 
Kahlil Gibran berjudul “On 
Children”. Iklan yang berjudul 
“Renungan Bagi Orang Tua” 
ini menjelaskan bahwa anak-
anak adalah individu yang 
memmiliki pendidrian sendiri. 
Merekalah anak panah yang 
harus melesat dari pangkuan 
busur orang tua untuk menuju 
masa depan. Hebohnya iklan 
ini dianggap berpihak dan 
mendorong aksi-aksi demon-
trasi mahasiswa yang marak 
tahun 1978. Oleh Presiden 
Soeharto, iklan ini dituduh 
riberal dan bersifat komunis 
yang akhir dipermasalahkan 
oleh Jaksa Agung Ali Said.  

Pada masa 1980-1990an, 
karya Grafis sudah  menerap-
kan pendekatan psikologis. 
Bahasa iklan mengikuti audi-
ence yang dituju agar lebih 
komunkatif. Nilai simbolisasi 
dan pencitraan semakin domi-
nan dalam tampilan iklan, 
karena didukung oleh per-
kembangan media maupun 
teknologi dalam penciptaan 
kreatif iklan. Pada masa ini 
tampilnya teks naskah (body
copy) mulai sedikit dikurangi, 
lebih cenderung pengutamaan 
gambar.

ILM masalah ling-kungan 
dengan slogan: “Bumi ini 
bukanlah warisan dari nenek 
moyang kita, malainkan 
pinjaman dari anakcucu kita”. Gambar 16.93: Iklan yang menjadi 

permasalahan hingga samap ke pengadilan 
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Grafis (iklan cetak) yang 
terpilih sebagai salah satu 
finalis Clio Award tahun 1980 
ini visualisasinya memperha-
tikan seorang bayi yang 
sedang menangis diantara 
tanah tandus dan pepohonan 
kering.

Karya Grafis yang dikampan-
yekan bersama Unicef yang 
sangat sukses tentang pro-
gram penghapusan polio di 
Indonesia melalui Program  
Pekan Imunisasi Nasional 
(PIN). Kampanye iklan yang 
dibintangi oleh Rano “si Doel” 
Karno dan Mandra sebagai 
model penyampai pesan. 
Program ini berlangsung dua 
tahun berturut-turut sukses 
dalam menghapus kemung-
kinan terjadinya polio. 

Pada masa 1990-an mulai 
masuknya teknologi komputer. 

Para desainer grafis sudah 
mulai meninggalkan ilustrasi, 
tipografi konvensional dan 
berani bereksperimen dengan 
manipulasi gambar. Dalam 
kondisi ini para praktisi dalam 
negeri sudah menggunakan 
peralatan yang sama digu-
nakan para praktisi luar negeri. 
Di ini dunia grafis Indonesia 
banyak terjebak dalam 
kesibukan sebuah pasar, 
karena sebagian besar para 
praktisi bekerja di biro-biro 
iklan atau media masa 
meskipun disisi ide mereka 
bebas memilih namun dalam 
ruang gerak berekspresi 
sangat terbatas. 

Ditahun 2000-an merupakan 
masa kejayaan berekspresi, 
baik dalam luapan emosi yang 
terpendam pada masa sebe-
lumnya, mapun pengaruh 
teknologi yang berkembang 
dengan pesat sehingga me-
mudahkan dan mempercepat 
untuk berkarya. ILM pada 
masa sebelumnya yang hanya 
berkeblat pada program 
memerintah, maka mada masa 
revormasi sudah berani 
mengkritik pemerintah. Pesan 
yang ditampilkan sudah berani 
keras dan memojokkan bagi 
yang dituju (audience). Para 
praktisi grafis sudah mulai 
berani berekspresi secara 
bebas penuh inifatif dikare-
nakan ada tuntutan lain, yaitu 
adanya ajang kompetisi tingkat 
Nasional, seperti Citra
Pariwara, Phinastika, Jawa

Gambar 16.94: Poster yang masuk finalis 
Clio Award tahun 1980 



Desain Grafis Komunikasi 439

Advertysing Festival, dan 
tingkat Asia Adfest di Thailand, 
maupun tingkat dunia di 
Amerika. Adanya tuntutan 
ajang festival ini para praktisi 
grafis sudah mencoba mengi-
kuti kualitas karya kompetisi. 

D. Final Design 
1.   Final dan konsep logo 

2. Final dan konsep desain 

   

 Konsep Visual 

Pada perancangan (desain) 
kemasan ini, background 
gambar yang digunakan ada-
lah gradasi warna yang dari 
warna terang ke warna yang 
semakin gelap yang berfungsi 
untuk menambah keindahan 
visual dari kemasannya. Selain 
itu pada desain kemasan ini 
juga ditampilkan adanya gam-
bar surabi yang berjajar jajar, 
untuk menjelaskan secara 
visual produk makanan yang 
ditawarkan

 Konsep Verbal 

Penggunaan gradasi warna 
yang dari warna terang ke 
warna yang semakin gelap 
mengartikan adanya kema-
tangan, kenikmatan yang 
lebih.

Seperti yang telah dijelaskan 
diatas bahwa sasaran kon-
sumen utama Surabi Imut 
Bandung adalah untuk usia 
remaja, untuk itu konsep 
desain yang diarancang untuk 
kemasannya juga diarahkan 
kepada usia remaja. Pada 
konsep desainnya sengaja 
dipilih warna – warna terang 
atau ceria yang mewakili jiwa 
keceriaan remaja sekaligus 
juga berfungsi sebagai peng-
identifikasian  rasa surabi itu 
sendiri. Selain itu juga 
diatampilkan ilustrasi gambar 
surabi berupa  trace, ini juga 
memberikan kesan visualisasi 
yang dapat menarik minat 

Gambar 16.96 a,b,c,d: Alternatif 
desain sesuai dengan konsep 

Gambar 16.95: Merek serabi imut 
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kalangan remaja untuk mem-
beli surabi ini. Sebab jika 
ilustrasi gambar seperti ini 
digunakan  dirasa lebih lucu, 
cocok untuk remaja dan 
memiliki kesan tidak kaku. 

3. Final dan konsep pecah 
lay-out kemasan 

 Konsep Visual 

Pada desain 2D bentuk 
kerangka kemasannya dibuat 
seperti gambar diatas ini 
dimaksudkan untuk memper-
mudah dalam proses kerja 

pembuatan kemasan. Ukuran 
kerangka kemasan diatas 
adalah berukuran 9 cm x 9 cm 
x 7.5 cm.

Konsep Verbal 

Dilihat dari ukurannya yang 
tidak begitu besar yaitu hanya 
cukup untuk dua buah surabi 
saja ini memang disesuaikan 
dengan kekuatan ekonomi dari 
segmen pasar yang dituju 
kalangan usia remaja  yaitu 
anak sekolah SMP hingga 
anak kuliahan dan sekaligus 
untuk menekan biaya produksi 
kemasan itu sendiri.  

4. Final dan konsep kemasan 

Kemasan redesign Surabi Imut 
bandung dibuat dengan ben-
tuk seperti gambar diatas 
dengan tujuan agar trade mark 
Surabi Imut Bandung ini dapat 
terbaca oleh konsumen jika 
dilihat dari sisi belakang 
ataupun dari sisi depan. 
Kemasan dengan bentuk 
seperti ini juga dapat saling 

Gambar 16.97: Pecah layout desain 
disesuaikan dengan anatomi kemasan 

Gambar 16.98: Dummy desain kemasan 
sesuai dengan karakter rasa 



Desain Grafis Komunikasi 441

ditumpuk antar tiap kemasan-
nya. Selain itu kemasan ini 
juga memiliki kemudahan 
dalam hal membuka tutup 
kemasan dan memiliki kemu-
dahan jika kemasan ini dibawa 
atau dijinjing.  

Keterangan kemasan : 

 Bahan  

Bahan yang digunakan pada 
kemasan aslinya adalah 
berupa plastik mika trans-
paran berbentuk kotak. Se-
dangkan bahan yang selan-
jutnya digunakan pada desain 
kemasan yang baru terbuat 
dari bahan kertas karton. Bila 
menggunakan kemasan dari 
bahan seperti karton memiliki 
nilai kepraktisan yaitu nantinya 
bila kemasannya sudah tidak 
dipakai kembali dapat didaur 
ulang.

 Ekonomi  

Jika dilihat dari segi ekono-
minya memang sedikit agak 
mahal bila menggunakan 
kertas karton daripada meng-
gunakan kotak plastik biasa. 
Sebenarnya kemasan dari 
bahn karton tidak mahal tetapi 
yang membuat mahal adalah 
proses pencetakan desain pa-
da kertas karton sehingga 
menjadikan kemasan dari ba-
han seperti ini terasa mahal. 
Namun dari segi kerapatan 
kemasan dan kebersihan ma-
kanannya, kemasan yang 
terbuat dari bahan ini jauh 

lebih baik. Selain itu peng-
gunaan kemasan dari bahan 
karton lebih kuat dan dapat 
melindungi makanan didalam-
nya bila kemasan itu saling 
ditumpuk dibandingkan de-
ngan penggunaan kemasan 
dari bahan plastik. Meskipun 
harganya masih relatif sedikit 
lebih mahal dibandingkan ba-
han dari plastik, namun dilihat 
dari ukuran tiap kemasannya 
yang tidak terlalu besar, 
pastinya tiap kemasan ini tidak 
membutuhkan bahan banyak 
untuk membuat tiap satu 
kemasannya, sehingga biaya 
bahan untuk membuat tiap 
satu kemasan dapat diimbangi 
oleh harga satuan tiap sura-
binya yang berkisar antara Rp. 
2500,- hingga Rp. 5000,-. 

 Promosi  

Media yang digunakan untuk 
promosi makanan ini hanyalah 
berupa kabar dari mulut ke 
mulut dan selebaran yang 
disebarkan di tiap sekolah. 
Sehingga mungkin diperlukan 
media promosi yang lebih 
besar dan bisa menarik minat 
masyarakat untuk membeli 
makanan ini misalnya ditam-
bahkan media promosi berupa 
spanduk di sepanjang jalan-
jalan raya yang banyak dile-
wati orang. Meskipun tujuan 
awal sasaran konsumennya 
adalah remaja, tapi tidak 
menutup kemungkinan orang 
dewasapun mencoba Surabi 
Imut Bandung ini.  
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E. Menyelesaikan 
pekerjaan, merawat ba-
han dan peralatan desain 

Karya desain media cetak 
harus bagus, rapi, bersih, 
menarik, komunikatif, dan se-
sua dengan fungsinya, serta 
sesuai dengan pemesan. Rapi 
dalam penataan (lay-out) se-
hingga dapat memberikan 
kesan serius dan sungguh-
sungguh dalam pengerja-
annya.

Bersih merupakan tampilan 
akhir sebuah karya, bila ada 
kotoran atau bercak tentu 
akan mengurangi kualitas 
karya, yang seakan-akan 
memberi kesan ceroboh, masa 
bodoh, dan tidak  professional. 
Menarik dalam segi penam-
pilan, baik piñataan, warna, 
ilustrasi (gambar) yang ditam-
pilkan.

Komunikatif dalam hal pesan 
yang disampaikan, baik gam-
bar, tulisan, maupun tata letak 
(lay-out). Setelah menyelesai-
kan pekerjaan dengan baik, 
tugas selanjutnya adalah 
merawat bahan dan alat, 
antara lain: 

o Rapikan kembali dan 
kelompokkan antara kertas 
yang telah dipakai dengan 
kertas yang belum dipakai 
secara tersendiri. Simpan 
di tempat yang tidak 
lembab, agar kertas tetap 
kering dan tidak lengket 
dengan kertas lain.  

o Simpan hasil printout de-
sain media cetak di dalam 
album khusus sebagai 
forto-folio yang nantinya 
bias digunakan untuk me-
lamar pekerjaan. 

o Buatlah file untuk desain 
media cetak ini agar seca-
ra cepat mudah mengingat 
dan mudah mencarinya.  

o Bila akan meninggalkan 
tempat, pastikan peralatan 
komputer, scanner dan 
printer dalam keadaan mati 
dan rapi, serta lepaskan 
kabel aliran listrik. 

F. Pendalaman 
Buatlah desain grafis yang 
mengambil ide dari budaya 
dan kesenian daerah saudara. 
Jenis karya desain grafis yang 
dimaksud, antara lain: 
1. Desain media cetak, me-

liputi kartu nama, amplop, 
kop surat, map, formulir, 
memo, dan kartu pos. 

2. Desain media promosi, 
yang terdiri dari stiker,
leaflet, baliho, poster, ka-
lender dinding, dan kalen-
der meja. 

3. Desain buku, meliputi co-
ver buku, desain isi buku, 
dan dummy.

4. Iklan media cetak, terdiri 
dari iklan kolom, iklan 
koran dan majalah. 

5. Desain kemasan hingga 
prototipe.
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A. Mempersiapkan tempat, 
bahan dan peralatan 
desain

Dalam mendesain media cetak 
diperlukan tempat yang me-
wadai, seperti ruang yang 
bersih, santai, tenang agar 
lebih leluasa dalam menger-
jakan desain. Adapun bahan 
dan peralatan yang dibutuhkan 
dalam membuat desain ada-
lah;
 Pensil dan pena 

Alat ini untuk membuat sket 
gambar (berwujut outline 
gambar).

Scanner
Alat ini merupakan alat yang 
dipakai untuk membaca doku-
men yang tertulis/tergambar 
pada sebuah kertas, dengan 
cara melewatkan pendeteksi 
image pada kertas tersebut. 
Alat ini merupakan alat optis 
yang dapat mengkonversikan 
citra seperti foto ke dalam 
bentuk digital supaya dapat 
disimpan atau diubah di kom-
puter.

 Kamera fotografi (SLR/ 
digital)

Alat ini merupakan alat untuk 
memotret obyek yang akan 
digunakan sebagai ilustrasi 
dalam desain buku. Caranya 
hasil bidikan dalam kamera di 
transfer ke komputer, yang 
selanjutnya diolah menjadi 
desain.

 Komputer (softwear Corel 
Draw, Photoshop);

Alat ini merupakan perangkat 
elektronik yang dapat dipakai 
untuk mengolah data dengan 
perantaraan sebuah program 
dan mampu memberikan infor-
masi dan pengolahan tersebut. 
Jenis alat ini merupakan 
prasarana untuk mempercepat 
proses desain. Pengerjaan 
melalui alat inilah yang 
dikatakan proses mendesain 
atau produksi hingga desain 
komprehenship.

 Printer 
Alat ini merupakan perangkat 
output yang bekerja sebagai 
pencetak. Sebuah printer 
mengeluarkan data yang 
terlihat pada layer komputer 
pada selembar kertas. Adanya 
alat ini, karya desain akan 
terlihat seperti aslinya. 

 Kertas 
Kertas merupakan bahan 
untuk mencetak. Jenis kertas 
yang dibutuhkan antara lain, 
kertas HVS 80 gram, inkjet 
paper 105 gsm, dan premium 
inkjet glossy paper 150 g. 

 Khusus dalam post design 
(paska/purna desain) grafis 
komunikasi. 

Dalam program ini merupakan 
tahapan penerbitan atau pe-
masangan media desain grafis 
sesuai kenyataan.

XVII. POST DESIGN
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Maka yang harus dipersiapkan 
post design ini adalah: 
o Bila desain grafis akan di 

pasang di jalan atau 
tempat strategis maka 
harus ijin tertulis ke Dinas 
Pendapatan Pemerintah 
Daerah.

o Bila media akan diterbitkan 
di surat kabar, maka harus 
menghubungi perusahaan/ 
perwakiltan penerbitan ter-
sebut.

o Perlunya biaya untuk pe-
masangan/penerbitan de-
sain grafis, maka semua 
biaya ini harus diberi-
tahukan kepada pemesan. 

B. Penerbitan Rancangan 
Grafis ke Masmedia 

Tugas desainer / praktisi se-
telah berproduksi adalah me-
nerbitkan atau memasang 
media  grafis  yang dubuatnya.

Menerapan cover ke masme-
dia harus sesuai dengan misi 
dan segmentasi pasar. Sewa 
media untuk mempromosikan 
produk/jasa berupa iklan me-
lalui penerbitan mas media 
koran, tabloid, majalah, dan 
buku merupakan bidikan me-
lalui segmen tententu. 

Gambar 17.1 (bawah):  
Cover masmedia 

harus melihat jenis majalah
dan segmen masmedia 
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Produk/jasa lokal yang dipa-
sarkan secara lokal (secara 
geografis), maka hanya dibu-
tuhkan iklan pada mas media 
terbitan lokal. Atau segmentasi 
berdasarkan faktor demo-
grafis, seperti produk kosmetik 
yang ditujukan pada usia 
remaja, maka iklan sebaiknya 
ditampilkan pada majalah 
Gadis yang sebagian besar 
dibaca oleh para remaja 
khususnya kaum hawa. Pro-
duk minuman penambah 
energi atau stamina yang 
sesuai diiklankan pada tabloid 
olah raga atau koran pada 
rubrik olah raga. 

Pemberitaan produk melalui 
iklan tersebut, harus benar-
benar di kontrol sesuai per-
mintaan, seperti diterbitkan di 
rublik apa, halaman berapa, 
ukurannya berapa, dan bera-
pa kali terbitan. Pengontrolan 
ini perlu karena bila hal ini 
tidak sesuai dengan permin-
taan maka bisa jadi kita (biro 
advertising) akan dikomplain 
klain (pemesan). 

Penerbitan iklan pada ma-
jalah, bisa dengan ukuran luas 
halaman, atau sesuai dengan 
jumlah kolom yang dipesan, 
sebagai contoh iklan di atas. 

C. Pemasangan Rancangan 
Grafis Media luar

Dalam merancang media 
grafis komunikasi media luar 
harus mengetahui jenis bahan 
yang akan dipakai, dimana 
media itu akan dipasang, dan 
teknik kontruksi dalam pema-
sangan media tersebut. Maka 
dari itu sebelum merancang 
media grafis sebaiknya harus 
mengetahui atau membidik 
tempat dimana media tersebut 
akan dipasang. 

Data yang diperlukan antara 
lain, bagaimana kondisi ling-
kungan, suasana lalu-lintas, 
berapa banyak orang yang 
lewat, berapa rata-rata kece-
patan kendaraan yang lewat di 
jalan tersebut. Data tersebut, 
adalah untuk mempercepat 
proses dalam berkarya. 

Gambar 17.2: 
Bagaimana sebuah iklan ditampilkan pada kolom sebuah majalah 
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Pemasangan rancangan grafis 
komunikasi di tempat strategis 
diperlukan biaya yang tidak 
sedikit karena harus menang-
gung pajak pemasangan. 
Maka dari itu paska produksi 
(post design) kadang biayanya 
lebih mahal dari pada biaya 
produksi. Biaya yang begitu 
besar ini tidak memutuskan 
semangat perusahaan dalam 
promosi produknya, karena 
dampaknya pada peningkatan 
penjualan produk.  

Gambar 17.3:  
Rancangan Grafis Media Luar (Billbroad/baliho)

Gambar 17.4 a,b: Aplikasi Grafis Media Luar (Billbroad/baliho)

Gambar 17.5: Rancangan Grafis Media Luar (Spanduk) 
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Gambar 17.6: Aplikasi Grafis Media Luar (Spanduk) 

Gambar 17.8: 
Aplikasi Grafis Media Luar (Poster) 

Gambar 17.7: 
Rancangan Grafis Media Luar  

(Poster)
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D. Menyelesaikan desain, 
merawat bahan dan 
peralatan

Tanggung jawab merupakan 
suatu keharusan seorang 
praktisi dalam menyelesaikan 
tugasnya desain, yaitu dari 
proses merancang hingga 
finishing siap cetak menjadi 
media promosi dan selan-
jutnya pada tahap akhir adalah 
penerbitan atau pemasangan 
media grafis komunikasi. 
Setelah menyelesaikan peker-
jaan dengan lancar, tugas 
selanjutnya adalah merawat 
bahan dan alat, pada waktu 
pemasangan dan pembong-
karan.

1. Waktu pemasangan 
o Menyimpan alat seperti 

palu, tang, obeng, dan 
sebainya.

o Menyimpan sisa bahan, 
seperti kawat, tali, paku, 
dan sebagainya. 

o Menyimpan sisa besi, kayu 
ditempat tertentu dan 
rapikan.

2. Waktu pembongkaran 
o Simpan hasil pembong-

karan (desain grafis yang 
telah terpasang) disimpan 
kembali bila di kemudian 
hari akan dipasang kem-
bali.

o Simpan, besi, kayu, bam-
bu, dan sejenisnya untuk 
memasang media grafis 
selanjutnya.

E. Pembahasan 
Coba saudara mengamati 
pihak Advertising pada waktu 
memasang dan membongkar. 
Bagaimana teknisnya, bila 
perlu tanyakan proses peri-
jinan pada Dinas Pendapatan 
Daerah atau perusahaan surat 
kabar.
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Budgeting merupakan praktik 
keuangan dan akuntansi untuk 
mengalokasikan dana dalam 
perusahaan dengan mem-
perkirakan semua biaya se-
cara rinci dalam membantu 
memenuhi tuntutan media 
promosi secara maksimal 
dengan biaya yang serendah-
rendahnya. 

 

A. Pra Desain/Produksi 
(Free Design) 

Pra produksi merupakan awal 
sebuah proses dalam mewu-
judkan media grafis komu-
nikasi. Pra produksi bisa 
dikatakan sebuah awal suk-
sesnya sebuah pekerjaan 
besar dalam mewujudkan 
impian dalam sebuah media 
grafis komunikasi. Sebagai 
contoh, salah satu perusaha-
an yang ingin produknya 
mempunyai merek yang 
mudah dikenal masyarakat, 
dan bagaimana mempromosi-
kannya.  

Langkah awal suatu biro jasa 
pembuat merek dan media 
grafis tentunya harus mem-
bedah produk tersebut, spe-
sifikasi produk, jenis produk, 
kelebihan produk, dan seba-
gainya. Proses inilah yang 
dikatakan proses pra produksi, 
yaitu pencarian data tentang 
suatu produk. 

 

 

Penggunaan model yang 
diambil dengan teknik fotografi 
untuk pembuatan media grafis, 
berapa roll yang dibu-tuhkan, 
hingga pembayaran model, di 
sinilah merupakan proses pra 
produksi. Pengga-lian ide 
melalui data-data pendukung 
dalam penciptaan media grafis 
komunikasi, ini juga salah satu 
proses pra produksi.  

Jadi semua kegiatan yang 
dilakukan sebelum proses ber-
karya (produksi) maka kegia-
tan itu disebut pra produksi. 
Semua ini tentunya membu-
tuhkan biaya. Dalam biro 
advertising yang besar pem-
biayaan ini dibuat secara 
global, namun bila advertising 
kecil anggaran pro produksi 
dimasukkan ke dalam proses 
produksi atau jasa peran-
cangan agar pengeluaran 
anggaran pada posisi ini tidak 
kelihatan atau seakan tidak 
ada. 

 
B. Desain /Produksi 

(Design) 
Proses desain/produksi meru-
pakan proses dari layout kasar 
hingga layout komprehensif. 
Tahapan proses inilah tentu-
nya memerlukan biaya yang 
harus dikeluarkan, baik secara 
perorangan maupun kelompok 
(organisasi).  

XVIII. BUGETING
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Perorangan merupakan kegi-
atan yang lakukan oleh 
seorang perancang/ praktisi 
dalam menyelesaikan karya, 
sedangkan yang dimaksud 
kelompok merupakan peng-
garapan media grafis komuni-
kasi dilakukan/ dikerjakan oleh 
beberapa orang atau kelom-
pok (tim).  

Sebagai contoh rancangan 
poster yang bisa diselesaikan 
oleh seorang desainer/praktisi, 
sedangkan dalam pengga-
rapan komik, buku, majalah, 
koran dan sebagainya biasa 
dikerjakan team work, yaitu 
bagian naskah, ilustrasi, lay-
out, dan sebagainya.  

Anggaran pada bagian ini 
merupakan anggaran yang 
paling besar dari pada bagian 
pra produksi dan pasca 
produksi. Bagian inilah yang 
menentukan jadi/berhasil atau 
tidaknya suatu karya media 
grafis komunikasi diterima 
klain. Bila klain tidak mene-
rima rancangan yang sudah 
dibuat akan mengakibatkan 
rugi besar, yang tentunya 
menambah pembiayaan lagi.  

Maka dari itu penganggaran 
dalam tahapan ini selain 
pengeluaran biaya pokok 
ditambah dengan biaya 10-15 
% untuk anggaran bila terjadi 
kesalahan fatal dalam hasil 
rancangan. Biaya penam-
bahan ini inklusif dimasukkan 
dalam anggaran proses pro-
duksi, yang seakan-akan 

penanggungan kegagalan di-
tanggung oleh perancang atau 
biro jasa media grafis 
komunikasi. 

 
C. Paska Desain/Produksi 

(Post Design) 
Pasca produksi merupakan 
pembiayaan diluar pra pro 
duksi dan proses produksi. 
Penganggan ini dilakukan 
untuk mempublikasikan media 
grafis kepada kalayak sasaran 
(masyarakat), seperti mener-
bitkan di masmedia, mema-
sang poster diberbagai tem-
pat. 

Biata pemasangan atau pe-
nerbitan di dalam masmedia 
berbeda-beda. Perbedaan har-
ga dalam masmedia dise-
babkan oleh, jenis masmedia, 
rublik yang ditempati atau 
disewa. Begitu pemasangan 
media grafis di jalan-jalan, 
anta jalan protokol dengan 
jalan kecil juga berbeda, 
tergantung ramainya masya-
rakat yang melewati jalan 
tersebut. 

 
D. Strategi Pembiayaan 
Bagaimana pembiayaan suatu 
media agar tidak terlalu 
mahal?. Ada beberapa cara 
agar dalam pembuatan media 
tidak terlalu mahal, antara lain: 

 Penggunaan bahan tidak 
harus baru. 
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Jenis media Iklan Majalah Tribus. 
Biaya desain 

a) Biaya Ilustrasi  Rp. 100.000,- 
b) Biaya Lay out  Rp. 100.000,- 
c) Biaya konsep  Rp. 200.000,- 

Biaya Pembuatan Prototype 
a) Biaya cetak ukuran A2 Rp. 50.000,- 
b) Biaya mounting  Rp. 20.000,- 

Biaya Pemasangan Iklan 
3 x terbit usuran 29,6x21 
 Rp.15.000.000,- 
1 x Rp, 5.000.000,- 

 Dalam pemotretan model 
tidak hanya untuk satu 
proyek media. 

 Pembiayaan pra produksi 
digabung dengan produksi. 

 Memanfaatkan bahan dan 
arsip sebelumnya. 

 Pengerjaan tidak dimasuk-
kan dalam lemburan, kecu-
ali dalam kondisi darurat. 

 Pembiayaan untuk klain 
sebaiknya dibuat secara 
global, sebagai contoh: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

E. Pendalaman 
Buatlah rancangan pembia-
yaan tentang karya desain 
grafis saudara, mulai dari awal 
(pra desain) hingga akhir 
(paska desain) secara rinci. 

 

 
 

Gambar 18: Media Kit harian Surya 
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Teknologi Grafis Komunikasi 
merupakan proses penciptaan 
media cetak yang dikomuni-
kasi kepada masyarakat. Se-
bagai calon praktisi/ desainer 
Teknologi Grafis Komunikasi 
sebaiknya harus mengetahui 
dasar keilmuan (ilmu dasar 
sebelum Grafis Komunikasi), 
kelimuan pokok (ilmu pengeta-
huan Grafis Komunikasi), dan 
kelimuan pengkayaan (kelimu-
an penguat agar Grafis Komu-
nikasi mempunyai estetika 
tinggi). 

Bila ditinjau dari sudut pan-
dang keilmuan, maka Tekno-
logi Grafis Komunikasi mem-
punyai dua pilar, yaitu teori 
dan praktek. Teori merupakan 
ilmu yang mendasarari akan 
terciptanya suatu karya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Seperti penggalian ide, lang-
kah-langkah yang harus 
dikerjakan seorang calon 
praktisi/desainer, bedah pro-
duk, kaji media, etika dan 
estetika, penelitian pasar, dan 
konsep. Praktek, terdiri dari 
penguatan skill keterampilan 
tangan (drawing), keteram-
pilan teknologi, seperti foto-
grafi, komputer, dan teknologi 
printing offset. 

Mekipun semua kelimuan ter-
sebut di atas sudah dikuasai, 
namun yang paling utama 
adalag bagaimana karya 
Grafis Komunikasi itu layak 
jual di pihak pemesan, dan 
informasi yang disampaikan 
bisa diterima masyarakat luas. 
Maka dari itu karya/produk 
Teknologi Grafis Komunikasi 
tepat mengacu pada: 

 
 
 

PRAKTISI / DESAINER PEMESAN/KLAIN 

MASYARAKAT 

KARYA / PRODUK 
TEKNOLOGI 

GRAFIS KOMUNIKASI 

Gambar 19: 
Empat komponen dalam teknologi grafis komunikasi 

XIX. PENUTUP
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